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Introduction

Many people will read the title of this book and think the idea of using the Zone System 

for digital photography and digital printing is nothing but sheer heresy. And to those 

people it probably is. Others have, over the years, tried to opine on whether Ansel Adams 

would have stuck steadfastly to his wet darkroom, or if he would have embraced digital 

photography and Photoshop. Many photography magazines, particularly those with an 

outdoor/landscape theme, reference Adams regularly and fill many column inches dis-

cussing how Adams would have adapted in the digital photography era. I’m not going to 

presume either way; I’m simply going to take some of his techniques and methods and 

apply them to the editing and printing of digital photographs, both black-and-white 

and color.

The digital age of photography and the digital darkroom have given photographers 

access to tools and methods far beyond what existed in the traditional wet darkroom. 

In addition to giving us more tools including digital techniques to achieve the effects of 

old-style dodging and burning—digital photography has made life simpler in many ways.

The mantra for the Zone System was, “Expose for the shadows; develop for the high-

lights.” I’ll go into this more throughout the book, but what it meant for black-and-white 

film was that the photographer could get more detail out of shadow areas and at the 

same time retain detail in highlight areas—within the brightness range of the film—by 

adjusting exposure and development and taking advantage of how each of these affects 

shadows and highlights differently on the film. What it really means is control. Taking 

control of the finished result rather than leaving it to chance. Taking control of your pho-

tography from camera to print. The Zone System was originally created for black-and-white 

sheet film because with individual sheets you could precisely control the exposure and 

development of every shot. When roll film became more popular, the idea of the Zone 

System became less practical unless the photographer was willing to switch rolls. This 

was easier with medium format, since the photographer could carry several camera backs 

loaded with film and each roll could be exposed differently. With small-format 35 mm 

film, switching rolls was more cumbersome, and thus an alternative to the Zone System 

called the Modified Zone System was conceived.

Some will suggest that with techniques such as blended exposures and High Dynamic 

Range (HDR) there really is no need for a Zone System approach in digital photography. 

I, obviously, disagree. Blended exposures and HDR are techniques to expand the bright-

ness range of an image beyond what the sensor is natively able to capture, but those 

techniques are still just starting points. Once two or more exposures have been blended, 

or five or nine exposures have been merged into an HDR image, the photographer need 

not stop. The blended-exposure image or the 32-bit HDR image or the tonemapped HDR 

image becomes only the starting point. I’ll talk later about shooting in RAW format, but 
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I’ll put a thought in your minds now to consider as you move through the book: HDR is 

the new RAW. HDR techniques will be explored in chapter 7.

Just as when the Zone System is used with black-and-white sheet film to gain control, 

the Digital Zone System (DZS) is also about control. It’s about taking fine control of a 

digital photo to make adjustments to the brightness ranges of small areas of the image, 

which, in the end, will more effectively enhance the whole.

Throughout the book, anything I provide descriptions of, anything I show illustrations 

or screen captures of, and anything I provide step-by-step directions for will be done in 

Adobe’s Photoshop CS6 or Lightroom 4. There are certainly other editing software pack-

ages available, such as Photoshop Elements, Paint Shop Pro, and the freeware GIMP, to 

name a few, but Photoshop from Adobe is the state-of-the-art. I believe it has the greatest 

level of functionality and the best color-management capabilities of any of the editing 

packages currently on the market. Lightroom has largely caught up in version 4 with the 

addition of soft proofing for printing, but not everyone uses Lightroom and you can’t use 

the DZS techniques in that application. That’s not to say some of the techniques in this 

book can’t be done with other software. Perhaps they can. It is also not to say that other 

editing packages are unworthy, because that’s not true. What I am suggesting, though, is 

that if you’re interested in advanced editing techniques, then, in my opinion, you’re better 

off having Photoshop for that work.

This book is not meant to be an introduction to Photoshop or Lightroom. Rather, it’s 

for those already familiar with these programs to learn a new approach to image editing; 

using the tools you’re already familiar with but in a new way. You’ll learn new methods 

that allow you to gain tremendous control over editing your images and you’ll achieve 

superior results. 

The last thing I should note before you read on is that this book is not intended as 

a replacement for your camera manual or as a technical treatise on photography. You 

already have a camera manual and there are many other books out there on the technical 

aspects of photography. This is intended to be a practical discussion of photography and 

in particular an editing technique that you may find useful in your photographic work. I’m 

not going to go into deep technical discussions on the concepts discussed in various parts 

of the book. I want to keep it as free of the more esoteric technicalities as possible and 

concentrate on practical matters. There won’t be discussions of how to set your camera 

in any particular mode or how to select shutter speeds or apertures. I shoot Nikon. You 

may shoot Canon. Or Pentax. Or Sony. Or… The DZS is not about any particular camera 

or manufacturer. It is about a process, and in that regard the camera maker you prefer 

is irrelevant.

I also work with the Windows system. You may too, or you may use the Mac system. 

Whichever you choose is really irrelevant to this discussion. The tools available in Photo-

shop and Lightroom are the same in both, though some of the keyboard shortcuts are dif-

ferent. Where I use the CTRL key, the Mac equivalent is the Command (or A) key. Where 

I reference the ALT key, the Mac equivalent is the Option or OPT key. The equivalent key 

commands for Mac users will be shown in gray throughout the book.

With that, let’s dive in.
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Chapter 1
Zone System Background

The Zone System is a process for exposure, development, and printing created by 

Ansel Adams and Fred Archer. I’m not going to go into a complete discussion of the Zone 

System here. It would be impractical due to space considerations, and some of Adams’ 

concepts aren’t as relevant to digital as to film. For an in-depth discussion and explana-

tion of the Zone System, Adams’ seminal trilogy The Camera, The Negative, and The Print 

are the books to read.

For those of you who already know about the Zone System, you may want to just 

quickly scan this chapter and then jump to chapter 2. But for those of you who are not 

familiar with the Zone System, these next few pages will provide a foundation to build 

on. Let’s get this information under our belts first and then with an understanding of the 

original Zone System we can apply this knowledge to the digital world of photography, 

which is our ultimate goal.

It’s important to remember that Adams created his Zone System to work with old-style 

black-and-white film. Newer types of black-and-white film, such as chromogenic films, 

don’t work with the Zone System. The concept can be applied in a limited way to color 

slide films because altered development is possible with these, but the narrower bright-

ness latitude of slide film makes using the Zone System less effective. It is not possible to 

use the Zone System with color negative films because, with but a very few exceptions, 

altered development is not an option.

It’s also important to remember that Adams’ Zone System was created for use with 

large-format sheet film. The reason is that it’s simple to adjust the exposure and develop-

ment of individual sheets of film. It’s more difficult to adjust the development of indi-

vidual frames of film on a roll. If for no other reason than this, the concepts of the Zone 

System are more applicable to digital photography than to 35 mm film photography, as it 

is possible to alter the “development” of each digital photo.

Adams found that by adjusting his exposure when taking the photo and adjusting his 

development of the film, he could create an image that retained more of the brightness 

The Zone System can be broken down into two components: 

	 1. Exposure and development

 	 2. Printing

The Digital Zone System can be broken down into two components: 

	 1. Exposure

	 2. Development and printing
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range in the scene than through normal exposure and development. In some cases he 

used normal development, but in others he extended or contracted development to ex-

pand or contract the tonal range of the shot. The Zone System can be broken down into 

two essential components: (1) exposure and development, and (2) printing. It’s the first 

component that we’ll explore in more detail below. The concepts of the Zone System for 

printing don’t apply in the same way in the Digital Zone System (DZS). The DZS can also 

be broken down into two components: (1) exposure, and (2) development and printing. 

We’ll see why I make this distinction later in the book.

Adams’ Zone System was mainly concerned with how tones, or areas of different bright-

ness, would be rendered in a print. The print, after all, is the way photos are presented 

to the viewer. There are other ways to view slide film, and in the digital age there are nu-

merous electronic means of viewing photos, but the print was, and remains, the ultimate 

presentation of a photograph. Adams broke his tonal range into 11 levels of brightness 

and related these to areas of brightness in the scene he was photographing. 

When referring to brightness levels on film, Adams called them “zones.” In a print, he 

referred to brightness levels as “values.” The zones and values correspond to each other, 

so Zone III in a scene (fairly deep shadow) is Value III in a print (fairly deep gray with 

ample detail). Zone/Value 0 is pure black. Zone/Value X is pure white or paper white 

(e.g., specular highlights). Zone V is middle gray, which is what our light meters are 

calibrated to. Each difference between zones is one stop of exposure. Zone II is the first 

where detail and texture can be discerned. On the other end of the scale, Zone VIII is the 

last where detail and texture can still be seen. Zones I and IX—while showing no detail or 

texture—are not quite pure black or pure white, but are very close. Zone I is ever so slightly 

lighter than black (a very dark but featureless gray) and Zone IX is ever so slightly darker 

than white (a very bright but featureless gray). 

Using a Traditional Step Wedge

With film, a traditional step wedge can be used in printing to determine exposure and 

contrast. A step wedge is a print or negative showing a series of gray blocks of varying 

densities.  The difference in density from one block to the next is the same (e.g., 1 stop, 

1/2 stop). This type of step wedge can be used in a couple of ways.

First, if you are shooting several exposures under similar lighting conditions, you can 

make one exposure of a pre-made step wedge and then print the image of the step wedge 

multiple times until you achieve the desired contrast and density. In this case, you might 

expose until you get the Zone V value to print as a middle value.  You can determine if 

your middle value is accurate by comparing your image to the pre-made step wedge or 

by using an instrument called a densitometer. Once you have the desired contrast and 

density in your step wedge print, those settings would become the base settings for print-

ing your images. Figure 1.1 shows what a traditional step wedge would look like. Stouffer 

(stouffer.net) is a well-known source for pre-made step wedges.

Alternatively, you could use what is called a transmission step wedge. This is the same 

as a printed step wedge except on a film negative. You expose the transmission step 

wedge on the enlarger until you get a print in which you can’t see a border between 

CHAPTER 1 | Zone System Background

u Figure 1.1: A tradi-

tional step wedge
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Zone System Background

the base material of the negative and the first step on the wedge. That exposure time 

becomes the base exposure for making your prints.

Another method is to create a step wedge using your own image. This can be called a 

stepped print. To create the stepped print, use a cover to block light from all but a small 

strip of the printing paper and make an exposure on the enlarger. Then move the cover 

material over to reveal another small strip, and then make another exposure using the 

same time as the first. You have now created a two-step wedge because the first strip has 

been exposed twice. Continue this process until you have as many steps as you want. 

Once you have this stepped print, evaluate the steps to determine which is closest to 

what you want the final image to look like. That becomes your base setting for making 

your print.

Figure 1.2 is an example of what a stepped print might look like. In this case there 

are seven steps. Evaluating this print, I would probably use segment four or five (8 or 10 

seconds) as the starting point for exposing my print.

t Figure 1.2: A stepped print 

Another Use for a Step Wedge

Camera reviewers today use a printed step wedge to test the dynamic 

range of a camera’s sensors. A step wedge is photographed with the 

camera being tested and the images are evaluated to determine the 

point at which noise in the shadows reaches a specific threshold, with 

no distinction visible between segments in the highlights. The 

difference between these light and dark limits is the dynamic range 

of the sensor.  
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It’s important to note a key difference between this stepped print and a traditional 

step wedge. In a stepped print, the density changes between the steps are not equal 

(as they are with the traditional wedge). The time differences are the same, but not the 

densities. The difference between the first two-second and four-second steps is one full 

stop, but the difference between the four-second and six-second steps is only half a stop. 

These fractional differences get smaller as you move across the print.

Today we can create a step wedge on the computer, as with the example in figure 

1.3. Here, each of the zones is represented by Roman numerals just as the traditional 

step wedge in figure 1.1, and the Arabic numerals indicate the grayscale values that cor-

respond to each zone. The zones are one stop apart. We’ll come back to these grayscale 

values later as we begin to relate zones to brightness values in the digital world. It is 

these brightness ranges that we’ll be creating and working with later on in the DZS. The 

only difference between the DZS step wedge and a traditional step wedge is that I’ve 

included the grayscale values.

Those who are familiar with film and with the Zone System will realize that the digital 

example shown here and the traditional step wedge in figure 1.1 are different from what 

a true Zone System step wedge would look like. Due to the nature of film, which will 

be discussed more in chapter 3, the zones are not equally spaced. A Zone System step 

wedge would show less separation in the darker (Zones 0 to II) and lighter (Zones VIII 

to X) zones and more separation in the middle zones (Zones III to VII), as can be seen in 

figure 1.4. For our purposes, the equal spacing between zones is more appropriate.

The mantra of the Zone System was, and still is, “Expose for the shadows; develop for 

the highlights.” What does that mean? Let’s go over it, beginning with the exposure and 

development side of things.

Expose for the Shadows

Adams wanted to make sure his shadow, or darker, values showed what he considered 

to be proper tonality in his print. Using a spot meter, he would measure the area he 

considered to be his most important shadow detail. Keep in mind that reflected light 

meters want to produce everything as a middle gray (Zone V). The meter reading for that 

important shadow area was for it to be exposed as Zone V on the film. He would then 

decide what value he wanted that important shadow area to have in the print. He would 

usually choose Value III or Value II. 

If Adams wanted the important shadow area to be Value III, he would reduce his 

exposure by two stops from what was indicated by the meter reading. This is called  

placing the value.  By taking the meter reading and adjusting exposure in reference to 

that reading, the important shadow component is placed where we want it on the film 

and in the print. When we place the important shadow area in the desired zone, other 

brightness values above and below the key zone simply fall where they may as a result 

of the exposure determined for the key shadow area. This is called the place and fall 

approach to exposure. 

What if, as a result of placing the important shadow detail, a highlight area is moved 

outside the range that can be captured by the film? We’ll discuss that further down when 

CHAPTER 1 | Zone System Background

u Figure 1.3: 

A computer generated 

step wedge

u Figure 1.4: A Zone 

System step wedge
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Expose for the Shadows

we talk about altered development. We’ll also return to the concept of place and fall 

when we talk about the Modified Zone System.

The use of the spot meter is important in the Zone System. A one-degree spot meter 

has a very narrow angle of view and allows you to isolate a specific area of the scene in 

the field of view of the meter for measurement. The meters in modern single lens reflex 

(SLR) cameras are less useful in zone metering. Some don’t have a spot meter at all. The 

ones that do may offer a three-percent spot meter or go as high as nine percent. That 

means the so-called spot meter will read between three percent and nine percent of the 

angle of view of the lens. With a wide-angle lens that can be quite a large area and it’s 

not as easy to isolate specific spots using that kind of meter. The longer the focal length 

of the lens, the narrower the angle of view and the narrower the view the on-board spot 

meter can take. But using separate lenses to meter and shoot is a bit of an inconvenience, 

to say the least. 

The multi-segment or matrix metering systems in today’s modern SLR cameras are very 

good. These take readings from several different areas and average them to come up 

with a proper exposure. In most cases these work well but can be fooled. And, in the end, 

you’re letting the camera and its on-board computer make exposure decisions for you. If 

you’re really interested in applying Zone System methods, a handheld spot meter is the 

way to go. If you don’t have or don’t want to buy a spot meter, you can certainly use the 

meter in your camera; you just need to have a solid understanding of how it works and 

how it can be fooled. We’ll dig into that in more detail in chapter 3.

The concept of “place and fall” is important, not only in terms of how the brightness 

range of the scene will be distributed, but also in terms of how much latitude is left at 

each end of the scale in the event we decide to place the important shadow detail in 

a zone other than where it may naturally lie. Assuming a scene with a normal contrast 

range, we will have values ranging from Zone 0 or I through Zone X or IX. Placing the 

important shadow area on a zone above or below where it may naturally lie impacts the 

rest of the zones also. Placing it on a lower than natural zone means that we will lose 

detail in some other shadow areas. This leads to what are called blocked shadows. Plac-

ing the important shadow area on a zone higher than where it may naturally lie means 

that all the values above it are pushed up to higher zones and a loss of detail may occur 

in highlight areas. Those areas are called blown highlights. 

For high-contrast scenes with brightness ranges that extend beyond what our film or 

digital sensor can record, we need to use other approaches. We’ll talk about that more 

in chapter 7. We can’t do anything about blocked shadows, but we can, to some extent, 

deal with what otherwise might be blown highlights. Paying attention to how shadow 

placement affects the ends of the brightness range is less important for scenes with 

a narrower than normal range of brightness, because in those cases there is sufficient 

latitude to work with.

Develop for the Highlights

We’ve looked at one piece of the puzzle; now let’s see how it relates to the development side.

As we saw previously, we can stay within the latitude of our film and use normal 

If you’re really interested in 

applying Zone System methods, 

a handheld spot meter is the 

way to go.
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development as long as we place our important shadow area properly and the brightness 

range of the scene we are photographing is either normal or narrower than normal.

The Zone System works as well as it does because of the way that exposure decisions 

and development methods affect the negative differently. Exposure affects primarily 

shadow areas, having less impact on highlight areas. Development, on the other hand, 

affects primarily highlight areas and has less effect on shadows. This is also the reason 

why placement of the key shadow detail at the time of exposure is important. Shadows 

are locked once the shutter release is pressed. Try as we might, pushing up shadow values 

to higher zones later during developing will result in nothing but featureless areas of gray. 

Pulling down shadow values that have been placed too high won’t work either, and will 

pull highlight values down as well, reducing contrast too much.

For this reason, when we have a scene that has a normal or narrow brightness range, 

we can expose for the important shadow detail we want to retain and then compensate 

during development to adjust the highlights.

Increasing development—through time, temperature, agitation, or a combination of 

those elements—increases contrast, brightening highlight values. Conversely, reducing 

development reduces contrast, darkening highlight values. What does this mean?

If we have a scene that has a narrow brightness range of, say, three stops, and we place 

our important shadow detail on Zone III, there are only two zones of brightness above 

that. We end up with a photo that has a brightness range of three stops, with the highest 

being at Zone V. This is still pretty dark overall, and the image will have very flat contrast. 

If we want to increase the contrast and push that Zone V up to Zone VII, we can increase 

the development of the film. How much? It will depend on the film/developer combina-

tion, but only testing will indicate how much development has to be increased to create 

that two-stop increase in contrast. Increasing development this way is known as push 

processing or pushing the film. It works because, as noted previously, altered development 

has the greatest effect on highlight areas and little effect on shadow areas. The result 

of pushing our film two stops will be a negative that has a five-stop brightness range, 

from Zone III to Zone VII. We will still be well within the range that the film can produce. 

When using altered development, it is best to change only one factor at a time in the 

development process rather than changing multiple variables. That way you can create a 

workflow that will produce consistent results time after time. Another important thing to 

keep in mind is that increasing development, or push processing, will also enhance grain 

in the negative and in the print.

What if we place the important shadow detail on a zone higher than where it other-

wise would be and the scene has a normal contrast range? We are going to get washed-

out or blown highlights, right? Not necessarily. Just as increased development can push 

up highlight values, contracted development can pull back highlight values. If we end up 

with a highlight value that is, say, two stops brighter than where we want it to be, we can 

pull back some of those highlight values and bring them back into the range of the film 

by contracting development. Contracting development is called pull processing or pulling 

the film, and is also accomplished by making changes to time, temperature, agitation, or 

a combination of those elements.

CHAPTER 1 | Zone System Background
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The Zone System and Roll Film

To put it in terms of digital tools, push and pull processing can be likened to Curves or 

Levels adjustments in Photoshop or to the exposure and curve adjustments available in 

RAW conversion software programs.

In the end, Adams’ Zone System, the Modified Zone System, and the DZS are about   

control—control over how you want your photos to look, and the ability to decide how 

shadows and highlights are rendered.

The Zone System and Slide Film

Transparency, slide, or positive film is very different from black-and-white negative 

film. First, the processed output is a positive medium rather than a negative due to the 

reversal process slide film undergoes in development (all film starts out as negative film). 

Protecting highlight values is much more important with slide film than with negative 

film. Slide film also has a much narrower brightness range than black-and-white film. 

Black-and-white film typically has a range of nine to ten stops, whereas slide film has a 

range of about five, maybe six, stops. Slide film is, therefore, inherently much more con-

trasty than black-and-white film. More contrasty? How can that be? Highlights will blow 

out sooner and shadows will block up more quickly with slide film, so you can end up with 

brighter highlights and darker shadows than you would have had with black-and-white 

film. Zone VIII on black-and-white film may effectively be Zone X on slide film, and Zone 

III may effectively be Zone 0. This narrower brightness latitude means more contrast.

Altered development can work with slide film, but the results are typically much less 

pleasant than with black-and-white film. Using adjusted exposure and development with 

slide film should be a last resort rather than a creative choice as it can be with black-

and-white film.

The Zone System and Color Negative Film

There is no Zone System for color negative film. With few exceptions—none of which is 

manufactured any longer as far as I know—color negative film doesn’t respond to altered 

development. Color negative film is designed for quick-turnaround and volume process-

ing by machine. Various film speeds and brands can be mixed together due to the same 

development requirements.

Chromogenic black-and-white film, because it is based on color negative film and pro-

cessed in the same way, is also not an option for Zone System photography.

The Zone System and Roll Film

The Zone System was created to work with large-format sheet film. Can it work with roll 

film? Yes, but it’s a bit more fiddly.

If you’re shooting with a medium-format camera that uses a film back, you can carry 

multiple backs loaded with film and simply change backs when you want a different ex-

posure/development combination. You can mark the backs N (for normal development), 

N +1 (normal plus one stop expanded development), N –2 (normal minus two stops 
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contracted development), and so forth, so you know which is which. If you take your film 

to a lab for processing, give the lab instructions for each roll based on how it was shot. If 

you process your own film, you can process the roll to the desired development.

With 35 mm it is even trickier. You can carry multiple bodies, but that quickly gets 

pretty heavy. To use the Zone System with 35 mm, you need to rewind and remove the 

film when you want to switch to a different roll. While this is possible, it is error prone. You 

must carefully keep track of the frame number when you take the film out of the camera, 

and make sure you leave the leader out of the canister. (There are ways to retrieve the 

leader if it gets wound inside, but this just adds to the fiddly-factor.) You then have to 

carefully count the frames to advance when you put the film back in the camera. Even if 

you get all that right, there is the possibility of registration errors that could result in an 

overlap of exposures, ruining two shots.

For roll, color negative, and slide film, the more practical solution is the Modified 

Zone System.

The Modified Zone System

The “Modified Zone System” is a term coined by Norman Koren, but its roots are firmly in 

the Zone System. Recall the concept of place and fall from earlier in the chapter. That’s 

exactly what the Modified Zone System is based on.

Recognizing the limitations of roll and color negative film, Koren coined the term Modi-

fied Zone System to refer to the idea of place and fall for all tonal values. Why is this 

important for films with which altered development isn’t possible? Why not just rely on 

the fancy meter and computer in the camera to get it right? Because the Modified Zone 

System still puts you in control. You decide where the tonal values will be, not an engineer 

working for the camera manufacturer. You are in control of the artistic vision; you’re not 

leaving it to the camera to determine what your art looks like.

Metering in the modified system is similar to metering in the Zone System. Using a 

handheld spot meter, you take measurements from a number of areas in the scene. Rather 

than placing your most important shadow area where you want it, however, you place your 

most important scene element where you want it. If your most important scene element 

is to be placed on Zone VI, you increase the metered exposure by one stop. You make 

this decision knowing where other parts of the scene will fall based on how those areas 

metered relative to your most important scene element. For example, if you’re shooting a 

flowing river near sundown and want a large, evenly lit portion of the river on Zone VI, 

you know that the brightest highlight of water flowing over some rocks that’s three stops 

higher will be on Zone IX (with no detail but not quite pure white). You also know that the 

shadowed area under some overhanging trees that measured four stops below your water 

will fall on Zone II (with just a hint of texture and detail). Having other areas of the scene 

that are brighter or darker will mean there will be areas of black or white that are devoid 

of any detail. But you have made a decision for that to happen rather than letting the 

camera take over for you. It is also not necessarily a bad thing to have some small areas of 

black shadow or white highlight. As long as these areas are small relative to the rest of the 

scene, the viewer’s gaze won’t be distracted and the whole image will look quite natural.

CHAPTER 1 | Zone System Background
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Visualization

Visualization

Before moving on, there is one more aspect of the Zone System that is important to dis-

cuss, and it applies to all forms of photography. Visualization is a process of looking at 

a subject or scene and conceptualizing how you want it to come out in your print. What 

do you want the global contrast to look like? What do you want local areas of contrast to 

look like? What do you want the overall finished image to look like? Are you shooting for 

color or black and white? In what aspect ratio will you print it?

All of these questions and more are things to think about when you’re shooting. If 

you know ahead of time what you are going to be shooting, you can think about these 

questions in advance so that you are ready when you get into the field. Thinking about 

these questions ahead of time will help you compose your image, adjust your exposure 

by using a meter reading, and edit your images effectively and efficiently. In particular, 

if you are shooting in color but intend to convert to black-and-white, understanding how 

colors translate into shades of gray and how this creates contrast and visual interest in a 

black-and-white photo can be crucial to a successful black-and-white image.

I’ll share a little anecdote to illustrate visualization. A number of years ago while I 

was working on assignment in the Czech Repuclic, I rented a studio for half a day and 

contracted some models. Before hiring the models, I checked out their sedcards and other 

work. I conceptualized shoots for all of them, including wardrobe, props, and poses, so 

that the time in the studio would be spent as efficiently as possible. With one particular 

model, I had just three shots I wanted to get. She’d been hired for the minimum duration 

of one hour. When after 25 minutes I said, “OK, we’re done,” she gave me a somewhat 

bewildered look. She said we still had time left but I told her that was OK. I explained 

that I’d known what I wanted to get, that I got it, and that she had done a fabulous job. 

Visualizing the shots allowed me to be efficient and get what I needed in a short period 

of time. But the model wanted to continue shooting, so we finished the full one-hour ses-

sion. While I took some nice shots during the remainder of the hour, none were as good 

as the ones I’d envisioned ahead of time. 

If you know ahead of time what 

you are going to be shooting, you 

can think about these questions in 

advance so that you are ready when 

you get into the field. 
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Chapter 2
Color Management, Photoshop Setup, 
and Image Management

Before we can begin editing digital photos, there are three important things need set 

up to make the workflow process more effective and efficient. First is color management. 

Without a color-managed workflow, ensuring consistency of color from capture to print is 

next to impossible. This includes making sure you’re working with a properly calibrated 

and profiled monitor, ensuring your scanner is profiled if you’re scanning film, and using 

accurate printer profiles in your printing. Second is setting up Photoshop with the proper 

color settings, which is key to ensuring color consistency throughout the editing and 

printing process. Third is the concept of image management, which means having a 

sound system of organizing your images so you can find what you want when you want.

Color Management

Entire books have been written about the complex topic of color management. If you 

want to invest the time to learn more, two excellent books to read are Color Confidence: 

The Digital Photographer’s Guide to Color Management by Tim Grey and Real World Color 

Management, 2nd Ed. by Bruce Fraser, et al. Grey’s book takes a pragmatic approach to 

color management, explaining how to put it into practice in digital photography. The 

Fraser book has a similar approach but goes much further, covering more of the theory 

of the human visual system and how color works in the computer world. It’s a fascinating 

read. What I’m going to present here is simply an overview of color management and the 

color-managed workflow.

Color management is a process whereby we get the tools of digital photography—com-

puter screen, scanner, digital camera, and printer—speaking the same language, and that 

language is color. While each device is capable of rendering color, the colors that each pro-

duces may be different even with identical RGB values. Two monitors of the same model 

may render the same colors differently out of the box. Two of the same scanner model may 

reproduce colors differently. Modern printers are much more consistent, and manufactur-

ers have worked hard to ensure consistency across a model range, but we still need things 

called profiles for the various paper/ink combinations we use. 

The process of developing a color-managed workflow is to create a set of profiles, which 

are little data files that tell the various parts of the system how to render color properly, 

to correct for the innate inaccuracies in each device. This is achieved by using a common 

set of colors known as LAB. LAB is a known quantity, and is the center point of the color 

management system.  When moving colors from one place to another (e.g., from a digital 

image file to a monitor or a digital image file to a print) the colors are converted from 

The L*a*b color space is device in-

dependent. (That is, it’s not specific 

to any particular device. The color 

space of a particular monitor would 

be device dependent.) It represents 

every color through three compo-

nents. The L value represents lumi-

nance and ranges from 0 for black 

to 100 for white in uniform steps. 

The a and b values are represented 

as +a/-a for red/green and +b/-b 

for blue/yellow.
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the source (the digital image file) into LAB, then from LAB into the set of colors used by 

the destination (monitor or printer). This makes the process of converting colors accurate.

Why do we even need to do this? Because color is a bit of a nebulous concept. Think 

of two printers from two different manufacturers. Each has an ink color magenta. But the 

formulation of each of these inks is different, so the color that each produces is different. 

Without a way to interpret and convert colors from one place to another, the prints from 

these two printers could look very different. That’s not what we want. There will always 

be differences between printers from two different manufacturers, but those differences 

can be minimized. Color management and the use of device-specific profiles in a color-

managed workflow maintain the consistency we’re looking for. In the case of the two 

printers, a profile will interpret the differences between the two types of magenta ink 

and determine the proper amount of magenta to use in combination with other colors to 

produce the color present in the digital image.

The goal is consistency in how color is rendered from device to device. It’s not, as many 

believe, to get a print to match the monitor. While you want the print to be as close as 

possible to what you see on your computer screen, an exact match is too much to ask. A 

reason for this is that computer monitors use transmissive light, while colors we see on a 

print are based on absorbed and reflected light. In addition, most computer monitors in 

use have color gamuts (the breadth of color that the device can produce) that are much 

smaller than what is present in our digital image files and smaller than what many of 

today’s printers can produce. The result is that we’re not seeing all of the color available 

on-screen. Color management is a process of ensuring consistency of color throughout 

the digital imaging workflow and across systems, so that if we send an image to someone 

else who is using a properly color-managed workflow, that person will see the same colors 

we see. Without color management, color consistency—which is the real goal—is nearly 

impossible to achieve.

Monitor Calibration and Profiling

Choosing a Monitor
The first step in the color-management process is calibrating and profiling your display. 

The type of display you use—cathode ray tube (CRT) or liquid crystal display (LCD)—is up 

to you. There are few CRTs currently made, so if you’re looking for a new monitor, an LCD 

may be your only choice. If your CRT is more than about five years old, consider replac-

ing it. The electron guns in CRT displays that are used to produce the image on-screen 

degrade over time. After three to five years of use, the electron guns degrade to the point 

where producing accurate color becomes difficult and producing a pure white may be 

impossible. There’s no need to throw the old display out though. You can keep it and use 

it as a second monitor, which can make editing easier. With all your tools and palettes on 

the secondary screen and your editing space on the main screen, your editing screen is 

cleaner and you have more space on which to work.

LCD monitors have come down in price over the last several years, and a display suit-

able for photo editing can be found for as little as about $300, depending on size. Larger 

displays cost more but are still a far cry from the LCD prices of just a few years ago, 

CHAPTER 2 | Color Management, Photoshop Setup, and Image Management

The goal of color management is to 

achieve consistency in how color is 

rendered from device to device.

Digital_Zone_EN_final_01.indd   16 24.09.12   19:40

http://lib.ommolketab.ir
http://lib.ommolketab.ir


|  17  |

Color Management

p Figure 2.1: Two-screen setup. Main 

editing screen on the left and secondary 

screen with tools on the right.

when a suitable LCD cost well over $1,000. LCD monitors typically last longer than CRT 

displays, but there are other things to consider about LCDs.

Depending on the type of front panel used on the monitor, its viewing angle charac-

teristics, ability to render color, and ability to show proper contrast may not meet the 

requirements for serious color and grayscale editing.

When choosing an LCD, look for one that has an In-Plane Switching (IPS) front panel. If 

you can’t find a monitor with an IPS panel that fits your budget, one with a Patterned Ver-

tical Alignment (PVA) panel is a decent second choice. Within these categories there are 

several different types (e.g., Super IPS and Super PVA). In general, these represent subtle 

differences in the basic technology and shouldn’t present significant improvements or 

drawbacks in a monitor that’s to be used for photo editing. As with any technology, 

you should do your research ahead of time. IPS and PVA use different ways of aligning 

the liquid crystals in the panel and turning them on and off to render an image on-

screen. Some LCD monitors provide little in the way of user-adjustable controls, which are 

called on-screen display (OSD) or Display Data Channel/Command Interface (DDC/CI) 

controls. You don’t want one of those. At a minimum, you want a monitor that lets you 

adjust the brightness (with LCD displays this is often through adjusting the backlight) 

and the color temperature (either directly or with Red, Green, or Blue adjustments). A 

contrast adjustment is also good but not crucial. 

Brightness and contrast ratio are two other important considerations when buying an 

LCD. You’ll be turning the brightness down when you calibrate, but a maximum rating of 

300 candelas per square meter (shortened to cd/m2 and often referred to as nits) is suf-

ficient. The contrast ratio is a little more tricky, as it determines how many shades of gray 

can be rendered between black and white. Higher is better, to a point. A contrast ratio of 

600:1 is about the minimum you should look for, in order to retain fine shadow detail. A 

level of 800:1 won’t give you a great enough increase in detail to justify the additional 

cost. If you really want to get that nth degree of shadow detail, then a level of 1000:1 

will help you. To put it into terms more relatable for the photographer, 600:1 represents 

about 9 stops and 1000:1 is 10 stops. One thing to be aware of with contrast ratios is 
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that some displays have dynamic contrast ratios. Depending on the brightness or dark-

ness of what’s being shown on-screen, the software running the display will adjust the 

contrast ratio dynamically. You don’t want that. If the display does have dynamic contrast 

capabilities, the manufacturer will likely include the highest ratio available through that 

technology in the monitor specifications because it looks better for marketing purposes. 

If the salesperson you’re speaking with doesn’t know what the static contrast ratio is 

(which is the one you want), phone the manufacturer and speak with pre-sales support 

or advanced technical support personnel. If they are unable to tell you, look for another 

monitor. Many monitors that have both static and dynamic contrast capabilities allow 

you to turn off the dynamic contrast. If you get a monitor with both, make sure you can 

turn off the dynamic contrast.

The last thing to look for in an LCD is the configuration of the backlight. Some back-

lights are more consistent than others, and you want one that’s as consistent as possible 

across the entire screen. If there’s going to be a drop-off, it will usually appear at the 

corners. One way to find out if there’s a drop-off is to fill the screen with a completely 

white image. You’ll be able to see any significant corner darkening, which will look like 

the vignetting that you get with some camera lenses. Some drop-off is normal, but you 

want to keep it to a minimum. Turning down the brightness of the monitor may aid in 

finding darker areas. Some websites that post reviews of computer hardware measure 

backlights and present their findings. Most LCD monitors use cold cathode fluorescent 

lighting (CCFL) as the backlight source. There’s nothing wrong with it, provided drop-off 

is well controlled. If money is no object, however, look for an LCD that uses light-emitting 

diodes (LEDs) as the light source. An increasing number of LED monitors are coming on 

the market. The ones available that are suitable for photo editing are still quite expensive, 

but prices are dropping. LED backlighting is superior to CCFL mainly from the standpoint 

of the range of color that can be displayed. Monitors with LED backlights can often dis-

play most of, and in some cases more than, the Adobe RGB color space. CCFL backlights 

are pretty much limited to the smaller sRGB color space. There’s more discussion of color 

spaces later in this chapter and in chapter 8.

Monitor Calibration and Profile Creation
The best way to calibrate and profile your display, whether a CRT or an LCD, is with a 

piece of hardware called a colorimeter or a spectrophotometer. These are sold by compa-

nies such as Datacolor and X-Rite. The Spyder package from Datacolor and the i1Display 

from X-Rite are both reasonably priced and do a good job. Whether a colorimeter or 

spectrophotometer is the better choice is a matter of debate, but I use the Spyder (a col-

orimeter) and it produces a very accurate profile for my display. The X-Rite ColorMunki is 

a spectrophotometer that will allow you to profile your monitor and create printer profiles 

with a single device. It has received positive reviews and is reasonably priced.

LCD displays do have some benefits over CRTs. A big plus is that they don’t degrade as 

fast, so even though you’ll pay more up-front for an LCD, it will last longer. LCDs are also 

much more consistent than CRTs. With a CRT monitor, reprofiling every couple weeks at 

a minimum is required, more often if the monitor is used a lot. The frequency of having 

to reprofile also increases as the monitor ages. It will drift more and more quickly as the 
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Color Management

p Figure 2.2: Calibration parameter selection p  Figure 2.3: Display control selection

electron guns age and degrade. LCDs are much more stable. Even with significant use, 

LCDs don’t need to be reprofiled as often. As a test, I let my secondary display go for 

six months without reprofiling. When I did remeasure and recalibrate, the difference be-

tween the two profiles was virtually imperceptible. An untrained eye might not even have 

noticed the difference. Now, I’m not suggesting you do that as a matter of course, but you 

can take some comfort in knowing that with an LCD you can spend less time calibrating 

and profiling your monitor, and more time taking and working on your photographs. (And 

I did do it with my secondary display, which is not color-critical for my purposes.)

The process for using any of these hardware tools is much the same. To begin, you 

launch the software that comes with the hardware device and set up the parameters you 

want to calibrate to. Typically this will be a display gamma of 2.2 and a color temperature 

of 6500 Kelvin (K) (or D65). Figures 2.2 and 2.3 are screenshots from the ColorVision 

profiling software for the Spyder. 

There is much debate about whether 6500 K or 5000 K (or D50) should be used for 

monitor calibration. The thinking behind using 5000 K is that the standard for viewing 

prints is viewing them under a 5000 K light source. It would seem intuitive, then, to 

calibrate your monitor to 5000 K. If that approach works for you, use it. My personal 

preference—and the general recommendation by experts in the field of color manage-

ment—is calibrating the monitor to 6500 K. There are several reasons for this. 

One is the difference in the way we view images through transmitted light and the 

way we view images with reflected light. The higher apparent brightness of transmitted 

light requires a higher color temperature to look correct. Using a setting of 5000 K results 

in a monitor that looks too dull and has a very evident warm/yellow color cast. A color 

temperature of 6500 K is also generally closer to the native white point of LCD monitors. 

The closer you stay to the native state of a device, the less it has to work to render color 

properly. You’ll see a better color gamut, and the monitor will last longer. You should still 

use a 5000 K light source to view your prints, however. Having tried both, I get better 

color and a better match between my prints and what I see on-screen by using 6500 K 

for monitor calibration.
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There’s also much debate about whether a gamma of 1.8 or 2.2 should be used, particu-

larly if you’re working in the Apple system where 1.8 was long considered the standard 

(2.2 being the standard in the Microsoft Windows system). Since about 2009, Apple 

systems have adopted the 2.2 standard as well. A level of 2.2 will give you a slightly 

brighter and more contrasty result, as well as the potential for a slight loss of shadow and 

highlight detail. Using a gamma of 1.8 will result in an on-screen image that’s a bit too 

dull and flat. A setting of 2.2 will provide a bit more oomph. As with color temperature, 

I’ve tried both and find that with with a display gamma of 2.2 I get a better result with 

a more accurate screen-to-print comparison and a better-looking print. How the photo 

looks on-screen when we’re editing determines how the image will look on paper.

CHAPTER 2 | Color Management, Photoshop Setup, and Image Management

What is Gamma? 

Gamma has two distinct meanings for photographers. First, when it comes to 

viewing images on screen and calibrating monitors, gamma is the relationship 

between the input voltage to the monitor (really, the electron guns in a CRT or 

the liquid crystals in an LCD) and the brightness of a pixel displayed on screen. 

That relationship is not linear (digital camera RAW files are linear). The relation-

ship between input voltage and screen brightness is represented by a concave 

shape. If you were to take a Photoshop Curves adjustment, place a control point 

in the middle, and pull down to the point where the control point is about two-

thirds of the way to the right on the bottom axis and from the top on the left 

axis, you‘d have something that is reasonably close to the gamma relationship 

of computer monitors using a gamma of 2.2. This makes images look very dark 

on screen. 

What we do when we calibrate our monitors is actually apply a curve that is 

the inverse of the monitor gamma.  While we specify 2.2 in the calibration soft-

ware, it gets applied to the monitor as 1/2.2. The two cancel each other out and 

we‘re back to a linear condition on screen, which is what we want. 

The second meaning of gamma that‘s important for photographers is that it 

is a representation of midtone contrast in an image. If you use the Photoshop 

Levels adjustment, the middle slider that‘s labeled 1.00 is a gamma adjustment. 

By moving the slider left or right you‘re altering the contrast of the image in 

the midtones. 
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Once you’ve made selections for color temperature and gamma, you’ll begin the 

process of calibrating your display and creating a display profile. The software that came 

with your colorimeter or spectrophotometer will instruct you to place the measuring de-

vice on the display in a specific spot, and it will start taking readings of color blocks 

displayed on-screen. You’ll be asked to adjust the monitor along the way in order to meet 

specific target values for color temperature, brightness, and in some cases contrast. Once 

the process is complete, a display profile will be created and saved in the proper folder 

on your hard drive. When you reboot the computer, the profile you created will be loaded 

into the graphics card and used in displaying content on the screen. Some people sug-

gest that adjusting the Red, Green, and Blue (RGB) sliders on an LCD monitor to set color 

temperature will result in an inaccurate profile. They think it’s better to simply let the 

profiling tools create a profile that corrects for differences in the way the monitor renders 

color. Others suggest that adjusting the RGB controls is the only way to get a proper 

profile. Again, I’ve done both, and find I get a more accurate profile by adjusting the RGB 

controls to achieve the proper color temperature. 

Color Management

p Figure 2.4: Color temperature adjustment selection p Figure 2.5: White balance pre-calibration

p Figure 2.7: Brightness settingp  Figure 2.6: White balance post-calibration
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I should note here that what I’m discussing with respect to monitors applies to stand-

alone displays, not laptop monitors. Laptops are generally not suitable for color-critical 

work as the front panel often lacks the quality required, and in many cases laptop graphics 

cards are feature stripped, which makes adjusting the display difficult if not impossible. 

If you’re going to use a laptop for color-critical photo editing, I suggest buying a stand-

alone display to use with it. Using laptop displays for a quick preview or to do some initial 

reviewing of images on the road is fine, but they’re really not suited to serious editing.

Scanner Profiling
Scanners also need to be profiled for those shooting film and then scanning to get to a 

digital image. Some of the packages for calibrating and profiling a monitor can also be 

used to profile a scanner. In addition, two major scanning software packages—SilverFast 

from LaserSoft and VueScan from Hamrick—include profiling functionality. You’ll need to 

buy a measuring target separately. LaserSoft and some major photo retailers sell them. A 

target is either a frame of slide film or a print that has a series of color blocks on it. The 

color blocks are based on a standard, and there’s a text file (often via download) that has 

the proper color numbers for all of the blocks. The colors read by the scanner are com-

pared to the proper numbers in the text file, and the software creates a profile that will 

correct for the differences between colors. Since not every available color is represented 

in the target, some interpolation between colors will occur.

In most cases the scanner profiling process is largely automated. You enter the profiling 

function of the scanning software, place the target in the scanner and the software does 

the rest of the work. At the end, a profile is created that you can use to correct the colors 

from scanned film. You can either apply the profile at the time of scanning or you can 

leave the scanned image untagged and apply the profile after the fact in Photoshop. 

In the two images of the leaf in figures 2.9 and 2.10, you can see the effect of using a 

scanner profile. After applying the profile, the colors in the second image are much more 

accurate. The greenish color cast is gone and the reddish cast in the shadows is gone, 
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while the red of the frozen leaf is much better. The cool blue color cast is more accurate 

and appropriate for the conditions which were pre-dawn shadow shot with daylight color-

balanced film.

Profiles in Printing
In printing, profiles are used to correct errors in how colors from your photos are repro-

duced on various media. The errors can come from the paper or the way the printer driver 

instructs the printer to lay down ink. Dyes, bleaches, ink-receptive coatings, and chemi-

cals used in the manufacture of inkjet paper can cause color shifts. As noted above, the 

formulations of ink colors by different manufacturers can also play a part in rendering 

inaccurate color in a print.

With advancements in inkjet printing since the first mass market pigment inkjet print-

er—the Epson 2200—came out, profiles provided by printer and paper manufacturers 

have become very good. The major paper brands (e.g., Hahnemühle, Ilford, Harman, 

Museo) make profiles available on their websites for an increasingly wide variety of print-

ers. And these profiles are typically quite accurate. Unless you’re using obscure papers or 

an unsupported printer, or 99.99% accuracy isn’t good enough for you, there’s really no 

need to make your own profiles or have them made for you.

As with many other aspects of photography, testing is important to verify the accuracy 

of the profiles you’re using. Make some test prints and do a comparison of what you’re 

seeing on-screen to what you see in print. Make sure that what you’re seeing is as close a 

match as possible under the lighting conditions you’re using. If the comparison isn’t very 

close, then look to the supplier of the profile. Contact the manufacturer to see if there’s an 

updated version or if there’s another reason it might not be working well for you. If you’re 

seeing significant mismatches in many prints across many paper types and paper profiles, 

then reevaluate your own workflow. Reprofile your monitor to make sure it’s accurate, and 

check your printing workflow to verify that you’re using the proper techniques.

If you’re using more obscure papers, coating your own, or using third-party inksets (not 

Color Management
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a recommended practice), then making your own profiles or having profiles made for you 

is likely going to be necessary to get an accurate print. There are services that will make 

printer profiles. Typically, they will send you or allow you to download a target to be 

printed. They’ll tell you which print settings to use. You mail the printed target to them, 

and they measure it and e-mail a profile to you. The cost for this type of service depends 

on where you go, but you should expect to pay at least $35. Some services charge more 

than $100.

If you only need a few custom profiles, having them done by a third party will likely 

be the most cost-effective option. Doing it yourself is a tedious, error-prone task, and the 

hardware required can be expensive. If you’re using a wide variety of obscure papers and 

need a large number of profiles, it may become cost effective to do it yourself. Costs for 

hardware range from about $400 to several thousand dollars. Costs can increase from 

there, depending on the software features and hardware accessories (e.g., an automated 

measuring table) you add to the mix.

Color management is important in the printing workflow as well, but we’ll cover that 

in chapter 8.

Camera Profiling
One issue that gets a lot of discussion is whether you need to profile your camera. This 

can be done. Some commentators recommend doing it, and some say it’s not really neces-

sary. I take a hybrid approach.

When you’re working with color that can be judged subjectively, profiling your camera 

isn’t really necessary. The “correct” color in these cases is the color you find most pleasing. 

It may not be completely accurate or completely natural. Fine art photography fits nicely 

into the category of work with color that can be judged subjectively.

On the other hand, if you need more accurate color, then creating a profile for your 

camera can be a good idea. That may be the case if, for example, you’re photographing 

products for a catalogue.

Creating a custom camera profile is not very difficult. One of the simpler tools to use for 

it is the X-Rite ColorChecker Passport. It’s a small, bifold plastic wallet that you can carry 

in your kit bag. It has a 24-patch color card, a gray card, and other patches for adjusting 

white balance. You photograph the color patch card and then export the image to the 

software provided by X-Rite. The software compares the color numbers captured by your 

camera to the known RGB values of the patches, and then creates a profile you can use 

in either Lightroom or Adobe Camera Raw (ACR) to automatically adjust the color of a 

single image or a selection of images. It works pretty well. But it’s not perfect. Keep in 

mind that you’re measuring from only 24 patches of the trillions of colors that exist in 

the universe. It will get you a good part of the way to where you need to be, but you may 

still need to do some tweaking after the fact. The profiles created by this package will be 

available in the Camera Calibration panel (of either Lightroom or ACR) in the drop-down 

menu with the other camera profiles provided by Adobe. 

There are other packages available for profiling a camera. I use the Passport because 

it does a good job, is reasonably priced, easy to carry, and has a plastic case that 

prevents damage.
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RAW or JPEG
The other significant decision you’re going to need to make with regard to your camera 

is whether you’re going to shoot in RAW or JPEG mode. There are numerous reasons on 

both sides of the argument. I continue to shoot both, depending on what I need, which 

is why I didn’t make the heading “RAW vs. JPEG.” When I need the best quality, I shoot 

RAW. In cases when quality isn’t as crucial, I may shoot JPEG. If I’m shooting for the web 

or newspaper publication, for example, the quality of RAW may not be necessary. If you’re 

going to shoot JPEG, you do need to know what you’re getting and the limitations the 

format puts on you.

Shooting in JPEG mode, you don’t have the freedom to adjust the image that you do 

with RAW. You have to be much more precise with your white balance setting and your 

exposure decision. With RAW, you have complete freedom to adjust the white balance 

after the shot, since it’s not hard coded into the image file. You also have a fair bit of 

latitude to adjust exposure and make color and contrast changes with RAW files.

Shooting in JPEG mode, you lose much of this flexibility. Any white balance changes 

will impart a color cast to the image. Your ability to adjust color and contrast is much 

more limited as well. The reason for this that RAW is not an actual file format. RAW is 

simply a set of information that is not completely locked in. JPEG is an actual image file 

format. It locks in settings such as white balance, color, and contrast when the shutter 

is released. If, for example, you are going to use Expose to the Right (ETTR, which is dis-

cussed in more detail in chapter 3), you have to shoot in RAW mode. JPEG simply does 

not afford you the ability to adjust exposure as you need to with ETTR.

You will also note that your camera gives you the option of choosing a color space 

for your images. Most cameras offer a choice of either Adobe RGB 1998 or sRGB. These 

are two imaging color spaces that are subsets of the total universe of color. The choice 

of in-camera color space applies only if you shoot JPEG. When shooting RAW, you can 

assign the color space you want during conversion of the RAW files. Note that I’m using 

the term color space and not color profile. There is a difference. A color space is indepen-

dent of any device (e.g., camera, monitor, scanner) and is a subset of the entire universe 

of color. A color profile is the data file that instructs the system on how to convert color 

from a source (e.g., camera, scanner) to a destination (e.g., monitor, printer) and is spe-

cific to that device. When I shoot JPEG, I shoot in the sRGB color space. The reason is 

that I shoot JPEG when the end use of the image doesn’t require a broad color space. 

Newspaper and magazine pages have a very narrow color gamut. The web is largely an 

sRGB environment.

Let’s take a look at the difference between the two color spaces so you can see what 

each offers and then decide for yourself which you want to use when shooting JPEG. 

Figure 2.12 shows the sRGB color space overlaid onto the Adobe RGB color space. You 

can see that sRGB is smaller and contains far fewer colors than Adobe RGB. 

Larger yet is the ProPhoto RGB color space. It’s not offered as an option in-camera but 

is available in Lightroom and ACR. 

Now we can begin setting up our color preferences in Photoshop.

Color Management
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Setting Up Photoshop

Before you get into editing images with the DZS, or any other methodology, you should 

establish your color settings in Photoshop. This will determine how colors are handled. In 

Photoshop, click on Edit>Color Settings and then click on the More Options button, and 

you’ll be presented with the dialog box shown in figure 2.13.

In the Working Spaces section of the dialog box, the CMYK, Gray, and Spot settings are 

not overly important unless you’re working with print shops and press printing processes. 

The key here is the RGB selection. I use ProPhoto RGB because it’s a very large color 

space and allows me to retain more of the color my camera captures than either Adobe 

RGB or sRGB. This is also the color space I tag my RAW files with when exporting. (We’ll 
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talk more about that in chapter 4.) Figure 2.14 shows the ProPhoto RGB space overlaid 

on the Adobe RGB and sRGB spaces. You can see the ProPhoto RGB space is larger and 

contains many more colors than either of the other two. With most of today’s modern 

DSLRs, you’ll still lose some color even with ProPhoto RGB because of the breadth of color 

the cameras can record.

Moving on to the next section of the dialog box are the Color Management Policies. 

Here is where you tell Photoshop how to deal with an image that has a color space that is 

different from your working space. If, for example, you open an image that is tagged with 

Adobe RGB, selecting Preserve Embedded Profiles will allow that image to be opened and 

stay tagged with Adobe RGB. If you select Convert to Working in the drop-down menu, 

the image will automatically be converted to your working space. This can sometimes do 

wonky things with color, particularly if your working space is smaller than the color space 

the image is tagged with. There is generally a good reason for an image to be tagged 

with a color space that is different from the working space. Your best bet is to select 

Preserve Embedded Profiles to maintain the embedded color space. As with the Working 

Spaces section, the CMYK and Gray options are less important for most photographers, 

so you can leave these set to the default. Because I tag my RAW files with the ProPhoto 

RGB space and set my Photoshop working space to ProPhoto RGB, I get fewer warning 

messages as well. Your best option is to keep things consistent between your Photoshop 

working space and the color space you tag your RAW files with during conversion.

The checkboxes at the bottom of the Conversion Options section are helpful for main-

taining the color consistency of your images. First are the options for Profile Mismatches.

If you have Ask When Opening checked, when you open an image that is tagged with 

the sRGB color space, for example, you’ll see a dialog that will ask you what you want 

to do with the image. If you have Ask When Pasting checked and you try to paste one 

image onto another that is tagged with a different color space, Photoshop will ask you 

what you want to do to resolve the color space conflict. And if you’ve checked the Missing 

Profiles Ask When Opening box, in the event you try to open an image that isn’t tagged 

with a color space, Photoshop will ask what you want to do with that image. Those who 

are comfortable with how they manage image color spaces in Photoshop can leave these 

boxes unchecked. If you’re newer to Photoshop or want the reminders, then keep the 

boxes checked. I keep them checked and recommend doing so if for no reason other than 

safety. And control. You’re the one deciding how color in your images is handled, not the 

software.

The third section of the Color Settings dialog box is Conversion Options. The Engine 

is the color management system that will be used to convert color from one space to 

another. Adobe (ACE) is the default. ACE stands for Adobe Color Engine. I recommend 

leaving this as the default because it’s the only option that is truly cross-platform (i.e., 

consistent on both Windows and Mac computers). The Intent is the rendering intent, 

which determines how colors are mapped from one color space to another and how 

out-of-gamut colors are handled. You’ll find a more extensive discussion of rendering 

intents in chapter 8. In this instance, the rendering intent tells Photoshop how to convert 

colors when the rendering intent option isn’t available in other places. Leaving this at the 

default of Relative Colorimetric is recommended. 

Setting Up Photoshop
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At the bottom of the Conversion Options section are three checkboxes. Black Point 

Compensation and Dither should both be checked. This is helpful when converting 

low-bit-depth images (e.g., 8 bit) to prevent banding in colors. The last checkbox, 

Compensate for Scene-referred Profiles, was introduced in Photoshop CS4 with the video 

capabilities that Photoshop now has. This is a feature for maintaining color consistency 

between Photoshop and Adobe After Effects, which is a video-editing software package. 

It has little consequence for still photographs, so it can be left unchecked. 

In the last section of the Color Settings dialog box, Advanced Controls, there are three 

checkboxes: (1) Desaturate Monitor Colors By, (2) Blend RGB Colors Using Gamma, and 

(3) Blend Text Colors Using Gamma. These can all be left unchecked.

The last piece of the Photoshop color setup is ACR. You determine which color space 

your RAW images are tagged with in ACR, as well as the bit depth and pixel resolution. 

The pixel resolution is less important because it can be changed later. 

Click on the link at the bottom of the ACR screen that indicates the color space, bit 

depth, and resolution (figure 2.15). This will open the Workflow Options dialog box (figure 

2.16). In this dialog, you can set your defaults for opening RAW images in Photoshop. You 

can see that I’ve selected ProPhoto RGB as the color space and 16 as the bit depth. This 

will ensure I retain as much quality as possible. Also note the checkbox at the bottom of 

the dialog that will allow you to open RAW images as Smart Objects by default.

The other choice here is Sharpen For. This will apply what is called output sharpening. 

Sharpening will be discussed in more detail in chapter 5. I would suggest leaving this set 

to None, as that setting will provide you with more flexibility later on. Output sharpening 

is the last step in the editing chain before printing, so choosing a setting for it now 

doesn’t make a great deal of sense.
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Image Management

The last step, but not the least important, in setting up a good workflow is deciding how 

to manage your images. That means deciding where you put images on your computer 

and how you sort and organize them.

Adobe Lightroom is a terrific digital asset management (DAM) tool. It’s more than that, 

of course, as it has very robust editing capabilities and, with version 4, now offers a full 

printing workflow that includes soft proofing. You don’t have to have a DAM package to 

keep track of your images. Even if you do, how you organize images on your hard drive 

can still make the process of locating images much easier.

Simply dropping all your images into a single folder on the hard drive is not good im-

age management. I’ve seen people get excited about showing an image they’re proud 

of, then spend the next 10 minutes or more trying to find it because they’ve dumped ev-

erything into a single folder. The excitement about showing the image goes away pretty 

quickly, particularly if they can’t find it. I’m going to offer you my own methodology for 

organizing images, and from there you can develop an organizational approach that 

works for you. I do use Lightroom, but I still have an approach to organizing my images, 

and that process can be used to find photos in Adobe Bridge as well. Even when open-

ing a file directly from Photoshop, I’m able to find it fairly quickly because my files are 

organized on the hard drive.

My approach is to organize images according to project or location. For example, 

I have a master folder called Commercial, into which all my commercial photography 

assignments go. Inside this folder are separate folders for each of my clients. If I have 

multiple assignments for a client, I’ll have a folder for each assignment inside the master 

client folder. Drilling down even further, all RAW images for a particular assignment go 

in a separate folder. JPEG and TIFF files also have separate folders. If I need to provide 

small, web-ready images, those will be into a separate folder. If I need to provide images 

cropped to a specific aspect ratio, those will go into a separate folder and the folder 

titled accordingly.

I apply a similar system based on location for my own photography. I have, for ex-

ample, shot in several places in New York State, so I have a master folder labeled New 

York State. Inside that folder are separate folders for all of the locations where I’ve shot, 

and then the various RAW, TIFF, and JPEG folders. A typical folder hierarchy might look 

something like this:

1.	 New York State

	 a. Buffalo

		  i.	 JPEG

		  ii.	 RAW

		  iii.	 TIFF

	 b.	 Letchworth State Park

	 c.	 Taughannock Falls State Park

	 d.	 Treman State Park

	 e.	 Watkins Glen State Park

Image Management
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Keywording
I assign keywords to my images when I import them into Lightroom. It’s much simpler 

to do this from the outset than to add keywords later. It is possible to batch keyword 

in Lightroom, which helps if you’re keywording after importing. Bridge doesn’t have an 

import function like Lightroom, but you can batch keyword in Bridge as well. It’s good 

to get into the habit of assigning keywords whenever you bring new images onto your 

computer. Keywords are important even if you have a strong folder system set up, because 

keywords allow you to find images across folders or across hard drives. Let’s say you’ve 

shot waterfalls in 10 different locations in three different countries, but Waterfalls is not 

the name of one of your master folders. Tagging those images with the keyword waterfall 

will allow you to find all of the images in all of the folder locations simply and quickly. 

You do need to exercise some care in how you set up your keywords. Take the example of 

using a country name to keyword. If you use USA for some images and United States for 

others, the images won’t all show up in the same keyword or text search. You may be able 

to get away with variations in some cases. For example, if you tagged some images with 

the province name Ontario and some with the abbreviation ON, those would show up in 

the same search using the text string on, whereas Virginia and VA would not. Even if your 

variations on Ontario show up in a single search, you might also get many other images 

you don’t want with a search string as non-specific as on. Taking care to be consistent 

and as specific as possible in your keywording will go a long way toward making your 

image organization process effective and will help you find the images you want when 

you want them.

Geotagging
The last aspect of image organization that I will touch on is a relatively new one—geotag-

ging (also called geocoding by Adobe). Geotagging is the embedding of location infor-

mation such as longitude, latitude, and city name in the metadata of a digital image file. 

It has become popular in the last few years as a by-product of photography-related social 

networking sites such as Flickr and Picasa. It does have another purpose, however. People 

looking to buy images are starting to use these social networks to search for photos by 

location and even by geographical coordinates. Google searches can bring people to your 

website through geotag information as well. Including this information in the metadata 

of images you post to the web can help others find you and will help generate revenue if 

photography is your business. Having location information included in the image meta-

data also makes it possible to search for images by location in Lightroom and Bridge.

There are cameras—some Sony Alpha models, for example—that have the ability to 

geotag images. For some cameras, such as advanced Canon and Nikon models, there are 

accessories that you can attach to the camera that will automatically geotag the images. 

These devices are often expensive. Even third-party options can be pricey. Many (perhaps 

most) photographers already have the tools to geotag their images by adding just a 

couple additional steps to their workflow. Small, handheld Global Positioning System 

(GPS) receivers with tracking capability can be used. These can record a track to a data 

file, and that data file can be used to embed the geographical information into the im-

age metadata. Today, an increasing number of people are carrying smartphones. Whether 

CHAPTER 2 | Color Management, Photoshop Setup, and Image Management

Even if you have a strong folder 

system set up, keywords are 

important because they allow 

you to find images across folders 

or across hard drives.

Digital_Zone_EN_final_01.indd   30 24.09.12   19:40

http://lib.ommolketab.ir
http://lib.ommolketab.ir


|  31  |

you have an iPhone, an Android phone, or a Blackberry, apps are available that will let 

you record a track to a data file. I’ve done this with a Blackberry and an Android phone. 

The process is simple. You set up the tracking app to record your location every so many 

feet/meters or so many seconds. The app records the coordinates of your location in a 

data file. This data file is then used by software to embed the location information into 

the image metadata after you download the data file and your image files to your com-

puter. The software does this by matching the timecodes of your images to the timecodes 

on the location data.

With the introduction of Lightroom version 4, Adobe included a Map module that 

allows users to geotag their images right in the software rather than using third-party 

software. This makes the process of geotagging images much simpler and faster. You can 

also use reverse geocoding, which, if enabled, will use the GPS coordinates to search the 

web and pull down detailed location data such as city, neighborhood, state/province, 

and country. Enable reverse geocoding in the Metadata tab of the Catalog Settings under 

the Edit menu.

In the Map module, you start the tagging process by loading your track log. Click the 

small squiggled line at the bottom of the screen (figure 2.17), and then in the popup 

window select Load Tracklog. Navigate to where you’ve stored the track log on your 

computer. I place mine in the master folder for the project or location. Referring to the 

sample file hierarchy earlier in the chapter, it would be the Buffalo folder. Once the track 

log is loaded, select all the images on the filmstrip with CTRL+A, then in the same menu 

select Auto-Tag Selected Photos. The one caveat here is that if you shot your images in 

a different time zone, you might have to adjust the Set Time Zone Offset. You’ll have to 

do this if you didn’t sync the clock in your camera with the clock in the device recording 

the track log file, and the recording device automatically updates to the local time of the 

location where you’re shooting. If you do sync the clock in the camera with the one in 

your GPS-tracking device, you can ignore the Set Time Zone Offset feature. 

In figure 2.17, you can see orange callout boxes with numbers inside. These represent 

the locations of tagged images and the number of images tagged at those locations. You 

can also geotag an image or a set of images simply by dragging them from the filmstrip 

at the bottom of the screen onto the map. This is a nice feature for instances in which you 

don’t have a GPS track log to work with. Of course, it may not be quite as accurate, but it 

should be better than having no information at all. 

If you’re concerned about privacy issues with images you post to the web or send to 

other parties, you can choose not to include the location information in the Export dialog. 

This kind of defeats the purpose of including it in the first place, if part of the reason you’re 

doing it is to make it easier for people to find you and your images on the web.

If you don’t use Lightroom, you can add location information to images with a third-

party program. PhotoPin is one for Mac/iPhone users. It includes both the tracking app 

and the desktop app that writes information into image files. On the Android platform, 

GPSLogger is an app that works well. Windows users have GPicSync as a desktop app to 

sync location data to image files. Blackberry users don’t have as much choice in phone 

apps: bbTracker is the only app I’m aware of that will create a track log file. I’ve used it, 

and it works well.

Image Management
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Image Backup
No discussion of image management would be complete without at least touching on the 

concept of image backup. It’s not worth the effort of organizing your images if you lose 

them in a hard drive failure. The odds are that you will have a hard drive failure at some 

point. Backing up your images is a very important step in the image-management workflow.

There are countless approaches to image backup. Some are simple, and some are com-

plex and expensive. The more important it is for you to be able to recover images in the 

event of a problem, the more complex and expensive your backup solution will need to be. 

Having a RAID setup inside your computer and nothing else is not a valid back up solu-

tion. RAID stands for Redundant Array of Independent Disks. The benefit of a RAID is the 

built in redundancy. A RAID system uses several hard drives for automatically replicating 

data. This is a good solution to guard against loss of data should one of your hard drives 

crash, but would do no good should you have a loss due to fire or theft. Having a RAID 

setup inside your computer isn’t a bad idea, but that alone is not a backup solution. Good 

backup means having duplicates of your images in other locations.

Perhaps the simplest, least expensive, albeit logistically difficult method of backing 

up digital images is to burn them to optical discs such as CDs, DVDs, or Blu-ray discs. 

This works reasonably well if you shoot a low volume of images. None of these discs will 

hold a large volume of images, and you have to develop a sound method of cataloguing 

and filing the discs so you can recover images when you want to. There are also concerns 

about the long-term data integrity of optical discs. You should have two copies of your 

discs as well, with one stored off-site in case of a fire or other damage to the discs in your 

home or office.

An external hard drive that you can connect to your computer is a better option. Ide-

ally, you should have two external hard drives—one that you keep on-site and one that 

you keep off-site, for example at a friend’s or relative’s house or in a safe deposit box. You 

should download images to the drives on a regular basis (e.g., weekly, or more often if you 

shoot large volumes of images) so that at any time your risk of loss is limited to a rela-

tively small number of images. Rotate the drives each time you do a back up so that the 
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risk of loss is limited to a short timeframe. This approach is adequate for low shooting vol-

umes, but hard drives do fill up. You can use multiple drives if you shoot higher volumes.

For those shooting higher volumes, a more complex system is likely needed. Network-

attached storage (NAS) devices come into play at this point. A NAS system is a storage 

device that is connected to a computer network that contains multiple hard drives that 

are set up in a RAID so you have the benefit of redundancy. A NAS device is essentially a 

small server. Because the device is connected to your computer via a network, it doesn’t 

have to be in the same physical location. An optimal, but expensive, solution is to have 

one NAS appliance at your home or office and a second at another location that is con-

nected to your network. This is really a solution for very high-volume operations that 

can justify the cost of setting up a larger network than one with a single router. A more 

economical approach is to have two NAS devices that, like single, external hard drives, 

you rotate on a regular basis. Having your own off-site NAS is almost like having your 

own cloud solution.

Cloud Backup
Cloud computing is a popular topic right now. It’s being heralded as the panacea for 

everyone’s computing needs (cloud-based software) and storage needs (cloud-based stor-

age services). Perhaps it will be in the future, but it isn’t really at present. Cloud storage is 

not inexpensive. Some services will provide you with a small amount of free space to get 

you to sign up, but the costs begin to climb when you exceed the free limit. Uploading to 

the cloud via a standard high-speed DSL or cable Internet connection is not very fast. You 

may have a 20Mbps or 30Mbps connection to your Internet service provider, but that’s 

the download speed. Upload speeds are typically about a tenth of that. Uploading large 

volumes of files will take an inordinate amount of time. On top of that, you’re trusting 

the security of your images to a third party. A third party you really know nothing about. 

A third party that may go out of business without notice and leave you no way to access 

or recover your data. Cloud storage is not something I would consider or recommend. At 

least not at this point in time. 

With Photoshop set up the way we want to handle color, and with the establishment of 

a sound color-managed workflow and a way to organize and backup our images, we can 

move on to actually taking pictures.

Image Management
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Chapter 3
Digital Exposure and Metering

No approach to editing and printing digital images will work if we can’t get the image 

right at the time of exposure. With digital cameras, the old computing maxim applies: 

garbage in, garbage out (aka GIGO). This chapter will walk through the basics of meter-

ing and exposure in digital imaging, so we can minimize the G.

Metering

Most of us tend to use the reflected-light meters in our cameras. These are wonderful 

tools that help us to get a correct exposure, but still aren’t perfect.

There are also handheld meters that can be used like in-camera meters to measure 

light reflected by a subject, or in incident mode, to measure the light falling on a subject. 

Many handheld meters are also able to measure light from studio strobes, which takes a 

more sensitive sensor. In-camera meters can’t measure strobes.

When applying the Zone System, Adams used a handheld spot meter. Spot meters are 

specialized meters that can measure light reflected from a very small area, typically a one-

degree arc. You can use them to make precise measurements of different areas of a scene 

without overlap of one area of brightness onto another, because the measurement area 

is so small. Most standard handheld meters do not have a spot function. If such a feature 

exists on a meter, it will be explicitly described by the manufacturer, and the meter will 

have a viewfinder that you look through to take readings.

Some in-camera meters also have a spot feature, but it’s not quite as useful as a hand-

held spot meter. Most in-camera spot meters measure a percentage of the field of view 

of the lens attached to the camera. Some meter an area as small as one percent, others 

meter three percent, and still others meter as much as nine percent, which really doesn’t 

make it a spot meter at all since its measuring area is so wide.

With a wide-angle lens even a one-percent spot meter can measure a wider area than 

desired. If your lens has a 140-degree angle of view, a one-percent spot meter will measure 

a 1.4-degree arc. The measurement is tied to the angle of view of the lens. Longer lenses 

with narrower angles of view will give you a smaller measurement area.

Most DSLR cameras have three or four metering modes, which can include a spot me-

ter, a center-weighted average meter, an average meter, and an advanced multi-segment 

meter. All of these are reflected-light meters, but work in slightly different ways. We’ve 

already discussed how a spot meter works. A center-weighted average meter works by 

averaging the brightness across the scene as presented in the viewfinder, but giving 

more weight to the center of the frame. That’s because a lot of people center their main 

subjects. Let’s assume the meter has three measurement zones—one for left of center, one 

for right of center, and one for the center of the frame. Let’s say we’re shooting with an 
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aperture of f/8. The area to the left of center is in shade, so the shutter speed meters 

as 1/30 second. The area to the right of center is in sunlight, so the shutter speed for 

that area meters as 1/500 second. The center is partly in shade, so the shutter speed 

for that area meters as 1/200 second. Now let’s assume that the weighting is 60% for 

the center and 20% for each of the other metering zones. The metered shutter speed 

for this made-up scene would be (0.60) (1/200) + (0.20) (1/500) + (0.20) (1/30) for 

a weighted-average shutter speed of 1/226, right in between the two camera settings 

available of 1/200 and 1/250. 

The average meter works by simply averaging the different areas of brightness in the 

scene to come up with an average brightness reading, and then setting an exposure for 

that average brightness. Using the same three-segment meter and scene as before we’d 

get a calculation of (0.33) (1/200) + (0.33) (1/500) + (0.33) (1/30) for an average 

shutter speed of 1/243, or the 1/250 second setting available on the camera. There isn’t 

a large difference in this case. In others the difference may be larger.

Multi-segment meters are high-tech average meters, if you will. Modern cameras have 

light metering systems that take brightness readings from many different areas of a 

scene and process each of them discretely with an on-board computer. The active focus 

point(s) may also be taken into consideration to help determine how the weighting of 

the different readings will be done with the active focus point(s) being used as an area of 

higher importance. The computer in the camera will calculate a weighted average read-

ing. Typically, the areas around the center of the frame or around active focus points are 

given more weight, and areas toward the edge of the frame are given progressively less 

weight. The scene will be analysed and compared to reference image information stored 

in the metering computer. Multi-segment meters are generally very accurate and do come 

up with a good exposure setting in most circumstances. Like all reflected-light meters, 

however, they can be fooled.

The 18% Gray Phenomenon
Fooled? How? Light meters are calibrated to a middle gray tone. Middle gray happens to 

be Zone V in the Zone System and represents an amount of 18% of the light that hits the 

subject being reflected back to the meter. That’s why we have 18% gray cards for taking 

meter readings.

This means that the reflected-light meter wants to turn everything it “sees” into a 

middle gray tone. If you take a photo of a black cat in a coal bin, what color do you 

think the cat will come out as? If you take a picture of a white sheet lying on snow, what 

color do you think it will come out as? The answer is the same in both cases: middle gray. 

The meter is fooled by overly light or overly dark subjects and comes up with the wrong 

exposure as a result.

Figures 3.1, 3.2, and 3.3 illustrate this. The images show a hibiscus flower in my gar-

den. The petals are white with contrasting dark pink areas. In the first image, I took the 

shot using my camera’s spot meter, measuring off the white petal with no adjustment to 

the metered exposure. The camera was a Canon EOS 5D, which has a 3.5% spot meter. 

I used a Sigma 105 mm f/2.8 macro lens with a 23-degree angle of view, so my spot 

meter was measuring a 0.8-degree arc. Given this small measuring arc and how close I 
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was to the flower—about one foot—I was able to use the spot meter and still isolate the 

white of the petal.

The white petal is middle gray. The histogram for the image shows us the same thing. 

The empty space on the right shows a lack of tone in the highlights. The peak in the 

middle shows us that most of the image (the petal) is middle toned, but the distribution 

in tones in this image is skewed far to the left, indicating an overly dark image. The in-

camera meter turned the white-petaled flower into a gray-petaled flower.

What happens if we increase the metered exposure by one stop? Having done so, 

figure 3.2 shows the petals are a much lighter gray, but still not white. The histogram 

shows that we still have underexposure, but overall less of it. The peak in the middle has 

moved to the right by one stop, but there is still a gap on the right tail of the graph telling 

us we have no whites. The distribution of tones on the histogram chart is pushed more to 

the right, but still not as far as it needs to be for a correct exposure.

Metering

t Figure 3.1: Reflected spot meter reading 

off the white of the petal. The image is 

two full stops underexposed.

t Figure 3.2: A one-stop increase in expo-

sure lightens the petals of the flower. This 

shot is now one stop underexposed.
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Now let’s take a look at what happens when we increase the metered exposure by two 

stops. As we see in figure 3.3, we now have nice white petals on the hibiscus. Just what 

we want! In the histogram, the peak has now moved nearly all the way to the right and 

there is no gap, indicating we now have white highlights. We have effectively compen-

sated for the meter being fooled by the bright subject matter. Take note of the direction 

we moved the exposure in this case. The meter wanted to underexpose our white subject, 

so we had to increase exposure to compensate. The opposite would be true in the case 

of an overly dark subject. In that case, the meter would want to overexpose the subject, 

making it lighter than reality, so to compensate we would need to decrease exposure 

to darken the subject back to what it should be. With time and practice, these types of 

adjustments become second nature.

This is how meters can get fooled. Even with very smart multi-segment meters, and 

with overly dark or overly light subjects, the meter will try to turn them into a middle gray. 

It does this with everything, actually, but the effect is most seen on very light or very dark 

subjects. In these cases, we have to compensate for the meter and adjust our exposure 

accordingly.

Incident meters—those that read light falling on the subject rather than light reflected 

by the subject—can’t be fooled in the same way as reflected-light meters. With an incident 

meter, you just set your exposure at the meter reading and you’re good to go. However, 

it’s difficult to measure the light falling on a mountain from half a mile away, so using an 

incident meter is not always practical.

Even though reflected-light meters can be fooled, using them to measure the bright-

ness range in a scene is still helpful. Just remember that the meter will want to turn 

everything into middle gray. The difference in exposure readings to turn a light subject to 

gray and a dark subject to gray will still be captured by the meter.

The exposure for our gray-petaled hibiscus was 1/2 second, at f/32 and ISO 100. The 

meter reading for the properly exposed, white-petaled hibiscus was 2 seconds, at f/32 
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u Figure 3.3: Properly exposed image 

showing true white in the petals
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and ISO 100. Knowing that the petal should be white and that the meter will try to turn 

it middle gray, we can compensate by the necessary factor to get a proper exposure the 

first time. We would increase the exposure by two stops from the meter reading. Recall 

from chapter 1 that this is essentially the “place” part of place and fall.

Test the meter in your camera under different conditions and in different situations. 

Figure out how each metering mode exposes the scene differently. This will help you in 

the field to know when you can accept the meter reading or when you have to help the 

camera out by adding real intelligence to the situation.

Metering
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What is a Histogram? 

Simply put, a histogram is a graph showing the distribution of the pixels in an image, 

from black on the left to white on the right.

What isn’t a histogram? 

As strange as it may sound, a histogram is not a substitute for a light meter.

Everything we see in the histograms in figures 3.1–3 and the assertions about whether 

the images are under- or overexposed is based on the context of the images.

A histogram that’s skewed to the left does not absolutely mean an image is underex-

posed. Conversely, a histogram skewed to the right does not absolutely mean the image 

is overexposed. In the previous examples, the histograms showed underexposure in the 

context of the image. Let’s look at some additional examples to see how the context of 

the image is important.

The histogram of the image in figure 3.4 is skewed to the right. But this is what’s called 

a high-key image. A high-key image is one in which most of the tones are light and there 

are few dark tones. In the context of this image, the histogram is fine.

The opposite of a high-key image is a low-key image. In a low-key image, most of the 

tones are dark and there are few light tones. The histogram for this type of image is 

skewed to the left, as shown in figure 3.5. In the context of the image, the histogram is 

correct. In another context it might show underexposure. But note that the graph contin-

ues nearly all the way to the right edge. In a truly underexposed image, this would not 

be the case.

CHAPTER 3 | Digital Exposure and Metering

p Figure 3.4: High-key image p Figure 3.5: Low-key image
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The image in figure 3.6 looks flat and lacking in contrast, and this is confirmed by the 

histogram. The graph is pulled in from both ends, indicating there are no true whites or 

true blacks. This is a flat- or low-contrast image.

Many people feel that this shape of histogram indicates a good image. It may, but not 

necessarily. What it shows is that the majority of the tones are in the middle zones. This 

may be fine, depending on the context of the image. The histogram that approximates 

what in math is referred to as a “normal distribution” is neither good nor bad by default. 

It depends on the image. It is rare, however, that we’ll want the histogram for a normal-

contrast image to show gaps at either or both ends.

The last kind of image we’ll look at is a high-contrast one. The histogram for a high-

contrast shot fills the entire graph. Often there are peaks at the left and right ends and 

flatness, or a trough, in the middle. This tells us that there are true blacks and lots of other 

dark tones, along with true whites and plenty of other light tones. That is exactly what the 

graph for the image in figure 3.7 shows, and in the context of the image, it is correct. At 

least it’s correct for me. Your vision for a similar image may be different, and that’s fine.

The histogram in and of itself does not tell us whether our image is properly exposed, 

and it should not be used as a proxy for a light meter. Context tells the tale. What may be 

an incorrect exposure in one image will be correct in another. Keep this in mind when you’re 

viewing your images in the field and when you’re editing them in the digital darkroom.

What is a Histogram? 

p Figure 3.6: Low-contrast image p Figure 3.7: High-contrast image
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Exposure

Now that we know how light meters work, we can move along to looking at how exposure 

is determined and what happens when we adjust one or more of the variables that go 

into exposure. What I like to call the “exposure triumvirate” is made up of shutter speed, 

aperture, and ISO.

Shutter speed is the amount of time the shutter stays open to let light pass through the 

lens and onto the sensor or film. Shutter speeds can range from fractions of a second to 

many seconds or minutes, and in some cases hours. For most DSLRs, the range of shutter 

speeds in one of the programmed exposure modes (more on these later) is from 1/8000 

second to 30 seconds. When you put the camera into what’s known as Bulb mode, shutter 

speeds of longer than 30 seconds can be obtained by holding the shutter open manually 

or, preferably, with a locking cable release.

The aperture is the opening in the lens that allows light through. It can be adjusted 

to different diameters. In most cameras, the aperture is in the lens, and the shutter is in 

the camera body. In some medium- and large-format cameras, the shutter and aperture 

are both in the lens.

Aperture settings are described by f-numbers such as f/4, f/8, f/16, and so forth. An 

f-number tells you the ratio of the focal length of the lens to the effective aperture, which 

is the diameter of the beam of light coming through the aperture. The “f“ refers to the 

focal length of the lens. Huh?

Take a lens with a focal length of 100 mm with the aperture set to f/4. The ratio of 

100:4 can also be expressed as 100/4, or 25. So the effective aperture is 25 mm. If you 

set the f-number to f/8, the effective aperture is 12.5 mm. In the case of a 200 mm lens 

with the f-number set to f/4, the effective aperture is 50 mm. Huh?

Remember that the f-number is representing a ratio. The ratio is constant, but that 

means the size of the opening has to vary. With longer focal length lenses, the aperture 

has to be larger to allow the same amount of light through.

This is important. While the size of the opening differs depending on the focal length 

of the lens, the amount of light that gets through onto the sensor or film is the same at 

any given aperture setting. So f/4 on a 14 mm lens lets the same amount of light through 

as f/4 on a 600 mm lens at the same shutter speed. If this weren’t the case, then light 

meters would be useless. We need to know that the relationship between the three ele-

ments of the exposure triumvirate is the same for all of our lenses.

The ISO setting is the wild card in the triumvirate. It’s not something that we would 

typically change unless we need to, or unless we want a certain look that comes from 

grain. In digital imaging, we don’t have grain, of course; we have noise. Noise and grain 

aren’t the same, and while grain can enhance some images, it is rare for noise to do so.

With film, moving from an ISO 100 film to an ISO 200 film actually meant the film was 

more sensitive to light. The tiny crystals of light-sensitive silver halide embedded in the film 

emulsion were larger on an ISO 200 film than on an ISO 100 film. As you increased the 

ISO rating, the grains become larger still as you moved up the scale to ISO 400, 800, and 

1600 films. Those larger, more light-sensitive crystals are what made the higher-rated film 

“faster,” or able to record an image at a faster shutter speed or smaller aperture.

CHAPTER 3 | Digital Exposure and Metering

The exposure triumvirate is made 

up of shutter speed, aperture, 

and ISO.
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With a digital camera, increasing the ISO setting does not actually make the sensor 

more sensitive to light. The pixel sites on a digital camera sensor have a fixed sensitiv-

ity to light. When we increase the ISO setting on a digital camera, what we’re doing is 

boosting the gain.

In a digital camera, light hits the pixels and is recorded as a number of photons that 

are captured by the pixel. This analog number of photons gets translated into a voltage 

that is then converted to digital information, and stored with all the information from the 

other pixels on the memory card. The number of photons each pixel can capture is fixed. 

Increasing the ISO setting does not mean more photons can be captured. So what does 

increasing the ISO setting do?

When we increase the ISO setting, the digital signal that’s captured is boosted. This 

comes at a cost, however. That cost is noise (the digital equivalent to grain). Noise is 

present in all digital images, even those taken at low ISO settings. When the signal is 

amplified, noise is also amplified. That’s why we see noise as more evident in higher-ISO 

digital images than in lower-ISO images. Advances in converting the analog photons 

into a digital signal and in processing that digital signal in-camera have given us newer 

cameras with lower overall noise, which means lower noise at higher ISO settings as well.

All digital camera sensors have what is called a base or natural ISO setting. It’s typi-

cally the lowest ISO setting the camera can be set at in its regular range (i.e., without 

going into the L/Low or H/High ISO settings). In many Canon cameras, for example, this 

is ISO 100. In some Nikons it’s ISO 200 and in others it’s 100.

Let’s take a look at each component of the exposure triumvirate in more detail.

Shutter Speed

As we noted earlier, the shutter speed is the amount of time the shutter remains open to 

let light pass through the lens and onto the film or sensor.

The shutter speed helps us control the appearance of action or movement. Faster shut-

ter speeds help us stop action and slower shutter speeds give blur or motion to action.

With a static subject, such as architecture, the shutter speed is less important and can 

be set to anything that produces a good exposure with the desired aperture and ISO 

settings.

When we have a subject or scene with movement, the choice of shutter speed becomes 

more important. Do we want to freeze the movement or allow it to blur slightly to give a 

sense of motion? It depends. Sometimes freezing movement is the way to go and some-

times not. In many sports images we see sharp, frozen images. The action depicted by the 

subject lets us know there’s movement going on. But some of the more compelling sports 

shots have motion blur in them. I recall a shot like that taken from above the bobsled 

track in Vancouver during the 2010 Winter Olympics. The photographer used a longer 

shutter speed, and the sled was a blur of color going through a curve in the track. It was 

not a traditional sports image, but it was incredibly compelling nonetheless. Sometimes it 

can be preferable to allow just a bit of motion blur into the shot. A race car on the track, 

for example, can be given a sense of dynamism with a little blur in the wheels.

Exposure

!
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The photo in figure 3.8 was taken at a shutter speed of 1/200 second. We can see the 

rotation of the wheel is blurred, which is what I wanted, but other parts of the shot are 

blurred as well. The writing on the car isn’t as clear as it could be.

In figure 3.9, I used a shutter speed of 1/400 second. We still have motion blur in the 

tires, but the writing on the car is clearer. There’s less blur in the driver’s helmet as well. 

It’s still not quite where I wanted it to be, though.

For the shot in figure 3.10, I used a shutter speed of 1/800 second. We still have mo-

tion blur in the wheels, but the rest of the car is quite clean and crisp. This is what I was 

looking for with the shot.

Let’s take a look at one more photo. In figure 3.11, I used a shutter speed of 1/1000 

second. As we can see, the rotational blur in the tires is much less evident. In my opinion, 

it’s not enough. If we get too fast and freeze the action too much, it begins to look like a 

staged shot taken on the track with the car sitting still. If there were more background in 

CHAPTER 3 | Digital Exposure and Metering

p Figure 3.8: With 1/200 second we have subject blur in 

parts of the car and the driver’s helmet

p Figure 3.9: 1/400 second is better but still has a little 

too much blur in areas other than the tires

p Figure 3.10: 1/800 second creates the right combination of 

wheel motion blur and sharpness in the rest of the image

p Figure 3.11: 1/1000 second is a little too fast with not 

quite enough rotational blur in the wheel
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the shot to show the panning effect of the camera and the background were blurred, this 

shot could work because we would get a sense of action and movement from the blurred 

background. In this case I wanted a close-up, so I needed more movement in the car to 

convey the sense of action, so I prefer the third shot.

When I took these shots, the car was coming off a slow hairpin corner, accelerating 

quickly and moving at about 80 miles per hour. I was about 30 feet away shooting at ISO 

160, 300mm, and f/4 with a full-frame-sensor camera. 

But what about capturing a slower form of action?

In figure 3.12, we have another isolation shot where there is no other action in the 

frame to give a sense of movement. If I had shot this with a fast enough shutter speed 

to freeze the hocky stick, it would, again, have looked like a staged shot. Using a shutter 

speed of 1/500 second, I was able to have the player’s head and body stopped but also 

retain a bit of motion blur in the hockey stick at the bottom of the shot. The bend in the 

stick also helps convey action.

Figure 3.13 was taken at 1/400 second, which froze the action because the movement 

in the shot was much slower. In the full-size photo you can read the writing on the puck 

and the goaltender’s eyes are clearly visible. Even though the action is frozen, we know 

there is movement because there’s more going on in the shot and the puck is off the ice. 

The position of the goaltender and the checking from the opposition player also help us 

know this is not a staged shot.  

Shutter Speed

p Figure 3.12: 1/500 second is fast enough to stop the 

motion of the player’s head and body but slow enough to 

give us motion blur in the stick

p Figure 3.13: 1/400 second is fast enough to freeze this slower 

action. In the full-size photo, the details are clearly visible

?
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To come back to our earlier point, shutter speed controls the way we capture move-

ment. You’ll need to do some testing in specific situations to determine which shutter 

speeds you should use get the degree of motion blur you want. The LCD on the back 

of the camera can be very helpful in the process, particularly when you zoom in on the 

recorded image to take a close look. Over time, you’ll develop a sense for the kinds of 

shutter speeds you’ll need to handle different situations and conditions.

When using slower shutter speeds, you may not be able to handhold your camera be-

cause even very small camera movements will result in blurry images. The rule of thumb 

for handholding is that your shutter speed should be at least 1/lens focal length. For 

example, with a 100 mm lens, your shutter speed should be 1/100 second or faster. With 

a 24 mm lens, your shutter speed can be as slow as 1/24 second. The reason for this is 

that the longer focal length magnifies the image more, and the effect of any shake is also 

magnified. Some people can handhold at slower shutter speeds and still get a sharp im-

age. Others can’t even go as slow as the rule of thumb indicates. Features such as image 

stabilization in the lens or camera body can also allow us to get sharper images at speeds 

slower than 1/focal length. But stabilization is not a silver bullet. You shouldn’t rely on 

it to rescue you from a bad exposure, because it won’t. Optical image stabilization only 

compensates for camera movement, not subject movement. The better option when shut-

ter speeds are getting too slow to handhold is to put the camera on a tripod. A monopod 

can be useful in some cases, such as when you want to pan.

Aperture

The aperture is the opening in the lens that allows light through onto the sensor or film. 

The aperture controls depth of field; that is, how much of our scene appears in sharp fo-

cus. All else being equal, a smaller aperture (higher f-number) will give us greater depth 

of field, which means more of the scene will appear in sharp focus. Conversely, all else 

being equal, a larger aperture (smaller f-number) will give us a shallower depth of field, 

which means less of the scene will appear in sharp focus.

Depth of field depends on two things: aperture and magnification. We know what the 

aperture is. What is magnification? Magnification is the size of the elements of our scene 

as rendered by the lens. Each lens has a magnification ratio. Zoom lenses have multiple 

magnification ratios because the magnification ratio is tied to the focal length of the lens. 

Magnification is determined by the focal length of the lens and the distance to subject. 

Being physically closer to your subject at any focal length means higher magnification. 

Shorter focal lengths will have lower magnification at any distance to your subject than 

longer focal lengths.

Given these facts, we can say that, in general, being closer to your subject will produce 

less depth of field than being farther away, and shorter focal length lenses will produce 

greater depth of field than longer focal length lenses—all else being equal (i.e., at the 

same distance and same aperture setting).

Let’s take a look at this by going back to our pretty, and ever cooperative, hibiscus 

flower. The camera was locked down on a tripod and the same focal length was used 

for each of the four shots in these examples (figures 3.14–17). All I did was adjust the 
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aperture setting between shots.

Figure 3.14 was taken at f/2.8 with a focal length of 105 mm and a distance to 

subject of about 1 foot. The focal length and distance to subject are the same for the 

remaining images in the sequence. I was focused on the tip of the stamen, which is nicely 

in focus here while the center of the flower and petals are out of focus.

Moving two stops down to f/5.6 in figure 3.15, we see that more of the stamen is in 

focus and the center of the flower is a bit less blurred. We have increased the depth of 

field by using a smaller aperture (larger f-number).

In figure 3.16, using f/11 brings most of the flower into focus, particularly the stamen. 

The center of the flower is crisper, but there is still a bit of softness in the petals on the 

right side. By this point, much of the isolation of specific parts of the flower is gone.

When we close the aperture down to f/22 in figure 3.17, the entire flower is in focus 

and we can clearly see the texture in the petals. At this point even parts of the back-

ground are fairly sharp.

Aperture

p Figure 3.14: Using f/2.8 produces a very shallow 

depth of field

p Figure 3.15: Using f/5.6 produces a little more depth 

of field and brings more of the flower into focus

p Figure 3.16: Using f/11 brings nearly all of the flower 

into focus

p Figure 3.17: At f/22 everything is in focus
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How do we use all of this?

Depth of field is useful when we want to make decisions about how to render a scene. 

If we want to show a wide, sweeping vista in a landscape, then it’s better to use a smaller 

aperture for greater depth of field. If we want to isolate a particular part of a scene from 

the background, then a larger aperture will help us do that. For example, when shooting a 

portrait in a setting with a busy or cluttered background, a shallow depth of field can help 

make the subject stand out and draw the viewer’s attention away from the background. 

These are just a few examples of how to use depth of field. Do some experimenting for 

yourself and see how you want to use it in your photography.

ISO

I call the ISO setting the “wild card” in the exposure triumvirate. I say this because I 

typically use it to compensate when I’m not able to use the aperture/shutter speed 

combination I want.

In most situations it’s best to use the lowest ISO setting you can and, preferably, the 

native ISO setting for the camera. That will give you the highest image quality with the 

lowest noise. Sometimes we want to add grain (or noise in the digital world) so we’ll use 

a higher ISO setting on purpose, knowing what the trade-off will be in overall image qual-

ity. But those instances are typically pretty rare.

When you’re unable to use the shutter speed or aperture you want with a given ISO set-

ting and you’re not willing to compromise, the wild card comes into play. You can increase 

your ISO setting and use the shutter/aperture combination you want.

At other times there really is no choice. For example, shooting sports in an arena can 

present a pretty dark environment for your camera, even if it’s lit for television. You may 

not be able to get your shutter speed high enough to achieve the right motion-stopping 

power, even shooting wide open. What to do? Increase the ISO setting. It’s common, for 

example, to shoot hockey or basketball with an f/2.8 lens wide open at a shutter speed 

of 1/400 second or faster, and an ISO setting of 1600 or higher.

Bringing back the compliant hibiscus plant, I want to demonstrate how increasing the 

ISO setting affects noise in the image. Figures 3.18–22 show 100% crops of the center of 

the flower. Each is taken at a different ISO setting. The shot is somewhat blurred due to 

the aperture setting, but we can still see the effects of noise in each image.

In the first image (figure 3.18) at ISO 100 there is really no visible noise. But at ISO 

800 (figure 3.19), there’s quite a bit of noise apparent in the image, but it’s still usable. 

The general image quality isn’t degraded significantly. 

The story begins to change by ISO 1600 (figure 3.20). Here we see significantly more 

noise, and the image quality is degraded. We also begin to notice a loss of detail. Look 

at the base of the stamen. There is a loss of shape and form, as well as some alteration 

in the color.

When we move to ISO 3200 in figure 3.21, the story gets even worse. ISO 3200 isn’t in 

the normal ISO range of the Canon EOS 5D that these shots were made with. The noise at 

this setting is objectionable. Some elements of the image are beginning to meld together 
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due to the loss of form and contrast. With film, this loss of form would be referred to as 

reduced acutance or edge clarity. We can also see discolored pixels at this setting. It re-

ally is an emergency-only setting. In other words, if you have to get the shot and have no 

other choice, use it, but otherwise avoid it.

While digital technology has improved greatly over the years since the original Canon 

EOS 5D was released, and while noise is generally now less at all ISO settings, the rela-

tionship between increasing ISO settings and growing levels of noise still holds. Although 

higher ISO settings are more usable now, the best practice is still to use the lowest ISO 

setting you can in a given situation.

ISO

p Figure 3.18: ISO 100 produces a clean image with no 

visible noise

p Figure 3.19: ISO 800 shows visible noise and the beginnings 

of lost contrast and detail

p Figure 3.20: At ISO 1600 noise is objectionable, 

causing marked loss of detail and contrast

p Figure 3.21: ISO 3200 is really an emergency-only 

setting due to the degradation of the image
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p Figure 3.22: Noise comparison between camera generations. An image from the original Canon EOS 5D at ISO 800 

is on the left, and one from the latest version of that model, the 5D Mark III, is on the right, also taken at ISO 800. The 

noise level is less apparent in the image from the newer camera.

Camera Exposure Modes

Now that we know what the exposure triumvirate is, how do we use it?

DSLRs have multiple modes and ways of allowing you to shoot. These modes range 

from fully automatic to fully manual. My advice is that you use only three of these: 

 Aperture Priority,  Shutter Priority, and  Manual. The other programmed modes and scene 

modes should be forgotten. Those are fully automated modes that give you no control 

over how your images turn out and you’ll leave all creative decisions up to the camera and 

the on-board computers if you use these. You’re reading this book because you’re pretty 

serious about your photography. And since you’re that serious about it, you’re going to 

want to take control of your images.

Aperture Priority Mode
In Aperture Priority mode (i.e., Av on Canon and A on Nikon), you manually set the ap-

erture you want and the camera automatically sets the shutter speed required to get a 

proper exposure. Use this mode when you want to control depth of fi eld and the shutter 

speed doesn’t matter as much. Keep in mind that your camera’s meter can be fooled in 

certain situations, so you may have to compensate.

In order to compensate for the unintelligent meter in your camera, DSLRs have a fea-

ture called  exposure compensation, which allows you to override the meter reading by 

increasing or decreasing exposure incrementally. Review your camera manual to fi nd out 

how to set exposure compensation. In Aperture Priority mode any exposure compensation 

you set will affect the shutter speed.

CHAPTER 3 | Digital Exposure and Metering
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Shutter Priority Mode
Shutter Priority mode (i.e., Tv on Canon and S on Nikon) locks the shutter speed manu-

ally set by you and the camera automatically sets the aperture needed to get a proper 

exposure. 

You can use Shutter Priority mode when the motion in your image is more important 

than depth of field. For example, with Shutter Priority you can use a slower (longer) shut-

ter speed to give flowing water the silky, cotton candy look that you see in figure 3.23, in 

which I used a slow shutter speed of about 3 seconds to produce the soft, flowing water 

effect. The image was made with an all-manual medium-format camera that had no 

Shutter Priority setting, but I would have chosen that setting if I had been selecting from 

semi-automatic modes. I say a shutter speed of “about 3 seconds” because the photo was 

shot on film, so the exposure information wasn’t recorded as it would be with a DSLR. 

Use faster (shorter) shutter speeds to freeze action, as we saw in the earlier images of 

the race car and hockey players.

In Shutter Priority mode, as in Aperture Priority mode, your meter can still be fooled. 

You may have to use exposure compensation to adjust the exposure. Using it in Shutter 

Priority mode will adjust the aperture.

Camera Exposure Modes

t Figure 3.23: Slower shutter speeds give 

a sense of movement in an image
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Manual Mode
The third mode you’ll want to use is full Manual. In this mode, you set both the shutter 

speed and the aperture. You take full control of the situation. There is no opportunity 

to use the camera’s exposure compensation feature, because you’re doing everything 

manually. Manual mode can be desirable when you want to take creative control of both 

movement and depth of field. 

As with Shutter Priority and Aperture Priority modes, the meter reading showing a proper 

exposure in Manual mode will not necessarily give you the desired exposure for the scene, 

so you still want to be aware of what you’re shooting and make adjustments accordingly.

In all three modes, keep in mind the caveats noted earlier in the chapter about hand-

holding and the need to use a tripod or monopod in some situations.

You can also change your ISO setting in all of these modes if the combination of aper-

ture and shutter speed you want to use isn’t going to give you the shot you want at your 

current ISO setting.

Bulb Mode
Depending on what you’re shooting and when, you may want to use Bulb mode. Bulb 

mode is essentially an extension of Manual mode. In Manual mode, you are limited to 

the slowest shutter speed the camera offers in the normal speed range, which is typically 

30 seconds. If you need to use shutter speeds longer than 30 seconds, Bulb mode allows 

you to do that.

In Bulb mode, the shutter stays open as long as you hold it open. You do that either 

with your finger on the shutter release button or with a cable release. Trust me—a cable 

release is preferable. Trying to hold the shutter open with your finger on a camera will 

induce camera shake. Using a cable release prevents it. Many cable releases let you lock 

the shutter open so you don’t have to hold the release button in. 

Bulb mode is useful for shooting at night and in other low-light conditions, especially 

if you’re capturing something like star trails and want to hold the shutter open for hours. 

Bulb mode is also helpful when you’re using a dark neutral density filter to capture fluid 

movement in water or clouds. That type of exposure can take several minutes with the 

popular 10-stop neutral density filter.

Exposing for Digital

Since digital photography came into its own in the late 1990s, there have been many 

ideas about how to expose for digital and whether digital is different from film. News 

flash: It is!

A digital sensor responds to light differently from a frame of film. Film responds to 

light in a non-linear manner. For the most part, if you double the exposure, you double 

the recording of light on the film. For the most part, that is. This relationship falls down 

at the top and bottom ends of the exposure. Film has a slightly curved response to light. 

It’s pretty much linear in the middle, but at the top and bottom it curves. For negative 

film, it goes up to the right at the top and down to the left at the bottom. This non-linear 

response to light in the shadows and highlights is what makes Adams’ Zone System work 
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the way it does. Each film has a slightly different curve, called a characteristic curve, but 

the curve for a particular negative film may look something like figure 3.24.

As we can see, for the most part, the response of the film to light is linear. But at the top 

and bottom the response flattens out. The top is called the shoulder, and the bottom is 

called the toe. The bottom axis measures exposure, increasing from left to right. The left 

axis measures the density of the film, increasing from bottom to top. Density is a measure-

ment of the lightness or darkness of an area of the film. It results in different things on 

slide film and negative film. On negative film, as we increase the exposure, the density of 

the negative increases. It’s reversed in printing and gives us our highlight areas.

The curve for a slide, or positive, film would look like the one in figure 3.25. With slide 

film, more exposure leads to less density in the slide, which gives us our highlight areas.

Digital sensors exhibit a linear response from the bottom to the top, with no shoulder 

or toe. Each doubling or halving of the exposure results in a doubling or halving of the 

amount of light recorded by the sensor from shadows to highlights.

With film, we can play with the exposure to get what we need, knowing we have a bit 

of wiggle room. If we want to lift the shadows a bit, we can increase the exposure slightly 

and, if we’re careful, we won’t overexpose the highlights. Conversely, if we want to bring 

down the highlights a bit we can reduce the exposure slightly and, if we are careful, we 

won’t lose all our shadow detail to inky blackness. That wiggle room doesn’t exist in 

the same way with digital photography. There is some wiggle room, however, and we’ll 

discuss it later.

We can see from the two curves that negative film and slide film respond to light in op-

posite ways. This makes sense when we consider that one is a negative medium and the 

other a positive medium. With negative film, higher areas of density on the negative block 

light during the printing process and become the lighter highlight areas in the print. Keep 

in mind what I said earlier: All film starts out as negative film. Slide film undergoes a 

reversal process during development to give us a positive finished product. 

Exposing for Digital

p Figure 3.24: Sample response curve for negative film p Figure 3.25: Sample response curve for slide film
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The Zone System was created for use with negative film—black-and-white negative 

sheet film, to be specific. The mantra of the Zone System is “expose for the shadows, 

develop for the highlights.” There are a few reasons for this.

If shadow areas are underexposed, they melt away into undetailed black holes. Given 

the nature of the film, however, some highlight detail can be recovered. Negative film is 

more forgiving of slightly increased exposure than decreased exposure. If you attempt to 

wring detail out of underexposed shadows, what happens is mostly that dark tones be-

come lighter shades of gray and grain becomes more visible, as we discussed in chapter 1.

The opposite is true of slide film. With slide film the mantra was “expose for the 

highlights.” Increased exposure would “blow out” highlights and render these areas as 

undetailed white blobs. Our eyes are naturally drawn to lighter areas of an image, so 

overexposed highlights would distract the attention of the viewer. Trying to tone down 

highlights would just create unappealing areas of blank gray.

Where does digital photography fit in? It’s a positive medium, so does that mean you 

should slightly decrease exposure to protect highlights? Changes in sensor technology 

have introduced a minor shoulder at the top of the digital response curve, and in-camera 

JPEG processing applies a tone curve to create more pleasing contrast, but the digital 

response curve is still linear.

In the early days of digital, a bias toward slight underexposure was recommended. Be-

fore the use of anti-blooming circuitry on sensors, overexposure of one pixel could spread 

or “bloom” into adjacent pixels, giving the area a washed-out appearance. Anti-blooming 

circuitry effectively shuts off the pixel as it reaches full exposure so that it won’t accept 

any more light, thus avoiding blooming. Even with this, overexposed highlights are not 

desirable and detail cannot be recovered later.

The problem photographers encountered when even slightly reducing exposure was 

that digital noise is more evident in underexposed areas of an image. Increasing exposure 

or brightening the image in the digital darkroom makes noise even more visible.

As sensors improve and photographers learn more about the limits of increased exposure 

in digital cameras, they were surprised to discover that there is a good deal of wiggle room 

after all. An image that appears to be overexposed on the LCD of the camera—complete 

with blinking highlights—can actually have full highlight detail available. 

Figure 3.26 shows an exposure that’s slightly reduced to protect the highlights. This is a 

screen capture from ACR with the underexposure warning turned on, which shows up as 

the blue shaded areas. The blue shaded areas lack information and will exhibit a high 

degree of noise if lightened.

Figure 3.27 shows a normal exposure of the same scene. In ACR, the Blacks slider has 

been moved slightly to the right to reduce the appearance of underexposure in the brush 

at the lower left. If we look closely at the shadow areas of the image, we can see that 

there’s still quite a bit of noise in the shadows. How do we deal with it? Take note of the 

histogram for this shot.
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Exposing for Digital

t Figure 3.26: Underexposure warning 

in ACR

t Figure 3.27: A normal exposure in ACR
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Figure 3.28 shows one way the shadow noise can be dealt with. In this image, the expo-

sure was increased one stop from the previous image. The screen capture from ACR shows 

what looks like overexposure in the area behind the lighthouse. Note that I didn’t say 

the shot has a one-stop overexposure, only that is looks like an overexposure. Over- and 

underexposure are mistakes. Increasing or decreasing exposure from the meter reading is 

a purposeful action, not a mistake.

Is there really overexposure in the clouds? No, there isn’t. That’s the wiggle room men-

tioned earlier. 

In the version of the image shown in figure 3.29, an exposure correction of –1, a High-

light correction of –25, and a Whites correction of –35 were applied. Last, a Blacks cor-

rection of +30 was applied to eliminate the small bit of underexposure in the brush in 

the lower left corner.

What do we see now? No overexposed highlights and no underexposed shadows. The 

shadows are dark, but that’s to be expected. What we have is an image that looks very 

much like the normal exposure but is actually better.

Expose to the Right
This technique is called Expose to the Right (ETTR). It’s a controversial method of 

digital exposure. It’s probably more controversial than the Zone System has been over the 

years. There are some who suggest that ETTR is the only way to expose for digital in all 

situations. In my opinion, that is flat out wrong.

ETTR can work in a few situations: (1) when the brightness range of the scene being 

photographed fits within the brightness range of the sensor, and (2) when you’re shoot-

ing at the base ISO of your camera. If either of these conditions is not true, ETTR does 

not apply. We’ll examine techniques for dealing with situations outside these conditions 

in chapter 6. If you’re shooting at an ISO setting above the base ISO, you can usually 

achieve the same results as with ETTR by simply dropping the ISO setting down equiva-

lent to the increase in exposure. For example, if you’re shooting at ISO 800 and increasing 

exposure by one stop for ETTR, you can move to ISO 400 and expose normally to get the 

same results. With a few cameras, it can be beneficial to shoot ETTR above the base ISO. 

Even then, it will typically work only for the lower part of the ISO range. Testing with your 

camera will help you determine whether you can effectively use ETTR at higher than base 

ISO, and how high you can go and still have the benefit of ETTR.

Why did I say the ETTR shot looked similar to the normal exposure but was actually 

better? Because the ETTR shot captured more light. More light means more signal. More 

signal means a better signal-to-noise (SNR) ratio and less evidence of noise in the shot. 

You’ll need to do some testing with your camera to determine how much you can push 

the exposure and still have recoverable highlights. You’ll also have to experiment with 

the in-camera contrast, saturation, and sharpness settings to optimize the LCD image for 

determining whether you’ve gone too far with ETTR. The preview image on the back of 

the camera is actually a JPEG rendered with the in-camera settings, not a preview of the 

RAW image. By adjusting the in-camera settings, you can get a closer match to what you 

see when you open your image in ACR.

CHAPTER 3 | Digital Exposure and Metering
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Exposing for Digital

t Figure 3.28: One stop increased 

exposure

t Figure 3.29: After exposure corrections
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Most DSLR cameras on the market today are able to generate 14-bit RAW files. These 

14 bits provide 16,384 levels of information. Today, DSLRs can also capture about 11 to 

13 stops of light. Half of the 16,384 levels of information (8,192) are contained in the 

uppermost stop. Half of that again (4,096) is contained in the next stop. This progres-

sion continues down to the last stop in the shadows, which, in a camera with a 12-stop 

brightness range, contains only 4 levels of data. With so little data—so little signal—in the 

lower stops, it’s easy to see why noise is more prevalent in the shadow areas of an image. 

By pushing the exposure to the right without overexposing, thereby capturing more levels 

of data, we improve the SNR and reduce the evidence of noise even after making our 

exposure corrections. Moreover, we will end up with more distinct steps of gray tones in 

the shadows. The linear representation of a digital capture is shown in figure 3.30. Notice 

that at the left end, you really can’t even distinguish between the stops any longer. The 

step wedge in chapter 1 showed grayscale values for zones. The two step wedges are very 

different in appearance. That step wedge in chapter 1 is what we have after applying a 

gamma correction to spread out the brightness values more evenly. 

In Photoshop or another image editing application, a linear image would look very 

dark. The reason is that our computer monitors are not linear in the way that they display 

information on-screen. Computer monitors have a built-in gamma curve with a concave 

shape. Think of opening the Curves panel in Photoshop and pulling the curve downward. 

This would roughly replicate the gamma curve of a monitor. In figure 3.33, I have done 

just that in the gamma-corrected image you see in figure 3.32. Notice that it looks very 

much like the linear image in figure 3.31. The gamma correction applied to a camera 

RAW file or an in-camera JPEG is the inverse of the monitor gamma curve. The two curves 

offset each other and bring our on-screen display back to a linear condition.

ETTR is, in my opinion, a holdover from the film Zone System. It’s a digital version of 

increasing exposure and contracting development. Just as that method reduces the evi-

dence of grain in film, ETTR reduces the evidence of noise. This is most helpful in shadow 

areas, particularly if we want to brighten these areas. It’s another benefit of digital as 

compared to film. With digital, our shadows are not locked in at the time of exposure as 
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u Figure 3.30: Step wedge representing 

linear digital capture
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Exposing for Digital

t Figure 3.31: True linear image viewed 

in ACR

t Figure 3.32: Gamma-corrected image 

in ACR

t Figure 3.33: Gamma-corrected image 

altered to replicate linear gamma image
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they were with film. We can lighten or darken shadows, midtones, and highlights.

The images in figure 3.34 illustrate this benefit. The one on the left is a 100% crop of 

a shadow section of the normal exposure. The one on the right is the same crop of the 

ETTR image.

In the first image, the noise in the shadow areas is much more evident and unappeal-

ing. This would definitely show up in a print. In the second image, the ETTR image, noise 

is significantly reduced and would not be visible in a print of the same size. To make the il-

lustration clearer, I increased the brightness of both images by the same relative amount. 

This brightening also shows how shadows can be lifted in an ETTR image without making 

noise visibility objectionable.

CHAPTER 3 | Digital Exposure and Metering

p Figure 3.34: Normal exposure (top) shows more noise. The ETTR image 

(bottom) has less visible noise.
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Important note:  

It is important to keep in mind that if you’re going to use ETTR to expose 

for digital capture, you MUST make your exposure adjustments to the 

RAW image in your RAW converter before employing the Digital Zone 

System discussed in chapter 5.

Exposing for Digital
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Chapter 4
Tools of the Digital Zone System

Before getting into the meat of the Digital Zone System, let’s take some time to walk 

through the main tools that are used with this editing methodology. In this chapter, I will 

outline the various shooting and editing tools that are recommended, and I’ll provide an 

explanation of what each does and why I suggest it. My hope is that ACR will eventually 

be fully integrated into Photoshop. Until that happens, we’ll have to work with the two 

components of Adobe’s software separately.

Camera and File Format

If you’re going to use ETTR, you have to shoot RAW. JPEG simply 

does not provide the flexibility to adjust exposure, white balance, 

and other variables that RAW does. The images shown here il-

lustrate the differences between RAW and JPEG. The first image 

(figure 4.1) is the RAW file out of the camera. The second image 

(figure 4.2) is the RAW file after adjustments made with ACR’s 

Basic panel. Figure 4.3 is a JPEG of the RAW file with the same 

adjustments. With the RAW file, it was possible to pull back more 

detail in the sky, particularly above and directly behind the light-

house. Its colors are better, and the overall image has more life 

than the edited JPEG. It should be pretty clear that RAW is the 

preferred file format for use with the DZS. There may still be times 

to shoot JPEG, but not when you want to use the DZS for editing. p Figure 4.1: Unaltered RAW file

p Figure 4.2: RAW file with adjustments in ACR p Figure 4.3: JPEG file with the same adjustments in ACR
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RAW is not a fixed file format. It is merely a collection of information. Camera settings 

such as white balance and color space are not locked in with a RAW file. RAW files 

are recorded as metadata attached to the image data, and the metadata items can be 

changed with little consequence. A comparison of similar white balance adjustments to a 

RAW file and a JPEG file are shown in figures 4.4 and 4.5. On both images, the white bal-

ance setting was increased (made warmer). You can see that in the JPEG file the change 

has imparted a color cast to the whole image and impacted areas where I didn’t want to 

add warmth, such as in the blue sky and the blue hue in the shadowed areas along the 

shoreline. With the white balance adjustment to the RAW file, the already warm-toned 

areas of the sky have been made warmer, but there’s also better retention of the blue in 

the sky and in the coolness of the rocks along the shore.

Given that we’re talking about a Zone System methodology for digital photography, 

shooting RAW makes absolute sense. Remember that the Zone System is about control. 

Shooting RAW allows you to maintain that full level of control in the DZS. Think of the 

RAW image out of your camera as the latent image on a sheet of 8x10 film. Nothing 

has been done to it. You make all the decisions about how it will be developed. There is 

one big difference between film and digital, though. With film, your shadows are locked 

in at the time of exposure and you really only have control over the highlights during 

development. With digital and RAW conversion, you have control over both shadows and 

highlights. This brings us to the next DZS tool.

Lightroom 4 and Adobe Camera Raw 7

Lightroom is a digital image editing and digital asset management (DAM) product from 

Adobe. It’s a terrific package if you need all of the DAM functionalities it offers along with 

the editing capabilities. The core of the editing functionality in Lightroom is ACR, which 

is Adobe’s RAW conversion utility. It interprets the RAW image data from your camera 

and converts that data into a viewable image. It also offers a great deal of functionality 

for editing and optimizing the RAW image. The editing capability in Lightroom is the 
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p Figure 4.4: White balance adjustment to RAW file p Figure 4.5: White balance adjustment to JPEG file
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same as what you have with ACR in Photoshop. So whether you edit your RAW files using 

Lightroom or ACR in Photoshop makes no difference. 

With the latest version of Lightroom (version 4) and the latest version of ACR (version 

7) that’s included with Photoshop CS6, Adobe has made some compelling changes to 

how you can render RAW files. The adjustment options in the Basic panel have been 

modified and a new conversion engine, called Process Version 2012 (PV2012), has been 

included. Gone are the Recovery, Brightness, and Fill Light adjustments. In addition, the 

Exposure slider functionality has been changed. In the previous versions, if a Fill Light 

or Recovery adjustment was pushed too far, it could begin to affect other areas of the 

image. This was an undesired effect. In the new version, you have Exposure, Highlights, 

Shadows, Whites, and Blacks. Contrast is still there, too, and it works the same as before. 

The render curve in the default camera profile has been changed as well. Figure 4.6 shows 

an ACR screenshot of the unaltered RAW file when opened with the previous conversion 

Lightroom 4 and Adobe Camera Raw 7

t Figure 4.6: Unaltered RAW file with 

PV2010

t Figure 4.7: Unaltered RAW file with 

PV2012
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engine, and figure 4.7 shows the same file when switched to PV2012. Note the difference 

in the highlight warning of the sky. PV2012 does a much better job by default of reining 

in highlight values. If this image had warnings at the shadow end of the exposure, you 

would see that a similar effect happens with what previously might have been blocked-up 

shadows. With PV2012, Adobe has come the closest yet to replicating the shoulder and 

toe of a film characteristic curve.

You’ll know you’re working with a previous PV if, in the lower right corner of the image 

window in ACR or the Develop module of Lightroom, you see a small exclamation mark. 

Clicking this exclamation mark will update the image to PV2012. In Lightroom, you’ll be 

asked if you want to update just the one photo, or all photos in the filmstrip. Holding the 

ALT key while clicking on the exclamation mark in Lightroom will convert just the single 

image to the new PV.

The way that the 2012PV works on RAW files is different from prior versions and it 

requires a fairly significant change in mindset to optimizing RAW images. To get the full 

benefit of Adobe’s RAW conversion capability, you should be using the most up-to-date 

software. The histogram for the image is actually split up into five sections. Highlights 

controls the section immediately to the right of the midtones, and Shadows controls the 

section immediately to the left. Whites controls the section at the very top end of the 

exposure range, the far right of the histogram, and Blacks controls the section at the very 

bottom end of the exposure range, to the far left of the histogram. These are the main 

adjustments you’ll use in correcting an ETTR image. You can, of course, use the other color 

and contrast adjustments to enhance color, hue, and contrast before sending the image 

into Photoshop.

I’m going to use Lightroom for the next couple of illustrations because the effect is 

more easily seen in Lightroom than ACR. But keep in mind that the same thing is hap-

pening when you’re working in ACR.

The effect of each slider is largely limited to the area of the histogram it pertains to, 

with just enough overlap or feathering to retain smooth tonality. This effect will seem fa-

miliar in the next chapter when we begin using the DZS. Moving your cursor over each of 

the adjustment sliders will generate a light gray overlay on the portion of the histogram 

that will be affected by the adjustment. The screen capture in figure 4.8 shows this while 

the cursor is over the Exposure slider. 

The ability to adjust individual areas of the image while minimally affecting other 

areas lends itself to Zone System methodology and meshes well with what we’ll do in 

chapter 5. 

The last thing to note in ACR before bringing an image into Photoshop is that we can 

open the image as a Smart Object. To do this by default, click on the image information 

link at the bottom of the ACR window (figure 4.9). That will open the Workflow Options 

dialog (figure 4.10), where you can make choices about how RAW images will be opened 

in Photoshop. At the bottom of the dialog box, be sure to check the box for Open in Pho-

toshop as Smart Objects. If you’re coming from Lightroom, right-click on the image in the 

Library, and select Edit In>Open as Smart Object in Photoshop. 
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Lightroom 4 and Adobe Camera Raw 7

t Figure 4.9: Image information link

 in ACR

t Figure 4.8: Histogram highlighted in 

the area affected by the Exposure slider

t Figure 4.10: Worflow Options showing 

Smart Objects checkbox
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When Lightroom sends a file to Photoshop, it picks up the color space you’ve pre-estab-

lished in your Lightroom preferences. To set up your preferences, go to Edit>Preferences 

(Lightroom>Preferences on the Mac) and click on the External Editing tab (figure 4.11). 

This allows you to set up what are essentially the Workflow Options you established in 

ACR. In my case, I’ve set up Lightroom to transfer images as 16-bit TIFF files tagged with 

the ProPhoto RGB color space. The resolution box can be set to anything, as it can be 

changed later without affecting image quality. I set Compression to None. You can apply 

lossless compression to TIFF files, but Photoshop will decompress the file to work with it, 

so there is no point in applying compression here.

With the changes made to the RAW file in ACR, we can now move on to the DZS tools 

that will be used in Photoshop.
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u Figure 4.11: External Editing 

preferences in Lightroom
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Photoshop CS6

In this section, I will introduce the four basic tools we will be using in Photoshop:

•	 Smart Objects

•	 Layers

•	 Layer Masks

•	 Alpha Channels

Smart Objects
Smart Objects are brilliant! Smart Objects provide a way of working in Photoshop that 

is completely non-destructive. The reason for this is that you’re not actually working on 

the image itself when you’re editing a Smart Object. You’re working on a copy of the im-

age that has the original image embedded within it. This protects the original from any 

changes.

You know you’re working with a Smart Object when you see a small icon in the layer 

thumbnail, which looks like a page with a turned corner (figure 4.12).

Working with RAW files as Smart Objects is very slick. Because the RAW image is al-

ways embedded in the Smart Object, you can reopen it in ACR by double-clicking on the 

image thumbnail in the Layers palette. You can make additional adjustments to the RAW 

file, click OK, and see the adjustments made to the image you’re working on. 

You’re not able to edit the pixels of a Smart Object because it doesn’t have any actual 

pixels. The pixels are in the embedded image inside the Smart Object. This being the 

case, you can’t use the Brush Tool or do any cloning or healing directly on a Smart Object. 

You’re not able to apply any adjustment tools such as Curves, Levels, or Hue/Saturation 

directly to the Smart Object. Rather, they have to be applied as adjustment layers. Any 

filters you apply, like Unsharp Mask or High Pass, similarly will not be applied directly 

to the Smart Object but will get applied as Smart Filters. Smart Filters appear below the 

Photoshop CS6

t Figure 4.12: Page icon indicating the 

layer is a Smart Object

Digital_Zone_EN_final_01.indd   69 24.09.12   19:42

http://lib.ommolketab.ir
http://lib.ommolketab.ir


|  70  |

Smart Object thumbnail (figure 4.13). The beauty of these is that they’re completely edit-

able and reversible at any time. Double-click on a Smart Filter to reopen it and adjust the 

settings. Right-click on a Smart Filter to delete it entirely. The one downside is that you’re 

not able to rename a Smart Filter. Perhaps that will change in the future. 

Layers
You’re going to be working a lot with layers in the DZS, both with image layers and 

adjustment layers. Image layers are simply different versions of the same image, or 

different images, that are used to make up a composite (figure 4.14). Adjustment layers 

are individual adjustments to an image that are applied in a virtual way on top of an 

image layer (figure 4.15). The effect of the adjustment layer is seen on the layers beneath 

it. The reason for using adjustment layers is that doing so makes the editing process 

non-destructive. By using adjustment layers, you’re not touching the pixels inside your 

master image. 

Cloning or healing with Smart Objects requires one additional step, but it’s a simple 

one. Create a new, blank layer above your base layer by going to Layer>New>Layer or 

click on the icon to the left of the garbage pail on the Channels palette. Activate your 

Clone Stamp Tool or Healing Brush Tool, and you’ll see a drop-down menu called Sam-

ple at the top of the screen in the toolbar (figure 4.16). Select Current & Below in the 

drop-down. That will allow you to clone and heal onto the base layer from your new 

blank layer.
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u Figure 4.13: Unsharp Mask applied as 

a Smart Filter
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Photoshop CS6

p Figure 4.14: Image showing two image layers

p Figure 4-16: New blank layer for cloning/healing, with Sample set to Current & Below

p Figure 4.15: Image showing multiple adjustment layers
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Layer Masks
Looking at the adjustment layers in figure 4.15, note the white box next to the layer 

thumbnail. That is a layer mask. 

Layer masks allow you to apply adjustments to specific parts of the image by masking 

out, or hiding, other parts. With layer masks, white reveals and black hides. Gray partially 

hides. The deeper the gray, the more gets hidden. A completely white layer mask means 

that whatever effect you apply will be applied to the entire image. Conversely, a com-

pletely black mask means the effect will be seen on no part of the image. An example 

will help illustrate this. 

Figure 4.16 is an image that I made adjustments to in ACR, then opened up in Pho-

toshop. In case you’re wondering what it is, it’s a shot of autumn foliage taken with a 

longish shutter speed and a vertical panning movement of the camera while the shutter 

was open. To the right of the image you see that I’ve added a Hue/Saturation adjust-

ment layer, but I’ve also manually painted out parts of the mask. Figure 4.17 shows that 

using the Brush Tool and selecting Black as my foreground color on the Tools palette, I 

painted over the left third of the image. Next, I switched my foreground color to middle 

gray (R=G=B=128) and painted over the middle third of the image. I left the right third 

of the image untouched. You can see this in the layer mask icon. None of the painting 

shows up in the image, which is what we want, but we do see where the painting was 

done on the layer mask icon. 

Next, I simply reduced Saturation on the Hue/Saturation adjustment layer to –100. 

You see the effect on the image itself. On the left third where I completely hid the mask, 

the saturation reduction has no effect. In the middle third, the saturation shows at 50 

percent strength. On the right third, where the mask remains fully visible, the saturation 

adjustment is at full effect and there is no color remaining in this area. You can apply a 

layer mask to any layer by going to Layer>Layer Mask and selecting the type of mask you 

want to add, or by clicking on the icon of the square with the hole in the middle at the 

bottom of the Channels palette to the right of the fx icon.

In essence, layer masks are a type of alpha channel, but applied to a layer rather than 

saved as a new channel. That brings us to the next tool in the DZS toolkit: alpha channels.

Alpha Channels
An alpha channel is really nothing more than a saved selection. Alpha channels, or saved 

selections, are used in cases when you’re likely to want to use a selection more than once 

and you don’t want to have to go back and recreate the selection. 

Alpha channels show up in the Channels palette below the RGB composite and indi-

vidual R, G, and B channels of an image. These channels work in the same way as any 

mask: Black hides, white reveals, and gray partially reveals, depending on how deep the 

gray is. Going back to our previous image, if we take a look at the channels palette, below 

the RGB composite and individual color channels is something called Hue/Saturation 

Mask 1 (figure 4.18). It contains the same black, gray, and white sections as the layer 

mask. This is an alpha channel.

In this case, the alpha channel was created by the Hue/Saturation adjustment layer 

but is only temporary. It’s visible only when the adjustment layer is active. When you click 
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In essence, layer masks are a type 

of alpha channel, but applied to a 

layer rather than saved as a new 

channel.
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Photoshop CS6

p Figure 4.17: Layer mask with selective effect created by painting with the Brush Tool

p Figure 4.18: Alpha channel visible in channels palette
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on the main base layer, the alpha channel goes away. Clicking on the Hue/Saturation 

adjustment layer again will bring the alpha channel back. We can make it permanent—

or permanent until we delete it—by saving the selection. To do this, go to Select>Load 

Selection, then Select>Save Selection. You can make this process easier by clicking on the 

small dotted circle at the bottom of the Channels palette, which will load the selection, 

and then clicking on the icon directly to the right of the dotted circle, which will save the 

selection as a channel. The selection is now saved as a channel and appears as Alpha 1 

in the Channels palette (figure 4.19).

Any selection in an image can be saved as an alpha channel, whether a very simple or 

very complex selection. What we’ll be doing in chapter 5 is making selections based on 

luminance or brightness values in the image and saving those as alpha channels. I’ll pre-

view one of those selections now. I’ve selected the highlight values (everything brighter 

than 128) in the impressionistic image shown in figure 4.20, and saved that selection as 

an alpha channel called Highlights.

With this selection saved as an alpha channel, we can come back to it at any time, 

load it, and apply adjustments to the image using that selection. To load the selection in 

the future, you can go to Select>Load Selection and choose the desired channel from the 

drop-down menu, or you can click on the alpha channel to activate it, then click on the 

dotted circle at the bottom of the Channels palette. You can also simply press the CTRL 

key (A on Mac) and click on the desired alpha channel.
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p Figure 4.19: Selection saved as a new alpha channel
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When you click on an alpha channel to activate it, the ef-

fect of the mask is easily seen in the image. I’ve switched to 

a different image for the example in figure 4.21, because it 

has a broader tonal scale and shows the effect more clearly. 

Note that in the file information at the top of the image, 

it shows Zones 7–10. This is one of several masks we’ll be 

creating in chapter 5.

Alpha channels are also saved with the image, and are 

available in the future should you wish to go back and 

refine or change previous edits. The alpha channels will 

remain part of the image file until you delete them.

That covers the major and more complex tools that will 

be used in the DZS. The rest are standard tools and ad-

justments. These include Curves, Levels, Hue/Saturation, 

Vibrance, and Unsharp Mask. With those basics and some 

insights into the more complex tools behind us, we can now 

move into the heart of editing images with the Digital 

Zone System.

Photoshop CS6

p Figure 4.19: Selection saved as a new alpha channel p Figure 4.20: Highlights selected and saved as an alpha channel

u Figure 4.21: Alpha channel selected. White shows where 

any adjustment will be visible and black hides the effect of 

any adjustment.
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Chapter 5
The Digital Zone System

We have discussed how cameras and meters “see” light, how exposure works in the digital 

world, and which tools are used in the Digital Zone System. We can now move on to look-

ing at how to optimize our digital images with the DZS. 

I’ll toss in a caveat now. This editing methodology does create some large files. If your 

computer is short on RAM, performance will be slower. Both RAM and hard drive space 

are relatively inexpensive, and processing power is abundant with the dual-, quad-, six-, 

and eight-core processors available today, so there is really nothing to fear with large 

image files.

The DZS uses what are called luminance masks to separate areas of different tones 

or brightness in an image. The concept of luminance masks has been written about and 

used for many years. What we’re doing now is breaking it down and making more refined 

selections for each area of tone or brightness. We’ll call these zone masks.

The beauty of zone masks is that they’re self-feathering. That is, each zone or selection 

intersects or overlaps with the others to give you smooth transitions and maintain smooth 

tonal gradations or transitions in your images. Can’t we just feather a regular selec-

tion? Not really. Feathering individual selections is a discrete process. The selections, even 

when feathered, do not intersect or overlap with each other, so you can get some harsh 

transitions between selections when making adjustments. With zone masks, each selec-

tion overlaps with others in a gradual manner, so that adjustments to one zone transition 

to other zones gradually, and keep those tonal transitions smooth.

Setting up the zone masks is a bit of work, but worthwhile work. You can speed up the 

process by using an action, and you can even download a pre-programmed action from 

the Rocky Nook website at rockynook.com/dzs.

Why Luminance? 

Using luminance information embedded in a digital image is a natural way to 

view an image because of the way the human visual system works. The human 

visual system has two types of receptors called cones and rods. Cones are used to 

see color. Rods are used to see brightness. We know that without light we cannot 

see color. But even in a dark room we can still discern objects. Those are the rod 

receptors in our eyes at work. We have far more rod receptors than cone receptors. 

Using luminance values allows us to isolate color adjustments to specific areas of 

brightness. For instance, we can isolate a saturation change in an area of higher 

brightness so that it doesn’t affect the same color in an area of lower brightness. 

We’ll see this later on when we look at some examples of the DZS in practice.

Downloadable actions can be found 

on the Rocky Nook website at 

rockynook.com/dzs
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Before getting into the detailed steps of setting up zone masks and working with an 

actual image, let’s take a look at how the selections work on a sample image. For illus-

tration purposes, what we’ll look at is a black-to-white gradient. In figure 5.1, we see a 

black-to-white gradient with the histogram for the gradient. 

In Photoshop CS6, we can select the highlights in an image by holding CTRL+ALT+2 

(A+option+2) together. (In versions prior to Photoshop CS5, using CTRL+ALT+~ did the 

same thing.) You can also select the highlights by holding CTRL (A) and clicking on the 

composite RGB channel in the Channels palette. When we do that, we get a selection 

with a histogram that looks like figure 5.2.
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p Figure 5.1: Black-to-white gradient

p Figure 5.2: Highlights selected
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Why Luminance?

What has happened with the histogram? We’ve made a selection such that just less 

than half the image is selected—the portion that’s brighter than a middle value (128 or 

Zone V). We can save this selection as an alpha channel, then make another selection. 

The layer stack with the alpha channel looks like the screenshot in figure 5.3.

Holding CTRL+ALT+SHIFT (A+option+shift) and clicking on the thumbnail for the 

alpha channel will create an intersecting or overlapping selection. The histogram for this 

new selection is shown in figure 5.4. As you move your cursor over the alpha channel 

thumbnail while holding CTRL+ALT+SHIFT (A+option+shift) you’ll see a little x in the 

box below the finger. This indicates that you’re making an intersecting selection.

p Figure 5.4: Smaller selection created from highlights

t Figure 5.3: Photoshop layer stack 

showing alpha channel
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Compare this histogram with the one from the first selection. It is showing half the 

brightness as in the first selection. This will be important as we move forward. We can 

repeat this process and get a smaller intersecting selection, as shown in figure 5.5. Once 

again, take note of what happens to the histogram. It has been cut down by half again.

We could invert the original selection (the highlights selection) and repeat the process. 

Doing so would create similar selections on the darker end of the gradient.

What does it mean when you cut brightness by half or double it? It means you’ve ad-

ded or subtracted one stop of light. Each of the new selections we make is removing one 

stop of light or brightness from the previous selection. We know from our earlier discus-

sion that one stop of brightness equates to one zone in the original Zone System. What 

we have with these intersecting selections is a way to create areas of brightness that can 

be likened to the zones in the Zone System.

Separating Zones

We’re not quite done yet. Most of these selections are made up of multiple zones. We need 

a way to separate them and make each an individual zone. We do that by subtracting 

one selection from another. The first selection contains all the brightness values higher 

than 128, or Zone V. We’ll consider this to be Zones VI through X. Our second selection 

contains one stop or zone less. It contains Zones VII through X. Subtracting the second 

selection from the first leaves us with just Zone VI.

The way to subtract one selection from another is to hold CTRL+ALT (A+option) and 

click on the thumbnail for the alpha channel we want to subtract. The steps are as follows:

	 1.	 Select>Load Selection>Alpha 1 (or CTRL+click A+click) on the alpha channel 	

		  you want to load, per chapter 4).

	 2.	 CTRL+ALT+click (A+option+click) on the thumbnail for Alpha 2.

CHAPTER 5 | The Digital Zone System

p Figure 5.5:Successively smaller selections can be created
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Separating Zones

When you do this, you’re going to see the warning message shown in figure 5.6. Don’t 

worry. This warning message doesn’t mean you don’t have a selection. You do. What this 

is telling you is that none of the pixels in the selection are more than 50% visible. This 

is because we’re making a selection of a very small set of pixels, combined with the fact 

that these overlapping selections are highly feathered.

Repeating this set of steps for other selections will create a series of zones one stop 

apart. Keep in mind, there is an action you can download as well. I would recommend 

walking through the steps manually at least once to get a feel for what’s happening.

In applying the Zone System to black-and-white film, Adams was truly working with 

tones, or luminance values. There was no color muddying things up. In the digital world, if 

we just apply the zone masks we’re creating as adjustment layers on the image file, we’re 

working with luminance and color. What we want to do is separate color from luminance 

so we can work on each separately.

Photoshop has several different Blending Modes for layers. One of them is Luminosity. 

It gets us partly to where we want to be, but not all the way.

Creating a Luminance Layer

We are going to separate luminosity by creating a new luminance layer that contains 

only the information on brightness values, irrespective of color. There is no way to do that 

directly in Photoshop, but there is a workaround. On the Photoshop installation disk for 

versions earlier than CS5, or contained in the download if you downloaded the program 

from Adobe, is a folder called Goodies. Inside this folder is a filter called HSB/HSL. To 

install this filter, unzip the folder, open the extracted folder, and look for the Optional 

MultiPlugin.8bf file. This plug-in includes the HSB/HSL filter. 

For CS5 and CS6, Adobe no longer includes this plug-in with the software, therefore 

it must be downloaded separately from the Adobe website. For CS5, the package can be 

downloaded from http://www.adobe.com/support/downloads/detail.jsp?ftpID=4688. 

With CS6, the optional plug-ins are available at http://helpx.adobe.com/photoshop/

kb/plug-ins-photoshop-cs61.html under the “Plug-ins available via web download” hea-

ding. Copy and paste the plug-in into the PhotoshopCSx/Plug-ins folder on your hard 

drive. Restart Photoshop and the plug-in should appear under Filter>Other>HSB/HSL.

HSB stands for “hue, saturation, and brightness,” and HSL stands for “hue, saturation, 

and lightness.” With both, the H is the same, but the saturation differs between the two. 

In the HSB model, saturation is at its highest when brightness is 100. This makes 

t Figure 5.6: Photoshop warning 

dialog box

Downloadable actions can be found 

on the Rocky Nook website at 

rockynook.com/dzs
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intuitive sense. We need light to see color. The more light, the more color we see. In the 

HSL model, saturation is highest when lightness is 50%. From that point, saturation 

drops as lightness increases or decreases. That’s not really what we want., so for purposes 

of the DZS, we’re going to use the HSB filter. I’ve created an action to generate the lumi-

nance layer, which you can download at rockynook.com/dzs.

The steps to create a luminance layer are outlined next, and as with the zone masks, 

I recommend walking through these steps at least once to get comfortable with what’s 

happening.

1.	 Open your image file. If you already have layers in the file, click to activate 		

		  the background or base layer.

2.	 Go to Image>Duplicate.

3.	 Go to Filter>Other>HSB/HSL. A dialog box like the one in figure 5.7 will pop up. 	

		  Make sure RGB is selected as the Input Mode and HSB as the Row Order. Click OK.

	 4.	 In the Channels palette, click on the Blue channel to select it. The Blue channel 	

		  corresponds to the Brightness channel in HSB. Photoshop does not rename the 	

		  channels Hue, Saturation, and Brightness, so you just need to know that the Blue 	

		  channel represents Brightness.

	 5.	 With the Blue (Brightness) channel selected, go to Select>All or press 		

		  CTRL+A (A+A). Next go to Edit>Copy or press CTRL+C (A+C).

	 6.	 Select the original image and go to Edit>Paste or press CTRL+V (A+V). This will 	

		  paste the luminance information onto the original image as a new layer.

	 7.	 Set the Layer Blend Mode of this luminance layer to Luminosity.

	 8.	 Rename the new layer Luminance or something else that will remind you what 	

		  it is. In the action that you can download, it’s called Luminance Layer.

That’s it! You have now extracted the luminance, or brightness, values from your image 

and can use zone masks to make adjustments to the luminance information, separate 

from the color information. 

One thing to take note of is that the luminance layer is in grayscale. That’s because 

we’ve removed the color information and are left with just brightness values. This will 

become key in converting to black-and-white, which will be covered in chapter 6.

CHAPTER 5 | The Digital Zone System

u Figure 5.7: HSB/HSL selection dialog
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Creating Zone Masks

Creating Zone Masks

Now we can move on to creating zone masks. This is a multi-step process and does take a 

bit of time. The action mentioned earlier will speed up the process to just a few seconds. 

There are a few things to be aware of before you begin.

First, if you’re working on an existing image that already has adjustment layers in 

place, the effect of those layers on the image will be taken into account when you create 

your zone masks. To avoid those adjustment layers affecting your zone masks, turn the 

visibility of the layers off by clicking on the eye icon to the left of the layer.

Second, when you run the action to create your zone masks on an image that has 

existing adjustment layers, a dialog box may pop up that says “Progress” and “Merging 

Layers.” The layers will not actually end up being merged into a single layer at the end. 

This is the effect of the adjustment layers being taken into account when the zone masks 

are created. You’ll still get the dialog message if the visibility of those layers is turned off, 

but the effect of the layers on the image will not affect the creation of the zone masks 

with the layer visibility turned off.

Now let’s move on to actually creating zone masks. Complete the following steps:

	 1.	 Click on the luminance layer to activate it.

	 2.	 Select the highlights in the image as outlined earlier in the chapter.

	 3.	 Go to Select>Save Selection, which will open the dialog box shown in figure 5.8.

	 4.	 In the Name field, give the selection a name that will easily remind you what it is. 	

		  I use Zone 6–10. New Channel is selected by default, and that’s what you want. 	

		  You can also use the quicker method of saving the selection as a channel, 

		  as discussed in chapter 4, in which case you’ll need to double-click on the 		

		  alpha channel to rename it.

	

	

	

	

	

	

	

	

	

	

	

	

	

	 5.	 Press CTRL+ALT+SHIFT (A+option+shift) and click on the thumbnail for the 		

		  Zone 6–10 channel in the Channels palette. This will create the next smaller 		

		  selection, as shown above.

t Figure 5.8: Save Selection dialog box
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	 6.	 Save this selection. Name the new channel something like Zone 7–10.

	 7.	 Repeat steps 3 and 4 to generate channels named Zone 8–10, Zone 9–10, 		

		  and Zone 10.

	 8.	 Go to Select>Load Selection. Choose Zone 6–10 from the Channel drop-down 	

		  menu as in the screenshot in figure 5.9. Again, you can also use the alternate 	

		  method with the icons at the bottom of the Channels palette discussed in 		

		  chapter 4 or CTRL+click (A+ click) on the alpha channel—whichever you’re more 	

		  comfortable with.

	 9.	 Go to Select>Inverse. This will load a selection composed of Zones 0 through 5.

	 10.	 Save this selection. Name the new channel Zone 0–5.

	

		  11.	 Repeat steps 3 and 8 to create channels named Zone 0–4, Zone 0–3, 		

			   Zone 0–2, Zone 0–1, and Zone 0.

You’re halfway there. What you’ve done to this point is lay the groundwork for creating 

the individual zone masks, as described earlier in relation to the sample gradient image. 

Next, you need to separate the individual zone masks from the zone groups. To do this, 

subtract one group from the other in succession as follows:

	 1.	 Load the selection called Zone 6–10.

	 2.	 Hold CTRL+ALT (A+option) and click on the thumbnail for the Zone 7–10 		

		  channel in the Channels palette. You’ll get the “No pixels are more than 50% 	

		  selected” warning. Click OK and continue.

	 3.	 Name this new channel Zone 6.

	 4.	 Load the selection called Zone 7–10.

	 5.	 Hold CTRL+ALT (A+option) and click on the thumbnail for Zone 8–10 in the 	

		  Channels palette.

	 6.	 Name this new channel Zone 7.

	 7.	 Repeat steps 4 through 6 to create Zones 8 and 9. Remember that Zone 10 		

		  was already created when we set up the zone groups.

	 8.	 Load the selection called Zone 0–5.

CHAPTER 5 | The Digital Zone System

u Figure 5.9: Load Selection dialog box
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Creating Zone Masks

	 9.	 Repeat steps 4 through 6 to create Zone 5 down to Zone 1. Remember that 		

		  Zone 0 has already been created.

Congratulations! You’ve created your zone groups and have your individual zone 

masks set up as well. What you should have is a Layers palette that looks like the image 

in figure 5.10. You should also have a Channels palette that looks similar to figure 5.11.

p Figure 5.10: Layers palette

p Figure 5.11: Channels palette
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You see that you have both the zone groups and the individual zone masks set up. At 

this point, you can delete the zone groups if you like. Keeping them will allow you to make 

adjustments to larger areas of the image if you wish. There are times when you’ll want to 

use those larger zone group luminance masks, so I recommend keeping them.

Now that we have the zone masks set up, what do we do with them?

Using Zone Masks

Take a look at figure 5.12. This image was taken on an overcast day. It has potential that 

isn’t fully realized. The autumn colors are strong. The color in the rocks is terrific. The 

flowing of the water is what I wanted. But overall, the image is flat and somewhat lifeless.

The next version is one that I worked on using traditional editing methods (figure 5.13). 

I applied a global Curves adjustment layer, then I applied a Hue/Saturation adjustment 

layer and manually masked out the water to isolate the adjustment to just the rocks and 

trees. Next, I used the High Pass sharpening method with a layer mask and masked out 

the water to keep it from being affected by the sharpening. It’s better. Definitely better. 

CHAPTER 5 | The Digital Zone System

?

p Figure 5.12: Autumn river on an overcast day p Figure 5.13: Autumn river edited with traditional tools
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Using Zone Masks

There’s more punch and there’s some good separation of tone in the darker areas. There 

are also the beginnings of some highlights in the trees at the back of the image. But it’s 

still not quite where I want it. I could try to take it further with any of the dodging and 

burning techniques, but they are time consuming and sometimes inaccurate, particularly 

when used in small, finely detailed areas.

When you begin working with the DZS, there will be some trial and error in finding 

out which zone masks impact different areas of the image. Go back to the grayscale step 

wedge in chapter 1 to remind yourself of the grayscale values that apply to each Zone. 

By moving your cursor over an area you want to work on in the image, you can view its 

RGB values in the Info palette. Looking at these values and correlating them with the step 

wedge will give you a good starting point for figuring out which zone mask you need to 

use. In figure 5.14, the cursor was held over the reddish brown rocks on the right, where 

you can see the white circle. The RGB values in the Info palette for this area are R 213, G 

189, and B 147. This equates to an average of 183, which is Zone VII. 

Another way to determine the brightness of the area you want to 

work on is to turn off the visibility of the background or base layer, 

make your luminance layer the active layer, and move your cursor over 

the area you want to work on. This will show the true grayscale values. 

If we do that with this image, the values are R 191, B 191, and G 191, 

which is essentially the same as the 183 we measured as an average on 

the color layer. You’ll become more comfortable and will train yourself 

to visualize the different levels of brightness as you use the DZS more, 

and you’ll be able to load the appropriate zone mask more quickly and 

edit more efficiently. 

Measure the areas you want to adjust before you start adding new 

adjustment layers. As you add new layers and begin adjusting the im-

age, the RGB values will change to reflect the effect of the adjustments 

you’ve made. This makes sense. Your digital darkroom adjustments have 

an impact that is similar to the effect of development adjustments in 

the Zone System, where changing the development could shift a tone 

from Zone VI to Zone VII. Your adjustments should be based on the 

original luminance values. If you want to go back and remeasure some 

areas, simply turn off the visibility of any adjustment layers by using the 

eye icon next to the layer.

As you load a zone mask, you’ll be presented with the same “No 

pixels are more than 50% selected” warning. Again, this is nothing to 

worry about, so you can just click out of the warning. (It would be nice if 

Adobe allowed you to disable the warning, as they do with most others.) 

To save the time it takes to load each zone mask individually, you can 

program an action to load them all and set up Curves adjustment layers 

for each. I’ve programmed that action, and you can download it from rockynook.com/dzs. 

The action also adds Hue/Saturation adjustment layers for all your zone masks. 

When you’re finished, you can delete the zone mask adjustment layers that you didn’t 

use. To make it easier to remember which were used and which were not, you can turn 

p Figure 5.14: Assessing luminance values in the image 

Digital_Zone_EN_final_01.indd   87 24.09.12   19:43

http://lib.ommolketab.ir
http://lib.ommolketab.ir


|  88  |

CHAPTER 5 | The Digital Zone System

u Figure 5.15:	

Final version edited 

with DZS
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Using Zone Masks

off the visibility of all the layers and turn on visibility of the ones you use. The ones that 

remain turned off can be deleted.

The primary adjustments you’re likely to use with your zone masks are Curves or Levels 

for tonal adjustments, along with Vibrance or Hue/Saturation for color adjustments. 

Some of the other adjustment tools may be helpful in certain situations.

Now let’s take a look at the version of the autumn river edited with the DZS (figure 5.15.) 

Next, we’ll walk through the steps required to create it.

What do we see? We see an image that has much more life and vitality than the 

previous version. We have an image that takes much more advantage of the slight tonal 

differences in some of the colors. Look at the trees in the back of the shot. Where before 

the trees on the upper left were a relatively uniform mass of deep red, we now have deep 

reds in the shadows and lighter, brighter reds in the light areas. The yellows and oranges 

on the right also show much more brightness because we worked with the luminance in 

the image to bring out that level of brightness. Even the green in the trees on the upper 

left has small hits of luminance that add visual interest to an otherwise uniform mass of 

color. Note, too, that in the evergreens in the back at the middle, we have hits of highlight 

on the edges of some of the branches. 

To bring these tonal and brightness differences out in the version edited with traditional 

tools, we had to do a lot of very fine painting in the image. With the DZS, we were able 

to bring them out by using the luminance that already existed in the image. Another 

thing to note is how much sharper the DZS version is. We’ll see the reason for that shortly.

Figure 5.16 shows the layer stack for the image. At the bottom, we have our original 

image layer. You can see the small icon at the bottom right that indicates this is a Smart 

Object. In the middle is the luminance layer, and it, too, is a Smart Object.

Above the luminance layer is a series of Curves adjustment layers pertaining to a selec-

tion of zone masks—in this case Zones 5 through 8. You see that each of these is clipped 

to the luminance layer. The reason for this is that we want these Curves adjustments to 

affect the luminance of the image only. If the layers were not clipped to the luminance 

layer, they would impact the entire series of layers, including those below the luminance 

layer. That’s because the luminance layer is set to the Luminosity Blend Mode. To clip an 

adjustment layer to a specific image layer, hold down the ALT (option) key, position your 

cursor on the line between the adjustment layer and the layer below, and click. As an 

alternative, you can check the box that says “Use Previous Layer to Create Clipping Mask” 

when you create the adjustment layer. Doing this will automatically clip the new adjust-

ment layer to the layer below.

On top of the base layer, we have a series of Hue/Saturation adjustment layers applied 

to different zone masks. The background layer is named Layer 0 here because I was work-

ing with an existing image, and when you convert an existing image to a Smart Object 

that’s what happens. Note that I have two Hue/Saturation adjustment layers for Zone 4. 

Applying the adjustments in two separate layers gives a slightly different look from ap-

plying a combined adjustment in a single layer. One builds on the other. There is a global 

Hue/Saturation adjustment layer that is applied to the entire base layer. In this one, 

you’ll see that I’ve masked out the adjustment to the water and only kept the effect in 

the rocks and trees. The painting necessary to create this mask was not difficult because 

p Figure 5.16: DZS layer stack
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it was such a large, continuous area. We can use the zone masks and zone groups for this 

kind of selective editing as well, and I’ll show an example of that later on.

Just as with any adjustment layer, the ones applied in the DZS have built-in masks. As 

with any Layer Mask, you can remove or diminish part of the effect of the adjustment 

layer by using the Brush Tool with your foreground color set to black. White reveals; black 

hides. Paint over the area where you want to hide the effect. Adjust the Opacity of the 

Brush Tool to hide more or less.

The last thing to note is the Unsharp Mask Smart Filter applied to the luminance layer. 

It’s another reason to use Smart Objects with this, or any, editing technique. The Unsharp 

Mask is applied as a Smart Filter, which makes it completely editable. That would not be 

the case if you applied it on an actual image layer. It comes with its own built-in filter 

mask, as you can see. This allows you to sharpen different parts of the image differently. 

In this case, I’ve removed the sharpening entirely from the lower part of the waterfall, and 

partially from the upper part of the river. If you want to adjust the amount of sharpening 

by reopening the Unsharp Mask, you can double-click on the Smart Filter and refine the 

amount of sharpening applied. If you want to reapply the filter and mask out different 

parts with each version, reopening the Unsharp Mask from Filter>Sharpen>Unsharp Mask 

will apply the filter a second time, and two Unsharp Mask Smart Filters will appear below 

the Smart Filters thumbnail. Sharpening at this stage is referred to as creative sharpening. 

We noted earlier that the DZS version was sharper than the version edited with tradi-

tional methods. The reason for this is that we’ve applied sharpening to the luminance 

layer, effectively sharpening just the luminance information in the image. By sharpening 

just the luminance we can sharpen more aggressively than if we were sharpening the 

entire image with the color information included. We can sharpen more aggressively and 

not get the unpleasant halos that unsharp masking can create or the overly “crunchy” 

look that sharpening too aggressively can cause. It’s not unlike sharpening the lightness 

channel in the LAB sharpening method that used to be popular.

The Zone System with film was about altering the tonal range of an image on the 

negative and in the print, either expanding or contracting it. Can we do the same with 

the DZS? Yes, we can. The histograms for the three versions of the waterfall image illus-

trate this. Figure 5.18 shows the three histograms—one for the unedited image, one for 

the image edited with traditional methods, and one for the image edited with the DZS.

We see that we’ve spread out the histogram more in the DZS image. The peak on the 

right side of the graph has moved farther to the right, and the peak on the left has moved 

CHAPTER 5 | The Digital Zone System

p Figure 5.18: Histograms for the original image (left), traditional edit (middle), DZS edit (right)
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farther to the left. We have effectively improved overall (global) contrast by making very 

selective adjustments to specific areas of tonality (local contrast). 

Could we have done the same thing with traditional editing methods? Maybe. But not 

nearly as easily. We would have to do more selective dodging and burning and would 

have to have been very precise with the painting to get a similar kind of result. It would 

have taken much more time, and the image still wouldn’t have the vitality or luminance 

that the DZS version has. With the DZS, we can add an adjustment layer, then simply 

adjust that layer. With this technique, we can push and pull the tonality of the image 

to improve dynamic range and image contrast in specific areas without overly affecting 

other areas. The amount that adjoining zones are affected due to the overlapping of the 

zone masks is just enough to maintain smooth transitions between tones.

When you’re finished editing your image and are ready to save it, you can reduce the 

size of the file by deleting all the alpha channel zone masks and zone groups. If you want 

to work on the image in the future, getting the masks back again is pretty simple. Open 

the image, then duplicate it via Image>Duplicate. Delete all the layers so you’re back 

to your original, then run the zone masks action. Click on the first zone mask channel, 

hold the SHIFT key, and click on each successive zone mask and zone group channel 

until all are selected. (Unlike with layers, you cannot click the first, hold SHIFT, and click 

the last to select all. Each has to be selected individually.) Now, drag the channels back 

to your DZS image. The masks are all back in place and you’re ready to continue edit-

ing. I’ve programmed an action to automate this step, which you can download from 

rockynook.com/dzs.

As was mentioned earlier in the chapter, the luminance layer is actually in grayscale. 

We can use this layer to help us with black-and-white conversions. We’ll cover that in 

chapter 6.

Using Zone Masks

Sharpening 

Sharpening of digital images is a step that needs to be done. Digital capture by either 

scanner or camera imparts some measure of softness to the image. The concepts around 

sharpening have evolved over the years. In the early days of digital, it was considered best 

to leave sharpening until the last step in the image-editing process and to sharpen only 

once. Today, it’s considered best to use a three-stage sharpening process.

The first stage of sharpening is done to the RAW file in your RAW converter. The pur-

pose of sharpening at this stage is to remove the effects of the anti-aliasing filter and 

demosaicing of the image. This is called capture sharpening.

The second stage of sharpening is called creative sharpening. We looked at this earlier 

in the chapter. Creative sharpening is done once your editing is finished but before you 

resize for output. It can be applied to the entire image, or as we saw with the waterfall im-

age, only to selected areas. That’s the “creative” part. Creative sharpening can be broken 

down further into sharpening for high-frequency and low-frequency image information. 

Downloadable actions can be found 

on the Rocky Nook website at 

rockynook.com/dzs
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High-frequency information in images is those areas that have a lot of detail. The trees 

and rocks in the waterfall example represent high-frequency data. Low-frequency infor-

mation in images is those areas that don’t have a lot of detail, like the flowing water 

in our example. Broad expanses of sky are another common low-frequency area. You’ll 

generally apply more sharpening to high-frequency data and less or no sharpening to 

low-frequency data.

The last step is output sharpening. This is a step that’s done to sharpen the image for 

a specific kind of output. It’s done after the image is resized. Resizing can impart some 

softness due to pixel interpolation. Printing will soften the image slightly due to what’s 

called dot gain, which is the increase in the size of the ink dots as they hit the paper. The 

dot gain with “soft” papers is greater than with “hard” papers, so a bit more output sharp-

ening needs to be applied for matte papers than for glossy papers. Adobe’s High Pass 

filter is good for output sharpening because it can be adjusted with the Opacity slider.

In the DZS, output sharpening for color images is pretty simple. Duplicate your original 

image layer, delete any Smart Filters on the duplicated layer, drag it to the top of the 

layer stack, and place it directly above the last adjustment layer that applies to your color 

image but below any layers that apply to a black-and-white version. Rename this new 

layer Output Sharpening or something similar that will tell you what it is. If this layer is 

not already a Smart Object (it should be since your base layer is a Smart Object), make it 

one by going to Layer>Smart Objects>Convert to Smart Object. Change the layer Blend 

Mode to Overlay. The image will look ugly at this point, but don’t worry. 

Go to Filter>Other>High Pass. In the box that pops up, choose a starting point of three 

to five for the Radius and click OK. You’ll see that the image now looks “normal” again. 

If you check and uncheck the eye icon next to the High Pass Smart Filter, you’ll see the 

effect of the sharpening on the image. You can fine-tune this by adjusting the Opacity of 

the layer or by double-clicking on the High Pass Smart Filter to reopen it and adjusting 

the Radius up or down. You can also change the layer Blend Mode to Soft Light, which 

will reduce the effect a little. 

Output sharpening of black-and-white images in the DZS is similar. Duplicate your 

luminance layer and delete any Smart Filters on the duplicated layer. Rename this layer 

Ouput Sharpening BW or something else that will remind you what it is. Drag it to the 

top of the layer stack above the last adjustment layer for your black-and-white conver-

sion. Change the layer Blend Mode to Overlay and apply the High Pass Filter in the same 

way as before. Fine-tune the effect with the Opacity slider or by changing the layer Blend 

Mode to Soft Light to get the final result you want.
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Sharpening with Your Masks

Sharpening with Your Masks

I sharpened the waterfall image by using the luminance layer and by painting in the 

Smart Filter mask to hide the sharpening in the white, flowing water.

You can achieve the same result by using the zone group masks that have already been 

created. In a technical sense, only the lighter masks are luminance masks. The darker 

masks, Zones 0 through 5, are technically called density masks: areas 

of greater darkness in an image and areas that will require more ink on 

paper are areas of greater density. Highlight areas don’t take a lot of 

ink and are not as dense.

We can use the zone masks or zone groups to create something 

called a Density Mask. With this Density Mask a technique called Den-

sity Mask Sharpening can be used. It really is pretty simple.

In the case of our waterfall image, we’ll make the luminance layer 

active by clicking on it. Next we’ll load the Zone 0–5 “density mask.” 

What we’ve selected is everything except the flowing water and a few 

bits of lighter areas in the rocks (figure 5.17). This is basically the same 

as what we achieved by painting on the Smart Filter mask. You can 

refine this selection even further if you wish. Select the Lasso Tool from 

the Tools palette, hold down the ALT key, and draw around the areas 

you want to delete from the selection. 

In this case, we would draw around the areas in the rocks and trees 

where marching ants appear, to remove those areas from the selection 

and get us back to just the water selected. We can now apply sharpen-

ing to this density mask selection. It will appear as a Smart Filter on the 

luminance layer, making it editable or reversible. 

Recall from earlier in the chapter that our zone masks are self-

feathering. What that means, in this case, is that areas of less density 

will be sharpened progressively less. If you were to zoom in on some 

areas of the water, you would see some slight sharpening. That’s OK. It 

won’t be evident in the final print.

Density mask sharpening is an elegant way to selectively sharpen certain areas of your 

image while leaving other areas unsharpened. As with editing using zone masks, it relies 

on information that’s embedded in the image. That means you don’t have to spend a lot 

of time manually painting in the image to mask out the effect in certain areas.

p Figure 5.17: Density mask selection 

for sharpening
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Chapter 6
The Digital Zone System 
and Black-and-White

In the digital world, we don’t shoot black-and-white photos the way we did with film. 

It might surprise you to know that digital sensors are actually monochrome. The color 

comes from the filter array that sits on top of the sensor. That aside, we still consider that 

we’re shooting in color. There have been a few dedicated monochrome digital cameras 

produced, but they never sold well and didn’t stay around for long. Personally, I think 

they’re a great idea and would love to have a dedicated black-and-white digital camera 

that I could use with color contrast filters, the way I shot with film. Until those cameras 

are made available to the masses again—and I’m not holding my breath—we’ll continue 

to work with color images that are converted to black-and-white. Which is not inher-

ently bad. Using color information to do black-and-white conversions can give us great 

flexibility that we didn’t have with black-and-white film.

We can shoot in grayscale mode with most digital cameras. It’s a JPEG-only option, 

however, and it’s not the best option. First, we lose the inherent quality of shooting RAW. 

Second, the conversions to monochrome in-camera are typically not very good. Your best 

bet for black-and-white in the digital world is to shoot RAW in color and then later con-

vert to grayscale.

In the relatively short history of digital photography there have been many ways to 

convert from color to black-and-white. Some methods are better than others. The tools 

available for doing black-and-white conversions have greatly improved over the years. 

Compared to the tools available in ACR and Photoshop today, the Channel Mixer method 

that was popular just five or six years ago is downright archaic. Many people have their 

favorite ways to go about it. Most of the methods involve adjusting the lightness of differ-

ent colors to achieve a pleasing mix. A good deal of dodging and burning can be involved 

as well, depending on the desired result. What these methods essentially do is use color 

to create tonal separation in order to generate visual interest. 

Creating a Luminance Layer

Most of the conventional image-editing methods try to mimic the use of color contrast 

filters on black-and-white film. The goal with digital black-and-white conversion is to cre-

ate color contrast. By creating contrast between colors, we get contrast in shades of gray. 

With the conventional methods of converting to black-and-white, this makes absolute 

sense. But our photos already have tonal variations in the existing luminance values. 

What if we could take advantage of those existing luminance differences to create our 

black-and-white images? Figures 6.1 through 6.6 show six examples of taking an image 
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that originally has quite a bit of color contrast and converting it into grayscale. Five of the 

methods are what could be referred to as “conventional.” The last is a conversion using 

luminance that exists within the image.

I specifically chose this image because it has a good range of colors and some subtle 

luminance variations that could be difficult to pick up. There are some brightness differ-

ences that the conventional methods of converting did not reproduce well. None of the 

conventional methods properly converted the bit of brighter blue in the middle, above 

the hinges. The brighter values on the far left of the image are also converted more ac-

curately in the luminance version. The brightness variations in the large hinge are picked 

up better, and the brighter green of the small hinge is more faithfully converted. Remem-

ber, these are all simple default conversions with no incremental editing. The better the 

conversion you start with, the better the final result.

CHAPTER 6 | The Digital Zone System and Black-and-White

p Figure 6.1: The color original

p Figure 6.2: Grayscale p Figure 6.3: Desaturate
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What we see as color in the world we live in gives us separation between elements in 

a photograph. Unfortunately, many colors convert to similar shades of gray. The classic 

example is a red rose and green leaves. We see the difference between the two because 

of the colors. Remove the color, and both produce a similar shade of gray, so we lose the 

separation. A similar example is red peppers with green stems.

Creating a Luminance Layer

p Figure 6.4: Red channel p Figure 6.5: Black-and-white adjustment

p Figure 6.6: LAB, lightness channel p Figure 6.7: Luminance values
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We see contrast difference between the peppers and the stems because of the color. 

If we remove the color with a simple Desaturate command in Photoshop what happens?

The contrast is gone. The difference between the red and green is gone. The two 

basically appear as the same in shade of gray. Figure 6.10 is a block made up of red, 

green, and blue. Each is set to a value of 255. We can distinguish between the blocks 

because of the color. What happens when we convert to grayscale? 

CHAPTER 6 | The Digital Zone System and Black-and-White

u Figure 6.8: Peppers in color

u Figure 6.9: Peppers in gray with Photo-

shop Desaturate command
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How Do We Get Shades of Gray?

This conversion shown in figure 6.11 was done with the Channel Mixer in Photoshop 

at the default settings of 40% Red, 40% Green, and 20% Blue. The goal is to mix the 

colors so that the combined total is 100%. The green and red from the original image 

have become the same shade of gray. This is what happens in the classic red rose/green 

leaves example with film as well. The two colors reflect similar amounts of light, which 

leads to similar shades of gray. Using black-and-white film without a color contrast filter 

on the lens is a lot like doing a default grayscale conversion in Photoshop. The same thing 

happened with the peppers and the color blocks. The blue block is darker because of the 

lower percentage of blue in the mix, but if we increased the blue to 40%, it too would 

become the same shade of gray. Even with the blue being darker there’s really no visual 

interest, because the tones are all so similar. 

We can look at each channel individually as well to see what happens. Figure 6.12 

shows the red, green, and blue blocks, from left to right, each set to 50%.

They’re all the same shade of gray. But we did have a slightly darker shade of gray 

in the earlier example. We can see that by adjusting the percentages of different colors 

we can change the appearance of tonality and luminance. But we’re still “creating” that 

luminance difference. Why create it? The image already has luminance variation. Let’s 

use it!

Going back to our autumn waterfall image from the previous chapter, if we do a con-

version to black-and-white with a Black & White adjustment layer at the default settings, 

we get the result shown in figure 6.13. It’s pretty blah. We’ve lost what separation existed 

between colors. The mass of trees in the background is mostly the same shade of gray. 

Yet we know there was color there and we know there were different areas of luminance. 

How Do We Get Shades of Gray?

p Figure 6.10: RGB color blocks

p Figure 6.11: Default grayscale 

conversion using Channel Mixer

p Figure 6.12: RGB channels, 

each at 50% gray

tt Figure 6.13: Default Black & White 

adjustment layer

t Figure 6.14: Conventional 

black-and-white conversion
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There’s little visual interest in this black-and-white image. Now, to be fair, we could make 

some adjustments to the color sliders and regain some visual interest and contrast. But 

to really get separation, there would have to be a lot of painting in the image with your 

preferred tools for dodging and burning. Figure 6.14 shows just such an attempt.

This is definitely preferable to the default version. There’s now some tonal separation 

in the trees at the back. The rocks along the left side have been lifted a bit, and overall 

the image has more contrast and visual snap. This took a lot of time to achieve, and there 

was a lot of painting to dodge and burn different areas. If you were to look at a larger 

version, you would see that a lot of painting was done on the trees at the back. Getting 

the brushed areas to have a high degree of accuracy in such small details is difficult and 

time consuming.

Black-and-White Conversions with the DZS

By making just one small change to our color DZS image, we can get a black-and-white 

version that retains the tonal variations in the color original, as shown in figure 6.15. The 

trees in the background have good tonal separation. The hints of highlight at the edges 

of some of the branches are retained. It’s a much more appealing image at the default 

conversion level. All we did to create this was change the Blend Mode of the luminance 

layer from Luminosity to Normal. That’s it. Simple. This version could stand on its own.

Because we’ve changed the Blend Mode to Normal, the Hue/Saturation adjustments 

in the color version play no part in the black-and-white version. This is simply the lumi-

nance information from the original that we extracted, plus the Curves adjustment layers 

and Unsharp Mask.

We probably want to do a little more to this, however. With the layer Blend Mode 

changed, when additional adjustment layers are created, they should be placed above 

the top layer that was used in editing the color version. The reason is that we’re going 

to group the layers later so we can turn them off and on as a group. With the luminance 

layer Blend Mode switched to Normal, the Hue/Saturation adjustment layers below the 

luminance layer are no longer active. To keep the black-and-white adjustments separate 

from the color adjustments, any new layers should be labeled with “BW” or “Gray” or 

some similar notation to remind you that these are for the black-and-white version only.

The process is the same as with the color version. Load a zone mask selection and ap-

ply your desired adjustment to it. This can be repeated for as many zones as you want 

to work on.

You can apply different sharpening to the black-and-white version as well. Disable the 

Unsharp Mask Smart Filter on the luminance layer by clicking the eye icon next to it. Open 

Unsharp Mask or Smart Sharpen, and apply sharpening to the black-and-white version 

independent of the color version. Photoshop doesn’t permit you to rename Smart Filters, 

but there is a way to know which is which. The first Smart Filter will be at the bottom and 

the second above it. Your black-and-white adjustments are at the top of your layer stack 

and above your color adjustments, so the sharpening Smart Filter that is at the top of the 

Smart Filter list applies to the black-and-white version.

CHAPTER 6 | The Digital Zone System and Black-and-White

p Figure 6.15: Default DZS conversion
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The final black-and-white version is shown in figure 6.16. The differences from the de-

fault image are evident. We’ve enhanced overall image contrast by concentrating on local 

contrast in a few zones. Some additional tonality has been added to the deep shadow 

area in the rock face by the water, on the right side at the top of the waterfall. The exist-

ing lighter tones in the trees at the back of the image have been lifted slightly as well. In 

terms of time, this took less than half the time of the conventional conversion method. 

The layer stack in figure 6.17 shows which zone masks were worked on.

Zone 1 and zones 3 through 7 have had Curves adjustment layers applied. You can see 

the second, separate Unsharp Mask Smart Filter in place to apply different sharpening 

to the black-and-white version. At the top of the layer stack, you see the folder called 

Black-and-White Conversions with the DZS

p Figure 6.16: Final DZS conversion

p Figure 6.17: DZS layer stack

Digital_Zone_EN_final_01.indd   101 24.09.12   19:44

http://lib.ommolketab.ir
http://lib.ommolketab.ir


|  102  |

Black & White. That’s the grouping of the six layers that were adjusted in creating the 

black-and-white version. By grouping them, we can turn their effect on or off all at once, 

rather than having to turn each one on or off individually. The other thing you’ll note is 

that the black-and-white zone mask layers are not clipped to the luminance layer. The 

reason is that because the Blend Mode of the luminance layer has been changed to 

Normal, nothing below that layer is having an effect on the image, and the black-and-

white adjustment layers need not be clipped to the luminance layer. Whether or not you 

clip them to the luminance layer would make no difference to the look of the end result.

You do want to leave the zone mask adjustment layers for the color version clipped so 

that you can switch between versions and not have to reclip each of them. These layers 

cannot be grouped because doing so would unclip them from the luminance layer and 

a layer group can’t be clipped to a layer. These can be turned on or off as you wish, to 

render the black-and-white result you want.

You can see the difference between the default DZS conversion (figure 6.15) and the 

final image (figure 6.16) in the histograms of the two images, shown in figure 6.18. The 

histogram for the default DZS version is on the left and the one for the final version is in 

the middle. For comparison, the histogram for the conventional conversion is on the right.

The change is not great, but it does make a visible difference. This illustrates that you 

don’t necessarily need to make large changes to an image to have a significant impact on 

the final result. Darker values on the left of the graph have been affected. In particular, 

note the shorter spike at the left edge, indicating less shadow detail has been clipped 

off. On the right of the graph there is separation between the lighter tones in the image, 

while the midtones are largely unaffected. Note that in the histogram for the conven-

tional method there is more clipping in the highlights and the graph is more compressed. 

The conventional version is flatter in midtone contrast but has more highlight clipping. 

Not a great result.

Over time you’ll train your eye to know which zones are which, and thus know which 

zone mask you need to load to affect specific areas of the image. There is a way to help 

determine this, though. If you hold your cursor over an area of the image you want to 

work on, you can see the RGB numbers for that area in the Info panel. The RGB numbers 

will be the same because you’re working with a grayscale representation in the luminance 

layer. You can then load the zone mask that corresponds to the RGB numbers under your 

cursor. For example, if your reading is 128, 128, 128, you know you need to load the Zone 

5 mask. If the readings are 42, 42, 42, you know you need to load the Zone 2 mask. You 

CHAPTER 6 | The Digital Zone System and Black-and-White

p Figure 6.18: Default DZS (left), final DZS (middle), conventional (right)
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can refer back to the step wedge in chapter 1 until you become used to the zone values. 

Recall from the previous chapter that you should make your measurements before you 

begin editing so that you’re reading from the original luminance values and not the 

adjusted values. For images with color and black-and-white versions in the same image, 

you should turn off your adjustments for the color image as well before measuring to 

determine which zone masks to use.

In figure 6.13, there was quite a bit of luminance difference to take advantage of. Can 

the DZS be used on an image in which there may not be as much separation between 

tones? Yes it can. Let’s go back to the red peppers and green stems example.

The straight grayscale conversion of the peppers looks pretty blah, as we can see in 

figure 6.20. There are some highlights on the peppers from ambient light reflection, but 

not a lot of distinction between the stems and the peppers. There 

isn’t even much distinction between the peppers at the top of the 

pile in more light and the ones at the bottom of the pile in less 

light. The histogram for the image is pretty much as expected—

mostly flat with spikes in the middle and at the left end, and not 

extending all the way to the right on the highlight end.

Now let’s take a look at the DZS image in figure 6.21. We see 

a much better result. There is tonal separation between the pep-

pers in different amounts of light. There is separation between 

the peppers and the stems. Overall contrast is much improved. 

It’s a far more visually interesting image. The histogram shows 

this as well, where the tonal range has been spread out. The 

spike in the middle of the original has been moved to the right, 

and the graph extends fully to the right edge. We’ve sacrificed a 

Black-and-White Conversions with the DZS

p Figure 6.20: Peppers with default grayscale conversion 

and histogram

p Figure 6.21: Peppers with DZS conversion and 

histogram

p Figure 6.19: Peppers in color
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bit of unimportant shadow detail at the bottom of the box to improve black levels. The 

layer stack in figure 6.22 shows what was done with this image.

In addition to the zone mask adjustments on individual zones to affect local contrast, 

I made some changes to larger tonal areas, as seen in the Zone 7–10 and Zone 9–10 

adjustment layers. At the end, I made a global Brightness adjustment to bring down the 

entire image slightly, and then a global Curves adjustment to enhance contrast. Notice 

that these global adjustments are at the top of the layer stack. That’s because I wanted 

truly global adjustments that took in the effect of the local adjustments.

ACR/Lightroom vs. DZS for Black-and-White Conversions

Let’s take a look at one more color to black-and-white conversion. The image in figure 

6.23 is the color version. It was taken in autumn on an overcast day. Because I used 

Daylight white balance, the bark has taken on a very interesting blue tone. It’s almost 

otherworldly. Notice the difference in brightness, or luminance, at the front right of the 

image compared to the back left, where both areas have blue color. This will be important 

when we do our black-and-white conversions.

Working on the black-and-white conversions, I used the tools available in ACR (or 

Lightroom) on one and the DZS on the other. The ACR version is in figure 6.24 and the 

DZS version is in figure 6.25. The difference is not dramatic but it is evident.

In ACR we’re trying to create gray contrast by working with color. We may be able to 

get the tonality we want in one part of the image but not in another, because adjusting, 

for example, the Blue balance will impact both the brighter areas at the front of the im-

age and the darker areas at the back left. Instead, by extracting the luminance informa-

tion from the image and using the zone masks to adjust brightness, we can more easily 

affect both local and global contrast in the image.

The DZS version took only a few minutes to complete. The ACR version took a fair bit 

longer because I had to go back and forth adjusting curves, Basic panel sliders, and color 

sliders to try to isolate the effects I wanted in specific areas. The work is definitely easier 

and more effective with ACR version 7 in Photoshop CS6 and with Lightroom 4 than 

earlier editions of the software programs because of the changes in the Basic panel ad-

justments discussed in chapter 4. Despite that, the DZS version has overall better tonality 

on both global and local levels as a result of the ability to isolate adjustments to specific 

areas of brightness.

Looking at the histograms for the two images in figure 6.26, we see noticeable differ-

ences. Compared to the histogram for the ACR version, the DZS version is more spread 

out, indicating a greater level of overall contrast. There are slightly more tones at the dark, 

left end of the graph as well as at the light, right end of the graph.

By now, what the Digital Zone System is and what it can do should be clear. In terms 

of converting a color image to black-and-white, the idea of creating good color contrast 

should translate into optimizing existing luminance contrast in a digital image. Extract-

ing luminance and contrast that already exist in an image provides a better starting 

point for image editing, and thus leads to a better ending point, in most cases, than 

conventional methods. 

CHAPTER 6 | The Digital Zone System and Black-and-White

p Figure 6.22: DZS pepper conversion 

layer stack
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ACR/Lightroom vs. DZS for Black-and-White Conversions

p Figure 6.23: Bark, color original

p Figure 6.24: ACR conversion p Figure 6.25: DZS conversion

p Figure 6.26a: Histogram for ACR conversion p Figure 6.26b: Histogram for DZS conversion
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Chapter 7
The Digital Zone System and 
High Dynamic Range Imagery

•	Ansel Adams’ Zone System was analog High Dynamic Range imagery (HDR).

•	HDR is an extreme version of ETTR.

Controversial statements? We’ll see. Over the course of this chapter we’ll look at why I 

believe those statements to be true and at how the DZS can be incorporated into an HDR 

workflow. Perhaps by the end of the chapter you’ll agree that these two statements are 

true as well.

Adams’ Zone System is a method for controlling dynamic range and contrast in 

negatives and prints. Because he understood the medium he was working with and the 

characteristics of each film, he could carefully adjust exposure and development of the 

film to produce a “printable” negative. Why have I put printable in quotations marks? 

We’ll examine that more in chapter 8.

With the adjustment of exposure and development, Adams could compress the bright-

ness range of a scene into something that would fit within the range he could capture 

on the film. Conversely, he could expand the brightness range of the scene on the film.

The option always exists to expose normally (i.e., according to the meter reading) and 

develop normally. But with the Zone System there are a couple of other options as well.

We can reduce exposure and extend development. We can also increase exposure and 

reduce development. Whichever we choose depends on the brightness range of the scene, 

which Zone we place important shadow detail in, and how that decision causes high-

lights to fall relative to the brightness range of the film.

There is no free lunch, however. You can’t cram a wider brightness range onto the 

negative than it can handle. Just as with RAW capture in digital, there is room at the 

highlight end of the scale, and where placement of a shadow detail might cause some 

highlights to fall into a higher zone, they can be brought back into range within reason. 

This is the essence of ETTR. On the other end, you can’t extend a midtone in a low-

dynamic-range scene into Zone VIII or Zone IX. You may be able to lift it to Zone VI or 

VII, but that’s about it.

In the context of HDR, we’re going to concentrate on compression of dynamic range. 

Even with the more limited ability to compress dynamic range in the Zone System, what 

is happening is tonemapping for all intents and purposes.

If you read Adams’ writings on the Zone System, particularly The Negative, he uses 

terminology that is similar to what we use in talking about HDR tonemapping. Adams 

discusses global and local contrast, both of which are key components of editing or 

!
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tonemapping HDR images. He discusses the impact local contrast has on the feel of the 

image. Lower contrast, on both a global and a local level, produces an image that is flat-

ter and has less texture. Higher contrast, particularly at the local level, enhances textures 

and can add a more gritty look to an image. This is precisely what happens when we 

tonemap an HDR image.

There are other methods for combining two or more images to increase dynamic range. 

Manual blending of images has been done since the mid-1800s when Gustave Le Gray 

combined negatives at different exposure settings to expand the dynamic range of his 

images. Manual blending of images in Photoshop is also possible using layer masks and 

selectively revealing certain parts of images. In this chapter we’re going to concentrate on 

HDR as an image-blending and dynamic range expansion method. Later in the chapter 

there’s a section on using your luminance masks to blend images as well. One of the 

knocks against HDR is that it can’t produce “realistic” results. This is, of course, nonsense, 

and some of the examples in this chapter will show that realistic results can be achieved.

Some will say there is no need for any sort of zone system, digital or otherwise, because 

we have HDR and other advanced image-blending techniques. The thinking goes that 

since the purpose of the Zone System was to manipulate dynamic range, HDR and simi-

lar methods serve that purpose. The argument continues that there is no need to really 

understand metering because you can just blast away as many brackets as you want and 

choose later which ones to merge. That really misses the point of what HDR is about. It 

also shows a clear lack of understanding of the Zone System. In addition, it relies on a 

method of photography called “spray ‘n’ pray,” in which people just crack off rapid-fire 

image sequences using the high burst rate and buffers of digital cameras in the hope 

that they get a useable image, or useable set of images, out of it. That’s not the approach 

that a serious photographer wants to take in making thoughtful and deliberate images. 

Many people do their HDR merge, tonemap it into something surreal looking, and 

call it a day. Others take a different approach, tonemapping in the HDR application to a 

more natural look but stopping the process at that point. There is no rule, however, that 

says you have to tonemap within the HDR application or use the tools the HDR software 

provides. There is another way to look at that HDR file. That is to consider the HDR file as 

a new RAW image. That’s right; I’m saying HDR is the new RAW. There are times when I 

will do everything in the HDR application. I’ll merge, tonemap, output a final image, and 

be done. Those instances are rare. Very rare. Those instances will typically be in situations 

where I want to get a quick preview of what I may end up with, even when I’m trying 

for a more surreal look. What I’m more likely to do is merge; tonemap the 32-bit image 

to a fairly flat, low-contrast result that gives me plenty of options for adjusting contrast 

later; then work on creating a final version that has the full range of contrast I want it 

to have. This flat, low-contrast “working image” is akin to Adams’ “printable” negative. 

Sometimes I won’t even tonemap in the HDR application at all. I will simply merge, open 

the 32-bit image in Photoshop, drop it down to 16-bit without any HDR tonemapping, 

and undertake a process called soft tonemapping, using the tools available in Photoshop 

with the DZS.

CHAPTER 7 | The Digital Zone System and High Dynamic Range Imagery

Another way to look at an HDR file 

is to consider it a new RAW image.
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How do we work with RAW files currently? For the most part, we make adjustments to 

the file in our RAW converter of choice, then open it in our image editor, make additional 

adjustments with layers and layer masks, and save that final edited version as our master 

in either TIFF or PSD format. Some work exclusively in a hybrid program like Lightroom 

and never touch Photoshop. Lightroom 4.1 can work with 32 bit files in the TIFF format 

but you still can’t work with 32 bit .hdr or .exr file. For all intents and purposes, Lightroom 

really still can’t be considered to be compatible with 32 bit HDR images. 

What we will work through is a way to use the DZS as a method of tonemapping HDR 

images. The biggest upside to this approach is that you don’t run the risk of getting the 

overprocessed, surreal results that are possible with regular HDR tonemapping tools. The 

results are completely natural—which is a look a lot of people want but have difficulty 

getting with the regular HDR tonemapping methods. We’ll also look at using the DZS for 

editing images that have already been tonemapped with standard HDR tools.

This chapter is not going to be an in-depth treatise on HDR. If you would like to delve 

into HDR in more detail, then Practical HDRI, 2nd Edition: High Dynamic Range Imaging 

Using Photoshop CS5 and Other Tools by Jack Howard is recommended reading. What 

we’ll discuss in this chapter is how the DZS can fit into an HDR workflow.

Employing the DZS as a method of tonemapping is simple and requires only a few 

additional steps compared to working with it on non-HDR images. 

What is HDR?

Before getting too far along, a brief explanation of what HDR is is probably in order. HDR 

in a purely technical sense is the merging of a series of images of differing exposures 

(differing brightness values) into a 32-bit image file. The goal is to extend the dynamic 

range of the image beyond what the sensor can record in a single exposure. Manually 

blending images is often referred to as HDR, and it is in the sense that manual blending 

also extends the dynamic range. But it doesn’t involve the use of a 32-bit file format, so 

from an absolute technical standpoint it is not HDR. A 32-bit file format is used because 

it can contain a much wider range of brightness than a16-bit or 8-bit file. 

We can’t currently use these 32-bit HDR files. Existing monitors can’t display the entire 

brightness range in 32-bit images, and printers can’t reproduce the entire brightness 

range with existing technology. Perhaps one day we’ll be able to use HDR images, but 

not today. In order to make use of the files, we have to take them through a process 

called tonemapping. Tonemapping is just a fancy word for editing. In this process the 

wide brightness range in the HDR image is compressed into a narrower band that we can 

actually use. This “mapping” of tones is in essence no different from what Adams did with 

his exposure and development decisions. With that short explanation of HDR, let’s move 

on to seeing how it fits within the DZS.

What Is HDR?

The goal of HDR imaging is to 

extend the dynamic range of an 

image beyond what the sensor can 

record in a single exposure.
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HDR Merging

We’ll start by looking at the RAW file we get out of the camera. Whether you’re using 

the HDR Pro utility in Photoshop or third-party HDR software, there are a few things you 

should do to RAW files before sending them into HDR-land. Yes, I am recommending 

making some edits to the RAW files before doing the HDR merge. I know others will say 

that you should do nothing to the RAW files, but I disagree. In my opinion, there are some 

adjustments that are simply better to do at the RAW stage.

The reason I suggest making these adjustments at the RAW stage is due to the nature 

of the HDR process. Everything gets enhanced, whether good or bad. If there’s something 

not quite right in the RAW images, it will get exaggerated in the HDR merge and may be 

more difficult to correct later.

The first thing to correct is the white balance. If the white balance setting in the camera 

was not set properly and your image has an unwanted color cast, fix it at the RAW stage. 

In either Lightroom or ACR you can adjust the white balance on one image, and then sync 

the changes to the other images in the sequence. This is probably the most important 

pre-merge adjustment of the three I’m suggesting. If you end up with an unwanted color 

cast in the HDR image due to an improper white balance, it can be difficult to deal with.

The second thing to take care of before merging are aberrations like purple fringing 

and chromatic aberration. It’s quicker and easier to fix them in the RAW files, and the 

result is better than if you try to fix them later. Since we’re working on multiple copies 

of the image in our layer stack in the DZS, trying to fix aberrations later can cause some 

unpleasant results due to the way pixels are shifted to correct the errors. Again, you can 

do it on one image, then sync to the rest.

The last pre-merge adjustment is spotting (to invoke a film term) or cloning/healing 

of dust and other detritus in the source images. Of the three this is probably the least 

necessary, but I find it’s still better done at the RAW stage than later in the workflow. As 

with the other two flaws, you can fix dust problems in one image, then sync to the rest 

in the series. 

Once you’ve done your pre-merge edits, you can go ahead and create your 32-bit HDR 

image. In many of the examples that follow, the 32-bit images were created in HDR Pro. 

You can use any HDR software for this. I like HDR Pro because of the seamless integration 

with Lightroom, Adobe Bridge, and the DZS.

CHAPTER 7 | The Digital Zone System and High Dynamic Range Imagery
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Next, we’ll walk through a series of images that take you from the original 32-bit HDR 

to a final image, with a comparison between the DZS version and a traditionally 

edited version. 

The first example is an image of an old, disused railway station in Buffalo, New York. 

The Buffalo Central Terminal is a terrific example of Art Deco design, and the station 

was an important hub for both passengers and cargo in its day. Unused for many years, 

it has fallen victim to heavy vandalism and is in the process of being restored by a local 

preservation group. 

In figure 7.1, you can see what the 32-bit version looks like before any adjustments. The 

histogram for the image is included as well.

HDR Merging

RAW vs. TIFF for HDR Processing

Whether you send RAW files or TIFF files to your HDR application of choice 

really depends on what the particular application works with better. Most HDR 

applications have built-in RAW converters, but the quality of the conversion can 

be variable. For the best results, I recommend sending the TIFFs you create from 

your edited RAW files in 16-bit, tagged with the ProPhoto RGB or Adobe RGB 

color space. 

If you use a program like Photomatix and its Lightroom plug-in, when you 

export the files to Photomatix from Lightroom they will be converted to TIFFs 

or JPEGs, in 16-bit or 8-bit, and they’ll apply whatever color space you selected, 

along with the edits you made to the RAW files. HDR Pro in Photoshop will auto-

matically pick up edits you made to RAW files by reading the XMP sidecar files.

t Figure 7.1: Original 32-bit image and 

histogram
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What should be immediately clear from the shape of the histogram is that it very much 

resembles the histogram of an image that has been exposed using ETTR. Remember that 

earlier in the chapter I suggested the Zone System was an analog version of HDR and 

that increased exposure and reduced development represented an early form of ETTR? In 

this histogram we see that quite well. Remember that I also said HDR was an extreme 

version of ETTR? This histogram illustrates that too. 

The dynamic range of this scene was not very large—only about 11 stops or so. In a 

purely technical sense, I probably didn’t need to use HDR because that range fits within 

what the sensor in the camera I was using (a Nikon D700) can capture. But what gets 

tested in a lab and what happens in real-world shooting conditions can be different, so 

I wanted to take the precaution of giving myself the leeway of those extra exposures 

and the ability to merge to HDR. Due to the many windows in the space and the type 

of day it was, with rapidly moving clouds, the light in the building was changing often 

and quickly. What might have been just an 11-stop range one minute could have been a 

13-stop range or more the next. Before moving on, let’s take a look at a single exposure 

to see what we have.

CHAPTER 7 | The Digital Zone System and High Dynamic Range Imagery

Single File and Adobe Conversion of RAW Files

A screen capture of the middle exposure from the bracket (the “normal” expo-

sure) in ACR is shown on the left in figure 7.2. We can see that even this normal 

exposure is pushed to the right. The reason is that the area I was metering was 

fairly dark and my meter wanted to turn that dark area into a middle-toned 

value. There is no highlight clipping, so we can still use this image.

As discussed in chapter 4, with Lightroom 4 and ACR 7, Adobe introduced a 

new RAW conversion engine. After some adjustments with the older RAW conver-

sion engine we get the image in figure 7.3. It’s better. The histogram has been 

shifted so it’s just off the right edge. While there is still good shadow detail, the 

floor is overly bright. This is about the best I can do with the old process.

Switching to the new PV2012, we get the image shown in figure 7.4. There is 

now much better detail in the floor and the shadow detail is still preserved. Look-

ing at the histogram, you can see it has very flat contrast overall. I could work 

with this version and use the DZS on it. But it’s still not as good a starting point 

as the HDR version we’ll look at next.
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HDR Merging

t Figure 7.3: RAW image edited with 

Process Version 2010

t Figure 7.2: Unaltered RAW image from 

the camera

t Figure 7.4: RAW image adjusted with 

Process Version 2012
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Tonemapping HDR Images

Soft Tonemapping
With the HDR file open, the next thing we need to do is bring the highlights back into the 

range of what we can view on-screen. There are several ways to do this with the tonemap-

ping tools in HDR Pro. Since we’re going to do the rest of our tonemapping using the DZS, 

all we’ll do in this case is use the Exposure and Gamma tonemapping adjustment and set 

the Exposure slider to 0. What you’ll find in Photoshop when you open a 32-bit file and 

look at the Exposure and Gamma settings via View>32-bit Preview Options is that the 

Exposure slider is set to some value other than 0. What the value is will vary depending 

on the image. In this case it was +1.3. After zeroing out the exposure to bring the high-

lights back into visible and useable territory we have the image in figure 7.5, along with 

the histogram for the image. 

You might look at the histogram for this image and the one for the single image and 

say the two are basically the same. They are similar, but there are important differences. 

The HDR histogram is more spread out and has a greater concentration of pixels in the 

darker areas. This is actually what we want because there is more shadow than highlight 

in the image. If you look carefully at the two versions of the shot, you can see that the 

floor area is a bit flatter and has better color in the HDR version. Overall, this is a better 

starting point.

I worked up two versions of this image, one using traditional tools and one using the 

DZS. The two are shown below for comparison (figures 7.6 and 7.7). The histograms for 

each are included as well. What do we see? The DZS version has better overall contrast 

and more visual “snap” than the traditionally edited version. There is better local contrast 

and global contrast. I’ve been better able to adjust the shadow and highlight detail. This 

can be seen clearly in the front of the newsstand. The DZS version has both deeper shad-

ows in the wood and brighter light areas in the marble. I’ve also been able to adjust the 
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u Figure 7.5: 32-bit HDR image with ex-

posure set to 0 via Exposure and Gamma, 

and histogram
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colors in the floor without affecting other areas because I could separate the adjustments 

based on luminance.

Next, let’s look at figure 7.8, which shows a screenshot of the layer stack for the DZS 

version. At the bottom, above the base layer, are the Hue/Saturation adjustments that 

were made to four selected zone masks. Above the luminance layer are the Curves adjust-

ments that were applied. At the top is a slight global Curves adjustment to refine overall 

image contrast.

To see how I was able to isolate color according to luminance, let’s take a closer look 

at the Red slider of the Hue/Saturation adjustment on Zone 7 of the DZS image (figure 

7.9) and compare it to the Red slider of a global Hue/Saturation adjustment to the entire 

image when using traditional methods (figure 7.10). By pushing the slider all the way to 

100 to overdo the effect, we can easily see which areas of the image are impacted.

We can clearly see that the adjustment to the reds is much more isolated to the floor in 

the DZS image compared to the other. Remember that we need light to see color. Colors 

in areas of shadow should be less vibrant than colors in areas of more light. That too is 

evident in the comparison of these two images. Notice the exposed brick on the left side 

of the archway to the train concourse. In the DZS image, the Red adjustment to Zone 7 

Tonemapping HDR Images

t Figure 7.6: Image edited with 

traditional methods

t Figure 7.7: Image edited with the DZS

Digital_Zone_EN_final_01.indd   115 24.09.12   19:45

http://lib.ommolketab.ir
http://lib.ommolketab.ir


|  116  |

doesn’t affect the color in that exposed brick at all, whereas in the image using global 

Hue/Saturation adjustment the red brick is affected. We don’t want that exposed red 

brick to be affected by the saturation adjustment to the floor because it sits in a shadow 

area and the color should be more muted. With the DZS and the ability to isolate adjust-

ments based on brightness, we can achieve a more realistic and visually accurate result. 

CHAPTER 7 | The Digital Zone System and High Dynamic Range Imagery

p Figure 7.8: DZS layer stack

p Figure 7.9: Red adjustment isolated to the floor in DZS

p Figure 7.10: Global Red adjustment
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Editing Images Post-Tonemapping
Can we use the DZS for post-tonemap adjustments to images that have been tone-

mapped in an HDR software application? Sure we can. 

When I walked into the Central Terminal in Buffalo and saw the architecture, a concept 

came into my head of how I wanted to render the image. A visualization. What I wanted 

to do was to create something that evoked an old, Art Deco–era illustration. The image 

in figure 7.11 was my first attempt at realizing that concept, where I used the following 

traditional methods.

I loaded the source images into the HDR software program Photomatix from HDRSoft, 

tonemapped them, and saved the image as a TIFF, which I then brought into Photoshop 

for further editing. I applied Hue/Saturation and Curves adjustment layers, and sharp-

ened the image with the High Pass method. I was pretty happy with the result. It was very 

close to what I was trying to achieve.

Next, I worked on the same image using the DZS. I used the same TIFF from Photomatix 

as the starting point. You can see the result in figure 7.12.

Tonemapping HDR Images

t Figure 7.12: HDR image edited with 

the DZS

p Figure 7.11: HDR image with global 

post-tonemap adjustments
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This is the version I was looking for! In particular, the flags in the first attempt looked 

too realistic. In the DZS image I was able to give the flags more of an illustration look. 

Overall contrast is better and the image is sharper due to the fact that I was able to 

sharpen more aggressively on the luminance layer than I could when using the High Pass 

method on the traditionally edited version.

Some may look at this and say it just looks like an overprocessed HDR image, and 

that’s OK. It is somewhat overprocessed compared to the strictly realistic interpretation 

we looked at earlier. It does, however, achieve the look I was going for and realize the 

concept I had in my mind when I walked into the space.

This is another key aspect of Adams’ Zone System that can carry over to the DZS. As I 

discussed in chapter 1, visualization is important in being able to create a final version of 

an image that you’re happy with. If you look at a subject or scene and can conceptualize 

how you want that image to look on-screen or in a print, you’ll be much more able to edit 

the image effectively and efficiently. Visualization makes for a much more pleasant and 

productive editing session, as opposed to simply trying to take a shot and start making 

adjustments without a goal or concept. Work on visualizing the end result when you first 

view a scene, and the success rate of your images should improve immensely. The exercise 

in visualization will also help you in the field to compose the image with the final result 

in mind. This can help prevent having to do significant cropping after the fact to get a 

composition that is pleasing or to fit a composition to an otherwise directionless image.

Image Blending with Zone Masks

To finish off this chapter, we’ll take a look at another way we can use our zone masks and 

zone groups. We can use them in blending exposures to extend dynamic range. There are 

several ways to manually blend images, but using the zone masks and zone groups can 

be very elegant.

Shot at sunset and into the setting sun, the image shown in figure 7.14 had a very 

wide brightness range. It was wider than I could capture in a single shot. If I exposed 

for the sky, I got an overly dark foreground. Exposing for the foreground produced an 

overexposed sky.

I needed some way to blend these two images to create a new version with proper 

exposure for both elements. I could have used HDR software. I could have used any of 

the other manual blending techniques as well, but those can be time consuming and 

inefficient due to the manual painting involved with some methods.

I decided to use zone masks to very quickly and effectively blend the two images 

together. I loaded them as layers with the foreground image (overexposed sky) on top. 

Pressing CTRL and clicking on the RGB composite channel in the Channels palette se-

lected the highlights for the top layer.

p Figure 7.13: Layer stack for the DZS 

version
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As you can see in figure 7.15, it looks like a discrete selection. But remember that these 

are, in actuality, highly feathered areas. The marching ants only show where pixels of 

more than 50% visibility are selected. With the highlight mask selected, I simply hit the 

Delete key. The sky from the layer underneath shows through, and I have a blended image 

(figure 7.16) that is properly exposed for both the sky and the foreground.

Quick, easy, and effective. I could now go on and make further adjustments to either layer 

to refine the image more.

Image Blending with Zone Masks

p Figure 7.14: Exposed for sky (left) with dark foreground. Exposed for foreground (right) with overexposed sky.

p Figure 7.15: Highlights selected p Figure 7.16: Blended image
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Chapter 8
Printing in the Digital Zone System

According to Ansel Adams’ Zone System, printing is yet another area where you can exert 

control over the finished result. The goal of film exposure and development is to get what 

Adams called a “printable” negative. That did not necessarily mean a negative that would 

print well as a straight print. What it meant was a negative that contained the brightness 

range he wanted to reproduce in the print but left work to be done on the enlarger.

The printable negative Adams ended up with after making exposure and development 

decisions, if printed straight, would often render a flat, lifeless print. The reason is that 

the negative itself would have very low contrast. But Adams knew a few things about 

printing that led to the creation of that flat negative. He knew that he could do more 

work in the printing process to enhance the image on the negative and render a print 

with a broad tonal scale and good global as well as local contrast. He also knew that the 

dynamic range of the papers he used was narrower than that of the film, and thus he 

knew that if he developed a negative with the same broad tonal scale he wanted in the 

print, he would lose some of it in the printing process due to blocked-up shadows and 

blown-out highlights.

A well-known quote attributed to Adams is, “The negative is the score, and the print 

is the performance.” Relating this quote to music, a songwriter may be able to write the 

music but it’s the performance that brings the music to life. A straight, rote rendition of 

musical notes will sound flat, lifeless, and mechanical. For the music to have depth and 

soul it takes a strong performer to interpret the notes. In the same way, the flat, lifeless 

negative needs to be brought to life. On the enlarger, in the darkroom, Adams gave life to 

his negatives. By selecting a particular contrast grade of paper, by choosing the developer 

and dilution, and by using techniques such as dodging and burning, Adams was able to 

manipulate that printable negative and create a true work of art.

It’s difficult to really understand the impact of Adams’ quote without seeing some of 

his straight prints alongside some final versions of the same image. If you have the op-

portunity to do so, I would definitely recommend taking advantage of it.

With the DZS, you’ll recall, I suggested that the two components are (1) exposure, 

and (2) development and printing. With digital, we don’t have the opportunity to adjust 

anything at the time of printing. All the work needs to be done at the development stage. 

The print merely renders what we create in the digital darkroom.

The exposure decision gives us our RAW file. With that RAW file we work in the digital 

darkroom of ACR and Photoshop to create the image that will appear in the print. We do 

our color (or gray-tone) enhancement, and make global and local contrast adjustments to 

get the image ready to print. We do, however, still make those adjustments with the paper 
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choice in mind. With digital printing we don’t have specific contrast grades of paper, but 

we do have media that can reproduce various levels of contrast and that have differing 

dynamic ranges and color gamuts.

The traditional and digital approaches are similar in that if either the negative or 

RAW file isn’t right, you can’t salvage something from it. You can’t—either through de-

velopment and printing of the negative or through editing of the digital RAW file—turn 

an unsuccessful image into a successful one. Remember the adage from earlier in the 

book—GIGO.

Choosing a Printing Surface

What I refer to as “hard” media are the coated papers. Glossy, semi-gloss, and luster 

papers fit into this category. They render images that are sharper, have greater Dmax 

(deeper blacks) and lower Dmin (brighter whites), and typically have a broader color 

gamut. Media that I call “soft” are papers like the watercolor or heavily textured, un-

coated papers. Canvas also fits into this category, even glossy canvas. These papers don’t 

produce as deep a black and typically not as bright a white, nor do they generally produce 

as wide a color gamut.

Figure 8.1 illustrates a typical difference. In the illustration, the color gamut of Epson’s 

Exhibition Fiber paper, a “hard” paper, is plotted against the smaller gamut of Epson’s 

Velvet Fine Art paper, which is a very “soft” paper with a velvet-like feel. The difference 

between the two may not seem very great, but when you’re printing an image with 

vibrant colors it is.

Knowing the characteristics of the paper allows us to choose the right media for the 

image and prepare the image so that it’s reproduced as well as possible on that media.

The Right Paper for the Right Image

What do I mean by choosing the right media for the image? In my opinion, certain imag-

es work better on certain types of media. Crisp, clean, sharp images work better on hard 

media, whereas more muted or ethereal images with softer colors and less defined detail 

work better on soft media. An important aspect of choosing media is to avoid the cliché. 

There are fads in all areas of life, and certainly photography and art are no exceptions. 

For the past few years, canvas has been a popular choice for printing. It’s relatively new 

to the photographer, and with digital printing it’s readily accessible. Canvas can be used 

with wet prints, but that is a much more labor-intensive and error-prone process. Today, 

people are printing anything and everything on canvas because it’s the hot trend. It’s not 

because the image looks good on canvas—many images don’t—but solely because canvas 

is popular. Metal is also becoming like canvas in that respect. Popularity isn’t a good rea-

son to choose a printing surface. Choose the surface that makes your image look the best.

CHAPTER 8 | Printing in the Digital Zone System

p Figure 8.1: Color gamut comparison: 

Epson Exhibition Fiber (darker/larger 

plot) and Epson Velvet Fine Art (brighter/

smaller plot
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Color Management for Printing

Recall in chapter 2, I said there was a color management aspect to printing and that we 

would cover it in this chapter. There is, and it’s crucially important. Without a properly 

color-managed printing workflow, getting a print that comes out the way you want, with 

accurate color and contrast, is more good luck than good (color) management.

Just as with the monitor and scanner, we’re going to make use of color profiles in the 

printing process. Without using these color profiles, paper coatings, optical brighteners 

that give a brighter white to the paper, any cool or warm tone the paper may have, and 

the way the printer interprets colors to combine inks on the paper, can all play a part in 

making the colors and contrast you see in a print different from what you see on-screen. 

Most of the highly regarded paper manufacturers provide accurate profiles for their 

papers to be used with a variety of popular printers. Five or six years ago, these canned 

profiles were not as good, and having custom profiles made was often the best way to 

achieve high-quality results. Today, these manufacturer-provided profiles are quite good. 

Unless you’re using a printer that the paper manufacturer doesn’t provide profiles for, a 

paper from a lesser-known manufacturer, or your own papers, there really shouldn’t be a 

need to have custom profiles made. That isn’t to say manufacturers’ profiles are perfect 

all the time. Sometimes there can be a dud. Recall from chapter 2 what you can do to try 

to rectify a problem with inaccurate prints. We’ll talk about sending your prints out to a 

service bureau later in the chapter.

Soft Proofing

The first step in the printing process is something called soft proofing. Soft proofing 

allows you to get a good preview on your computer monitor of what your print will look 

like on paper. It doesn’t necessarily replace a printed proof, and even if you do soft proof, 

your first print may not be exactly what you were aiming for. But the instances of reprint-

ing should be reduced dramatically if you employ a sound soft proofing methodology.

The next section will walk you through the process of soft proofing in Photoshop. Later 

in the chapter we’ll discuss soft proofing in Lightroom; the much-needed feature that was 

added in version 4. A word of advance warning, soft proofing in the two applications is 

a bit different so you’ll want to pay particular attention to where you’re working on your 

original and comparing to a copy (Photoshop) versus where you’re working on a copy and 

comparing to your original (Lightroom).

Soft Proofing in Photoshop
With your image open in Photoshop, go to Image>Duplicate. This will create a copy of 

your original that you will use to soft proof against. Tile the two images side-by-side, 

and make them the same magnification level. To change the magnification, click on the 

Zoom Tool (the magnifying glass) in the Tools palette (see the highlighted tool in figure 

8.2). Moving your cursor over the image, you’ll see the magnifying glass with a + sign in 

it. Click to increase magnification. Holding the ALT (option) key will turn the sign into 

a minus (–) and you can then click to reduce magnification. This function does nothing 

Soft Proofing

p Figure 8.2: Zoom Tool
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to resize the actual image; it merely adjusts the screen view. The two images on-screen 

should now look something like figure 8.3.

Click on the original image to make it active and go to View>Proof Setup>Custom. This 

will bring up the dialog box shown in figure 8.4.

Here is where you make your choices for soft proofing the image. They will be the 

same choices you make later when you output the print. In my example, the Device to 

Simulate option is set to Pro38 USFAP, which is the profile for Epson UltraSmooth Fine 

Art Paper on the Epson Stylus Pro 3800 printer. When it comes to the choice of Render-

ing Intent, you’re going to be selecting either Relative Colorimetric or Perceptual. I set 
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p Figure 8.3: Original and copy images 

side-by-side on-screen

u Figure 8.4: Proof Setup dialog box
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the Rendering Intent to Relative Colorimetric. I’ve checked the box to turn Black Point 

Compensation (BPC). (The sidebar on page 129 explains BPC as well as each of the four 

Rendering Intent settings.)  

Under Display Options (On-Screen), is a check box for Simulate Paper Color. This ad-

justs the image to show you a preview of what the image will look like on a given paper. 

It will apply any hue or warm or cool tone the paper has, and will more accurately show 

the dynamic range of the printed image. When you soft proof, turn this option on by 

checking the box as I have done. After you’ve made all your selections, click OK to close 

the dialog box. You’ll see that your image will change to something that looks pretty ugly. 

That’s alright. We’re going to fix it.

The visual match will typically be closer with hard papers than with soft papers. The 

paper in this case, UltraSmooth Fine Art, is what I call a soft paper. It isn’t going to re-

produce blacks as deep or whites as bright as a hard paper would. If I had chosen a hard 

paper such as Epson’s Ultra Premium Glossy, the difference between the two versions 

would be smaller.

The goal now is to make adjustments to the proofed original to make it look as close 

as possible to the unproofed copy. You’re rarely going to get the two to look identical. 

You should still make adjustments at this stage as layers, so that you can delete or alter 

them in the future as needed. I added Curves and Hue/Saturation adjustment layers 

to the proofed version. The final proofed version with adjustments is shown in figure 8.6.

Soft Proofing

p Figure 8.5: Soft proofed original 

(right), and unproofed copy (left)
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You can see that the two are still not exactly the same, but they’re now closer. As noted 

above, it’s rare to get the two to match exactly. This is another reason why the goal of 

color management is not to get an exact match between your print and what you see 

on-screen, but you try to get as close as possible.

The next two layer stack screenshots (figures 8.7 and 8.8) show the adjustment layers 

I applied for printing and the layer group I created for those adjustment layers. Printing 

adjustments to an image are going to be specific to the paper, printer, and rendering 

intent. In some cases even the printing resolution will make a difference. Some profiles 

are also made for viewing under specific lighting conditions. In the future, if you use a 

different paper, printer, rendering intent, resolution, or profile that is built with a differ-

ent lighting condition, your proofing adjustments will be different. Grouping adjustment 

layers and naming the group so you know what it is allows you to prepare the same im-

age for printing in multiple ways by simply turning off or on the visibility of one of the 

printing adjustment groups. If you wish, you can include your output sharpening layer in 

this group too. Remember that the output sharpening will be different for hard and soft 

media, so including it in the proofing adjustments makes some sense.

In this case, I named the group for the printer (Epson 3800), the paper (USFAP), the 

rendering intent (Perceptual), and the printing resolution that will be used (1440 dpi). 

Some papers use different profiles for different printing resolutions, so including that 

information in the layer group name can be helpful.

CHAPTER 8 | Printing in the Digital Zone System

p Figure 8.6: Adjusted soft proof original 

(right) and unproofed copy (left)
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Soft Proofing

p Figure 8.8: Printing adjustment layers grouped and 

named for the paper, printer, resolution, and rendering 

intent

p Figure 8.7: Printing adjustment layers at the top 

of the stack
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Rendering Intents 

There are four different rendering intents. The rendering intent determines how out-of-

gamut colors are reproduced. What are out-of-gamut colors? They’re colors that are out 

of the range that can be reproduced by the paper and ink in a print. The color gamut of 

the paper and inkset is the universe of colors that they can reproduce. Rendering intent 

only matters for practical purposes when printing. When we switch from one editing color 

space to another (e.g., Adobe RGB to sRGB), the rendering intent is relative colorimetric 

by default. This will change as what are called Version 4 ICC profiles become more widely 

used, but with the use of Version 2 profiles, the intent is relative colorimetric. 

ICC stands for International Color Consortium. This international body develops the 

specifications for producing color profiles and makes recommendations for how color pro-

files should be used in color-managed workflows. These broader color spaces, called work-

ing color spaces, are referred to as device independent. That is, they are the same regard-

less of where the image is being viewed. The color space of a printing paper or a monitor, 

which is called an output color space, is referred to as device dependent. That is, the color 

space is entirely dependent on the ink/paper combination or the specific monitor.

Relative colorimetric: All of the out-of-gamut colors are remapped to the closest in-

gamut colors. If we have a particular red that is 150, 25, 25, and another that is 175, 20, 

20, and both are out of gamut for the particular ink/paper combination and the closest 

in-gamut color is 125, 55,55, then both of these out-of-gamut reds will get reproduced as 

the same in-gamut red. What this can cause with a lot of out-of-gamut colors is an increase 

in saturation of some colors at the outer limits of the gamut. What also happens with rela-

tive colorimetric is that the white point of your source image gets remapped to the white 

point of the destination paper. In other words, white stays white, as much as possible. If 

your paper has a warm tone, the white of your image will become the warm tone of the 

paper in your print.

Perceptual: The perceptual rendering intent remaps all of the colors in an image, both 

in-gamut and out-of-gamut, so that the relationships between the colors remain as close 

as possible. This can sometimes cause a small decrease in overall color saturation, but be-

cause the relationships between colors are maintained, the perception of color and satura-

tion stays pretty much the same. Perceptual is a good starting point for soft proofing and 

printing. If you try perceptual and don’t like how it looks, switch to relative colorimetric 

and see if it works better.

CHAPTER 8 | Printing in the Digital Zone System

u Figure 8.9: Out-of-gamut color map-

ping with the relative colorimetric render-

ing intent. In-gamut colors don’t change, 

and out-of-gamut colors get remapped 

to the limit.
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Absolute colorimetric: This rendering intent remaps out-of-gamut colors in the same 

way as relative colorimetric. What it doesn’t do is remap the white point. Absolute colori-

metric will overlay the color of the paper you’re proofing with onto the paper you’re print-

ing on. You’re already doing that visually by selecting Simulate Paper Color in the proofing 

dialog. If you print with absolute colorimetric to a warm-toned paper, for example, the 

warm tone of the paper will be printed onto the warm-toned paper, doubling the effect. 

Absolute colorimetric is good to use if you’re simulating another device, such as a printing 

press, and you know you’re going to be printing onto a paper that has a different base 

from what you’re creating your proof on. This is a very specialized case and not one we 

want to use for photo printing.

Saturation: The saturation rendering intent remaps all of the out-of-gamut colors to the 

closest in-gamut color. This sounds the same as relative colorimetric, right? What the satu-

ration intent also does is remap some in-gamut colors closer to the limit. This can cause 

a marked increase in overall saturation. Saturation also doesn’t necessarily remap colors 

into the same color family. It remaps according to saturation levels. If you have a red that 

can’t be replicated but there’s a yellow that has the same saturation level, your red may 

get remapped to yellow. Not good.

Black point compensation: Applying BPC will be an image-by-image choice. The choice 

will be determined by how well the paper you’re using reproduces deep blacks and what 

the Dmax (the deepest black the paper can reproduce) of the paper is. BPC remaps the 

black point of the image to compensate for the ability of the paper to render deep blacks. 

With papers like the softer media, if BPC is left turned off, you may get a lot of blocked-up 

shadows. Turning BPC on will lighten some of those darker areas to retain as much shadow 

information as possible. Try it turned on and off to see which is better. The effects of hav-

ing BPC on and off can be seen in figure 8.11. The diagonal gray line represents an image 

with brightness values ranging from 0 (black) to 255 (white). No paper can print that full 

range. In this case, I’ve shown a sample paper with a black point of 45. That means any-

thing with a brightness value of 45 or lower will be rendered black on this paper. Referring 

back to the step wedge in chapter 1, we’ll lose Zone I and some of Zone II. To compensate, 

turning BPC on remaps the black point of the image to 45 and slightly lightens some of 

the other dark values to retain shadow detail. 

Soft Proofing

t Figure 8.10: Color mapping with the 

perceptual rendering intent. All colors get 

remapped relative to each other. The result 

is a compression of the entire color range 

of the image.
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Preserve Details Using BCP 

BPC has another purpose in general color space conversions. If you’re going from a color 

space with a deep black point to one with a less deep black point, you can get blocked-up 

shadows. You can also have the inverse. If you’re going from a color space with a higher 

black point to one with a lower black point, you can get shadow areas that appear washed 

out. Using BPC in these cases will preserve your blacks and shadow detail. In the first case 

it will do the same as with a print and lighten the areas appropriately to retain shadow 

detail. In the second case BPC will actually darken those areas further to keep them from 

appearing overly light, being washed out and reducing the contrast in your image. Note 

also that when you’re using the perceptual rendering intent, checking or unchecking the 

BPC box will make no difference. The reason for this is that with the perceptual intent, BPC 

is always turned on by default.

CHAPTER 8 | Printing in the Digital Zone System

u Figure 8.11: Effects of having BPC on 

and off
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Soft Proofing

Why Use A Wide Color Space?
Recalling the color space gamut charts from chapter 2 and comparing the charts of paper 

color gamuts earlier in this chapter, you might be wondering why I’ve suggested working 

with a wide color space such as ProPhoto RGB when not all of the colors can be repro-

duced in a print. For reference, the next color gamut plot shows the difference between 

ProPhoto and Epson Exhibition Fiber, which is a paper with a very good color gamut.

There are a lot of colors in the ProPhoto space that aren’t reproducible on this paper 

with the inks of the Epson 3800 printer. But look what happens when we compare the 

same paper on a newer printer with a newer inkset. The color gamut of the paper is larger 

with the Epson Stylus Pro 7900 printer and a newer inkset. How can this be? Technol-

ogy changes. Technology improves. Just as digital cameras have become better over the 

years, so have printers and inks. Newer inks allow for greater levels of color even on the 

same paper. The main reason I suggest using ProPhoto is for future proofing. Because 

technology is always changing and improving, I want to be ready to take advantage of 

the new technology when it’s available. If I used Adobe RGB I would have to go back and 

rework all of my old images, which would require a lot of wasted time and energy. Work 

smarter, not harder. Think ahead and try to take advantage as much as possible of what 

may come in the future.

Here is another reason I suggest ProPhoto RGB: Adobe RGB is too small in some cases 

even now. The two plots in figure 8.14 show Adobe RGB compared to Epson Exhibition 

Fiber paper on the Epson 3800 printer and the same paper on the Epson 7900 printer. 

Even with the 3800, the paper/ink combination can reproduce more colors in some areas 

than the Adobe RGB space contains. The problem gets even worse on the 7900 printer. 

Why give up color in your prints if you don’t have to?

p Figure 8.12: Color gamut comparison. 

ProPhoto RGB (darker/larger plot), and 

Epson Exhibition Fiber paper (brighter/

smaller plot).

p Figure 8.14: Color gamut plots of Adobe RGB (dark plot) and Epson Exhibition Fiber 

paper (bright plot). This identical color space and paper shown on an Epson 3800 

printer (left) and an Epson 7900 printer (right).

p Figure 8.13: Color gamut comparison. 

Exhibition Fiber paper with the Epson 

7900 printer (darker plot) and the Epson 

3800 printer (brighter plot).
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Soft Proofing

See Which Colors are Out-of-Gamut
Photoshop’s View>Gamut Warning option (figure 8.15) will let you see which colors in 

your image are out of gamut for the paper you’re soft proofing and the inkset being used.

This is an interesting utility that lets you see the specific areas of the image that aren’t 

going to reproduce accurately in the print. You don’t need to do anything to fix the out-

of-gamut colors because the rendering intent will do it for you. The gamut warning just 

shows you which colors and parts of your image will be affected by the rendering intent. 

Some photographers like to fully or partially fix the out-of-gamut colors themselves. 

They feel it gives them more control over the final result. Should you choose to make 

adjustments to bring more or all of the colors in-gamut, you can do this in your printing 

adjustments layer group. Create a new Hue/Saturation or Vibrance layer, label it appro-

priately (e.g., Color Gamut Adjustment), and then adjust the colors to reduce saturation, 

adjust brightness, or alter hue to bring the colors into the gamut of the paper. The default 

color for the warning overlay is gray, but gray can sometimes be difficult to see. You can 

change the overlay color to anything you like by going to Edit>Preferences>Transparency 

& Gamut (Photoshop>Preferences>Transparency & Gamut). 

I chose a magenta color because it’s easily visible and not likely to show up in an im-

age. One thing the gamut warning does not do is show the intensity of the out-of-gamut 

colors. That is, the overlay is not denser in areas of greater out-of-gamut color. This would 

be a nice change on the part of Adobe and would make the utility even more useful.

When you’re comparing your prints to what you see on-screen, it is important that you 

compare the print to your adjusted soft-proofed image and not the original image. 

t Figure 8.15: Photoshop gamut warning
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Color Printing 

Now that you’ve edited and soft proofed your image and have a better understanding of 

rendering intents, you can move on to actually making your print.

There are two philosophies of printing. One is that as long as the image you’re printing 

will print at a resolution between about 160 ppi on the low end and 400 ppi on the high 

end, you don’t need to do anything. The other approach is to resize the image to match 

the native resolution of the printer (e.g., 360 ppi for Epson and 300 ppi for Canon). I’ve 

done both, and having closely examined prints made using both approaches I find that 

resizing does lead to better print quality. The difference is more evident with hard papers 

that show more fine detail, but can also be seen with some soft papers. My recommenda-

tion is to do some testing yourself and find out what works best for you.

CHAPTER 8 | Printing in the Digital Zone System

A Note About Printing Profiles 

Profiles are device and paper specific. You cannot expect high-quality results if 

you use a profile for a different printer model, even from the same manufacturer, 

or a different but similar paper. 

u Figure 8.16: Photoshop CS6 Print 

Settings dialog box. The numbers in red 

will help you to follow along with the 

steps below.
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In Photoshop, File>Print will open up the Print Settings dialog box (figure 8.16). Let’s 

walk through each of the areas. The screenshots in this example are for an Epson 3800 

printer. Other professional Epson printers will have similar printer setup options. Manu-

facturers other than Epson may have a different printer driver screen, but the choices to 

be made will be similar. Whatever printer you’re using, read the manual to familiarize 

yourself with the available options. The Photoshop Print Settings dialog has changed 

a bit with Photoshop CS6. CS6 offers a few new options that aren’t necessarily of great 

importance to photographers.

	 1.	 In the Printer dropdown window, if you have more than one printer connected 	

		  to the computer, you’ll want to make sure you’re sending the print to the 		

		  proper device. 

	 2.	 Click on the Print Settings button to bring up the dialog box where you set up 	

		  the printer for the job as follows:

	 a)	 The Page Layout tab is where you select the paper orientation—Landscape 	

		  (horizontal) or Portrait (vertical). That is the only choice you need to make 	

		  on this tab.

	 b)	 On the Main tab, Media Type allows you to select the type of paper you’re 	

		  using. This isn’t the name of the paper but rather the paper type. Third-party 

		  papers will tell you which Media Type to use with their profile.

	 c)	 From the Color dropdown, you can choose Color, Black, or Advanced 		

		  B&W Photo. Other manufacturers have similar selections, and their own 

		  advanced black-and-white printing processes.

	 d)	 The Print Quality dropdown is where you determine the resolution the 

		  printer will use and a few other options as follows:

	 i.	 The Speed/Quality slider determines the printer resolution: 4 is 

		  1440 dpi (dots per inch) and 5 uses 2880 dpi. For hard papers, choose 	

		  level 5 and for soft papers use level 4. Some papers will tell you what 	

		  quality setting to use. In those cases use the suggested setting. 

		  This setting is different from the image resolution you set by resizing 

		  the image in Photoshop.

	 ii.	 Checking the High Speed box enables bi-directional printing. The printer 

		  will lay down ink on the paper as the print head moves across the 

		  carriage in both directions. When it’s turned off (unchecked), the printer 

		  lays down ink as the print head moves in only one direction. I’ve achieved 

		  a higher print quality with High Speed turned off. Prints take longer to

		  complete, but the higher print quality is worth the time it takes. Do some 

		  tests to see what works best for you.

Color Printing

p Figure 8.17: Epson 3800 Printer 

Settings dialog

p Figure 8.18: Print quality options
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	 e)	 For the Mode option, select Custom, and in the drop-down menu right below 	

		  this, choose No Color Adjustment. By doing this you’re completely turning 

		  off any color management by the printer. You want Photoshop to manage 

		  your colors. If you leave this turned on and also have Photoshop managing 	

		  color, this setting will override the Photoshop color management and tend to 	

		  produce poorer prints. 

		  Having Photoshop manage color all the way through the editing and printing 

		  workflow is the proper color-management approach. Turn off printer color 

		  management for any printer you’re using.

	 f)	 The Source option determines how you’re feeding the paper into the printer. 

		  Epson printers have multiple paper paths. This allows you to select the proper 

		  path for the paper. In general, matte (soft) media are fed through the rear 

		  path, and glossy (hard) media go through the sheet feed at the front. There 

		  is a third option for Manual-Front, which will not be used often. It’s called 

		  a “straight-through paper path” and is typically used for very thick or 

		  inflexible media (e.g., metal).

	 g)	 The Size option lets you choose the paper size you’re printing on. If the paper 	

		  you’re using isn’t shown as one of the options, you can click on the 

		  User Defined button to the right to create your own custom paper size.

Click OK to saves your settings. You will be taken back to the Print Settings dialog box, 

(figure 8.16) where you will continue with our selections.

	 3.	 In the Color Handling dropdown, select Photoshop Manages Colors. This choice 	

		  allows you to continue with a fully Photoshop-color-managed workflow. Take note 	

		  of the warning at the top of the Color Management section reminding you to turn 	

		  off color management in the printer driver.

	 4.	 In the Printer Profile dropdown, choose the appropriate color profile for the paper 	

		  you’re printing on. In this case Pro38 EMP paper is selected.  

	 5.	 The next box should default to Normal Printing, which is what you want. The other 

		  option is Hard Proofing. You would choose Hard Proofing if you were trying to 	

		  proof for a different printer or a printing press with your printer. 

CHAPTER 8 | Printing in the Digital Zone System

	 iii.	 The Edge Smoothing box should be left unchecked (turned off).

	 iv.	 The Finest Detail box should also be left unchecked (turned off) 

		  for photo printing. Turning this option on changes the resolution of 

		  the printer from 360 ppi to 720 ppi, which does not make a quality 

		  difference for photos. This setting is intended for text and vector/line

		   drawings to increase sharpness in a print.
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	 6.	 For Rendering Intent, select either Perceptual or Relative Colorimetric. This should 

		  be the same selection you used when soft proofing.

	 7.	 Turn Black Point Compensation on or off by checking or unchecking the box, 

		  as you had it set when you soft proofed. Keep in mind that with the Perceptual

		  intent, BPC is always on. 

	 8.	 The Scaled Print Size section is where you can quickly adjust the size of the print 

		  to fit the paper size you’re printing on. You really don’t want to do this here. 

		  If you need to change the size of the image, do it using the image resizing options 	

		  in Photoshop.

	 9.	 The Print Resolution box will show you the pixel resolution of the image at its 

		  current size. Remember what I noted at the start of this section about resizing 

		  your image to the native (360/300 ppi) resolution of the printer. In this case, 

		  the resolution is showing 300 ppi so I would go back and resize the image 

		  before printing.

	 10.	 The three selection check boxes at the lower-left of the dialog box give options 

		  to soft proof inside the Printer Settings dialog. Since you have already soft proofed 

		  the image side-by-side with an unproofed copy, there is no need to do anything 

		  with these checkboxes.

Last, at the bottom right side of the Print Settings dialog, you’ll notice three other sets 

of options. In general you won’t be using these. Printing Marks and Functions are re-

ally options for press operations where cut marks, fold marks, and registration of color 

separations may be necessary. PostScript Options isn’t something that will be needed for 

general photo printing as it used primarily for printing vector images.

Color Printing

Advanced Paper Configuration Options 

It is less likely that you’ll need to use these advanced paper configuration options, 

which are accessed by clicking the Paper Config button (see figure 8.17, near letter 

B). You will generally use these settings for custom media types that aren’t already 

set up in the driver. Manufacturers of some third-party papers will instruct you to 

manually adjust the Paper Thickness and/or Platen Gap. The Color Density, Drying 

Time, and Paper Feed Adjustment will rarely be used. The instruction manual for the 

printer will describe what these settings do.

p Figure 8.19: Additional paper 

configuration options
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	Black-and-White Printing

You absolutely can use the steps outlined in the “Color Printing” section above to print 

black-and-white images. You should end up with terrific results. Epson, Canon, and HP 

have included an additional utility for black-and-white printing that you may want to 

try as well. Each works somewhat differently. What I’m going to walk through next is the 

Epson version. Check the manual for your printer to see how the specialized black-and-white 

mode works in your case.

When Epson introduced multi-gray and black inksets, the company also added a spe-

cial black-and-white printing mode to its printer driver. It’s called Advanced Black & White 

(ABW). Canon and HP have similar options in their printer drivers. These special black-

and-white printing modes use less color ink in creating the print and more of the black/

gray inks. The theory is this enables the photographer to generate a more neutrally toned 

print (the driver does allow you to add a warm or cool tone) that is less likely to have a 

color cast. The ABW utility also allows for deeper blacks than are possible with the regular 

RGB printer driver, which is something that a lot of black-and-white photographers prefer. 

Because the ABW mode uses less color ink—particularly yellow, which has the shortest 

longevity of all the color inks—the print life is lengthened.

The problem with the ABW mode in the Epson driver is that it isn’t natively a color-

managed process. This mode is looking for a grayscale file, not a color file. Without 

specially made profiles, you can’t soft proof in this mode, so it can be a bit of a hit-or-miss 

exercise. And while you can tone the whole image with the ABW mode, you can’t print 

split-toned images. If you try to do this, the toning will be converted to gray and you’ll lose 

the effect. To print split-toned images you need to use the normal color printing workflow.

There are a few steps you can take to help with the consistency of the process. First, 

using Photoshop’s Edit>Convert to Profile, convert your image to either Adobe RGB or 

sRGB. If you’ve used Smart Objects, you will be presented with a dialog box telling you 

that some Smart Filters may not work and asking you whether you want to Rasterize the 

Smart Objects. Click Don’t Rasterize. The reason for converting to Adobe RGB or sRGB is 

that the Epson ABW driver expects to receive image files that are encoded with a gamma 

curve of 2.2. If your document is already in either Adobe RGB or sRGB, you don’t need 

to convert it. If your document is in ProPhoto RGB, you do because ProPhoto RGB uses a 

gamma of 1.8. Printing with ABW mode with the ProPhoto RGB color space will render a 

print that’s too dark. 

With that done, go to File>Print, follow the steps to 2(C) above, and select Advanced 

Black&White from the drop-down menu. Next, click on the Advanced button next to 

Mode. This opens the ABW settings dialog. Change the default setting of Darker to Dark. 

If you want, you can add a tone to the image in this dialog as well. When I want to tone 

an image, I do it myself in Photoshop and print the image using the full-color printing 

workflow. I have more control of the toning of the print doing it this way. Note that the 

Before and After images are not your actual image. It would be nice if Epson’s interface 

showed it here, but it doesn’t. This is another reason to use Photoshop for toning and 

contrast adjustments rather than the ABW driver. You really can’t get a proper sense of 

CHAPTER 8 | Printing in the Digital Zone System
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how the changes affect your particular image in ABW mode. 

Once you’ve selected Dark, click OK to return to the printer driver setup. Follow the 

remaining steps to select your paper size and orientation, and then click OK. Back in the 

Photoshop Print Settings (figure 8.18), in the Color Handling dropdown, choose Printer 

Manages Colors, and in the Rendering Intent dropdown, select Relative Colorimetric. 

Click Print and you’re done! 

Truth be told, the Rendering Intent is immaterial here, since we’re working with gray 

tones and there can’t be any out-of-gamut colors. Note, too, that I’ve said to use Printer 

Manages Colors. This is different from what we do in a true color-managed workflow, but 

remember that ABW isn’t a natively color-managed (or gray-managed) process.

With CS6, Adobe made some changes to the print workflow, which were required due 

to changes at the operating system level from Apple and Microsoft. As a result, some of 

the previously available options with Photoshop Manages Color are no longer available 

in CS6. This necessitates some changes to the ABW workflow. Selecting Dark in the ABW 

driver is really a starting point. If the printed image isn’t to your liking, you can switch 

to one of the other settings and try again. Whatever settings you use for one paper may 

not work with a different paper. Unfortunately, ABW is a bit of a black box, so there is no 

really good way to present a definitive workflow with ABW. You’re going to have to do 

some testing on your own to see what will work for you with the papers you want to use. 

The benefits of using less color ink and getting improved print longevity may not be worth 

the extra effort and cost in ink and paper required to find workflows that work for you.

The process is different if you’re using paper profiles that have been created specifically 

for use with ABW. With these profiles you can soft proof the image, and printing is a fully 

color- or gray-managed process. There aren’t many of these specialized profiles available, 

however. If you can find some on the web, try them out and use the same workflow as 

for color printing. Prints made with high-quality ABW ICC profiles do produce superior 

and repeatable results. If you can find some good profiles or have some made for you, 

the quality of the black-and-white prints produced with a fully color- or gray-managed 

workflow may be worth it to you.

Keep in mind the process above only applies to Epson printers and the Epson ABW 

mode. For Canon and HP, check the user manual for the manufacturer’s suggestions, 

contact technical support, and see what other people are recommending on reliable web-

sites. Compare the results using the color workflow to print black-and-white to using the 

ABW mode (or grayscale mode of your printer) and see which one you prefer.

Having printed black-and-white images with both the color workflow and the ABW 

workflow without profiles, I haven’t found the ABW process produces a superior print. 

I have used some ABW-specific profiles, however, and those do make a difference. The 

potential of ABW with Epson printers is terrific, but I believe it still needs work for that 

potential to be realized.

	Printing in Lightroom

Lightroom was introduced by Adobe in 2007 as a RAW conversion utility and a Digital 

Asset Management (DAM) application. A DAM application is one that allows you to man-

Printing in Lightroom
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age your image library in a database format. You may say that’s what Bridge does, right? 

Almost. Bridge is an image browser. It only allows you to see images that are resident on 

your computer. A DAM application allows you to manage images that are stored offline 

as well. You can easily reference those images in a DAM application, and, while you can’t 

edit offline images, you can record where those images are stored offline so you can find 

them quickly and easily if the need arises. 

When Lightroom was first introduced it had more features for editing images than the 

ACR conversion engine that came with Photoshop. Today, the editing functionalities of 

ACR and Lightroom are the same.  But Lightroom still has some additional interesting 

features such as the Map module discussed in chapter 2. Another feature is the printing 

workflow. Lightroom has always had a sound workflow for printing, but in the past it 

lacked one key feature: soft proofing. This made the printing workflow incomplete and 

necessitated a round trip from Lightroom to Photoshop and back again. With version 

4, Adobe has included soft proofing capabilities inside Lightroom, making the printing 

workflow complete.

Soft Proofing in Lightroom
Soft proofing is a terrific new feature that has been added to version 4 of Lightroom. 

To access this functionality, check the box in the lower-left part of the Develop module.

On the right side of the screen, below the histogram, you can set up your proofing pa-

rameters. Here you select your paper Profile, an Intent, which is the rendering intent and 

whether to Simulate Paper & Ink. By default, BPC is turned on for soft proofing even with 

the Relative Colorimetric intent. When you check the box for Simulate Paper & Ink, the 

surrounding the image will change. This is providing the same preview as Simulate Paper 

when soft proofing in Photoshop. You will also notice a button to Create Proof Copy. You 

want to do this. Doing so will create a Virtual Copy of your image. You make your proof-

ing adjustments on this Virtual Copy and you will also print from this Virtual Copy, not 

your original. This is exactly the opposite of they way it’s done in Photoshop. You’ll see 

that the whole Lightroom process is a bit different. If you try to make adjustments to the 

soft proof without first creating a Virtual Copy, a warning dialog will pop up on-screen 

asking if you want to make a Virtual Copy first. This is a nice feature if you’ve forgotten 

to make your Virtual Copy. 

You can also set up a side-by-side comparison, just as you would in Photoshop. At 

the bottom of the screen, to the left of the Soft Proofing checkbox is the button for 

comparing images. In figure 8.20 you see this noted with the red arrow above the box 

with the split Y. There you’ll find a drop-down menu that allows you to select the type of 

comparison you want. The Before/After or the Left/Right option is most useful for this 

purpose. Your original image will appear on the left and your proof on the right. With this 

side-by-side comparison in place, you can now use the adjustment options in the Develop 

module to bring the Virtual Copy as close as possible to the original image. 

You can also view the gamut warning in the Lightroom soft proof mode. On the his-

togram, at the top right, shown with a red arrow in figure 8.20, is a tiny icon of a page 

with a turned corner. Clicking this will show you the gamut warning for the paper you’re 

proofing. On the upper-left side of the histogram is a small icon of a monitor, noted with 
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a red arrow. Clicking this will show you the gamut warning for the monitor (which colors 

in the image your monitor can’t reproduce). These gamut warnings use the same colors 

as for highlight and shadow warnings—blue for monitor and red for paper. This can make 

them hard to see when you have an image with similar colors as the warning overlays, 

but I don’t believe the warning overlay colors can be changed. 

The same caveats apply here as with soft proofing in Photoshop. When you make your 

print and want to compare it to the screen image, use the adjusted Virtual Copy for the 

Printing in Lightroom

p Figure 8.20: Soft proofing checkbox 

and proofing parameters

p Figure 8.21: Lightroom’s side-by-side 

proof comparison
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comparison. The Virtual Copy is saved with the paper profile tagged to the filename, and 

your soft proof adjustments are saved to that specific Virtual Copy as well so that you can 

come back to the Virtual Copy and print from it in the future. Virtual Copies do not take 

up any hard drive space. You can also create a collection for all of your printing Virtual 

Copies with the soft proof adjustments so you know where all of them are should you 

want to make additional prints from them in the future.  Unlike in Photoshop where you 

can make printing adjustments for multiple papers with layers and groups on the same 

original, in Lightroom you’ll create a different Virtual Copy for each paper or printer.

Using the Print Module in Lightroom
When you enter the Print module, the active image is displayed on-screen with the cur-

rent paper size and layout settings. To change the paper size and set up the various print 

options for a properly color-managed print, click on Page Setup in the lower left of the 

screen to open the printer driver. (On the Mac there are two buttons, one for Page Setup 

and one for Print Settings. The Page Setup button is where you’ll make your choice for 

paper size and orientation. The Print Settings button will take you into the printer driver 

setup.) Make the necessary selections as you would when printing from Photoshop. The 

only difference here is that you don’t need to set the paper orientation because you can 

rotate the image in Lightroom Print.

With the print settings established, move over to the right side of the screen. You’ll note 

that I am not discussing all of the various templates available for printing contact sheets 

and other layouts. At this point, we’re really concerned about creating a single print. In 

Figure 8.22, I’ve broken the print parameters into three segments and blown them up 

for viewing purposes. You access the various settings by scrolling down the right side of 

the window.

	 1.	 Image Settings: This is the first menu where you can rotate the image to better 	

		  fit the page.

	 2.	  Layout: Here you’ll find page margin and cell size settings. Cell Size determines 	

		  the size of the print, which can be resized to the limit of your margin settings. The 	

		  image is automatically adjusted on-screen, but the actual image dimensions are not 

		  affected. (This is much easier to use than the Image Size options in Photoshop.) 

	 3.	 Guides: These options allow you to show the size of the print, print resolution, and

		   layout markings on-screen. The layout markings are useful if you want to drag

		  margins or the Cell Size borders in the image, rather than using the input boxes or

		  sliders. Make sure you have Show Guides checked, as well as Dimensions. You’ll see

		  the information overlaid on the image. In figure 8.22 it shows 267 ppi. 

	 4.	 Page: These options will let you insert a watermark, text, or a graphic on top of 

		  the image. 
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	 5.	 Print Job: This is where we finalize the image for print. Here we can set the print 

		  resolution to something other than the calculated value shown on-screen. (The 	

		  default setting is 240 ppi.) This is where you would input 360 for Epson printers or 

		  300 for other printers. Turn this on by checking the Print Resolution box. Output 	

		  sharpening is also applied here with the Print Sharpening and Media Type options. 

		  You can select Glossy or Matte paper and choose one of three levels of sharpening. 

		  (If you’re printing from Light room but editing in Photoshop, you omit the output-

		  sharpening step of the DZS editing workflow.) Lightroom has been set up to 		

		  optimize print sharpening for various media types. The paper Profile is also selected 

		  at this stage, along with the rendering Intent. Notice that only Perceptual and 

		  Relative Colorimetric are offered here. You’ll note that BPC is not offered as an 

		  option. Recall that by default it’s turned on when you’re using the Perceptual 

		  intent. In Lightroom BPC is also turned on by default when you’re using the 

		  Relative Colorimetric intent.

	After you have completed setting all your options, it’s finally time to click the Print button!

Printing in Lightroom

t Figure 8.22: Lightroom Print module

p Figure 8.23: Example with Guides and 

Page panels
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Sending Prints to a Lab

Things are a bit different when you’re sending your images out to a lab to be printed. As 

with anything else, some are better than others. Most labs will accept only 8-bit JPEG files 

tagged with the sRGB color space. The reason is that the file is much smaller and will take 

less time to upload, putting less strain on the lab’s file-transfer pipeline and taking up less 

space on their servers. They may say they require sRGB because that’s the color space of 

their printers. Avoid labs that make such a claim.

Some labs will make profiles for their printers available so that you can soft proof. If the 

lab does not or will not make profiles available to you, look for another lab. The best op-

tion is a lab that allows you to send TIFF files and preferably in 16-bit. Even an 8-bit TIFF 

is preferred to 8-bit JPEGs due to the lack of compression, which degrades image files. 

To prepare an image for printing by a lab, do your soft proofing and make any desired 

printing adjustments the same way you would if you were doing the printing. When 

you’re done, flatten the image, convert it to the color space required by the lab, and save 

the file under a new name so you aren’t overwriting your master file. Transfer the image 

to the lab, and you should get back a very good print.

Some labs will tell you they use a color-managed workflow, some will not, and some 

will give you the option for a slightly higher price. If the lab indicates it does or can use a 

color-managed workflow, that means it will use the proper printer profile in making your 

print. It does not mean the lab will soft proof and correct the image for you (though some 

will do that, too, at an even higher cost). If the lab doesn’t use a color-managed workflow, 

then you need to make one change to the steps above. Rather than converting the image 

to Adobe RGB or sRGB, convert it to the profile you soft proofed with. I know this runs 

counter to everything else I’ve covered in the book with respect to color management, 

but all of that assumed a properly color-managed workflow. Don’t use a lab that won’t 

offer color management if you don’t have to. If you have no other choice, then convert 

the image to the paper profile you soft proofed with and hope for the best.	
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Conclusion

Herein endeth the journey into the Digital Zone System—in this book, that is. For me, it 

has been a four-year process of researching, experimenting, refining, and writing. Your 

own journey and experimentation with the DZS is just beginning. Will it be for everyone? 

No. Will it be used on every image? No. What I’ve tried to do in these pages is present a 

methodology for editing that can be useful in optimizing images for both digital display 

and print. I think the results are clear and that the approach does have merit and can 

be beneficial. I’m confident that this approach will create some controversy, just as the 

original Zone System, ETTR, HDR, and many other constructs of photography did. That’s 

alright. We don’t all have to agree. I hope you find the approach and the ideas that I’ve 

presented here to be useful. All I can suggest is to try it for yourself on your images and 

see how it works for you.

Although it does use some fairly common Photoshop tools, the Digital Zone System is a 

different methodology from what you may have used in the past. It will take some getting 

used to and it will take a bit of time to learn how to recognize which areas of brightness 

need to be worked on and how to use zone masks. I feel it will be time well invested. It 

certainly has been for me. Thanks for taking the time to read the book. 

Now get your camera, go out and make some photographs, and start using the Digi-

tal Zone System! You can post your results on my Facebook page at the following URL:

facebook.com/RFPhotographyCanada. I will most definitely be pleased to read your feedback.

Robert Fisher

November 2012

rf-photography.ca
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Appendices Appendix A – About the Feature Images

Front cover image: These beach rocks were captured in 2007 while I was on a trip I took for my long-
term personal project. (The project is to photograph and document all the remaining lighthouses in 
Canada. There are a LOT of lighthouses, which is why it’s a long-term project.) Back at my computer, 
I tried several different approaches to editing the image, but I was never satisfied with any version I 
came up with, either in color or black-and-white. Years later, I worked on it again, but this time with 
the DZS, and it finally came to life for me! This is what I had actually seen when I took the picture, 
but until using the DZS, I had never been able to recreate it accurately. Finally, I was able to recreate 
the luminance, vibrance, and depth of color I saw that morning. Even the black-and-white version 
maintains the sheen that is present in the color version. I now have both color and black-and-white 
versions I’m very happy with. The black-and-white version was exhibited in a solo show I had in 
Toronto in 2011. 

Page 4 – chapter 1 opening image: Toronto Dominion Centre (TD Centre) in Toronto, Canada, is a 
collection of office towers in the downtown area designed primarily by Ludwig Mies van der Rohe. 
The TD Centre is a multiple-tower campus. The strong geometrics and lines of the buildings can 
make for interesting patterns and abstract images. Depending on the angle and location from which 
you shoot, you can get the appearance of two buildings interesecting, as in this picture. I wanted to 
concentrate on the lines and shapes of the windows and walls, so I purposely left out the bottom of 
the buildings and made sure there was no sky at the top. Tilting the camera enhanced the abstract 
feel that I was trying to achieve. I was shooting in late afternoon with the sun low in the sky, which 
caused strong reflections off the windows. A single exposure wasn’t going to work, so this is a 
three-shot HDR image using a 1.5 stop bracket. After doing the HDR merge, I converted the image 
to black-and-white in Lightroom. I feel that this monochromatic version enhances the abstraction 
and brings greater concentration to the geometric shapes. The DZS was used to process this image.

Page 14 – chapter 2 opening image: This was one of those happy accidents we are lucky enough 
to find every so often. Driving home from taking my dog for a walk in a local nature area, I passed 
a construction company and noticed four old, rusting cars sitting in the front of the parking lot. I’d 
passed this place a number of times in the past and the cars hadn’t been there before. Not wanting 
to miss the photographic opportunity, I took my dog home and immediately grabbed a camera to 
head back to where the cars were. Because it was a Saturday, there weren’t a lot of people around 
and it took a while to find someone to ask if it would be alright to shoot the cars. The guys I talked to 
didn’t care and didn’t think the owner would, and he wasn’t around to object anyway. With that, I set 
about surveying the cars and trying to find some interesting angles. One of the things that interests 
me about old cars like this are the colors that appear from multiple layers of paint mixed with vari-
ous states of rust and decay. Given the urban surroundings that would have led to some cluttered 
backgrounds in wider shots I decided to concentrate on small details and to use as shallow a depth 
of field as possible to throw any background elements out of focus. The small, round taillight caught 
my eye, and I liked the mix of blue and red paint on the car’s body. The shot was made with a Canon 
EOS 620, on a tripod, likely on Fujifilm Provia as I used a lot of Provia back then, and at f/4 with a 
Canon 24–05mm f/4 L lens. 

Page 34 – chapter 3 opening image, Don’t Drink and Build: I really wasn’t sure what I was looking 
at when I saw this. I had to shake my head a couple of times to make sure my eyes weren’t out of 
whack. This was taken on the same outing as the opening image for chapter eight (pg. 122). I was 
walking along an alleyway, looking for things that fit my objective, when over a fence I saw the top 
of this door all a-kilter. I stood up on my tiptoes to get a better look. Sure enough, the door—and the 
wall, for that matter—was seriously slanted. I could hardly believe it, and wondered how a building 
chould have settled or shifted that much over time. How could anyone have built something so 
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out of square? It was very odd, yet visually compelling. I rested the camera on top of the fence for 
support and grabbed a couple of shots. Back in my office, I had to figure out how to render this. I’d 
shot it so that the door was straight, which put the steps and wooden header board on a slant. That 
didn’t look right, so I rotated the image to make the steps and header board straight, which put the 
door and wall on a slant, and which looked better because that’s how I had seen it to begin with. A 
very odd scene, to be sure. Shot with a Nikon D700 and a 28–70mm f/2.8 lens at 56mm, f/8 for 
1/125s, and ISO 200. 

Page 39: Ottawa is the capital of Canada where the Canadian parliament sits atop a hill called, not 
surprisingly, Parliament Hill. The Ottawa River flows below and along the back of the parliament 
buildings. While I was visiting there, I wanted to capture images of some of the landmarks, but I 
wanted to record them in ways that differ from the usual. I hadn’t seen many shots of the back of 
the center block of the parliament building, so I decided that was the angle I’d use. There is a park 
across the river that provides terrific views, and the angle is right for capturing the scene at sunset. 
I set up as the sun was setting and recorded a number of shots from a few different vantage points. 
This particular shot is a crop of one of the images. The original is a much wider view that includes 
the river, but I decided I wanted to concentrate on the building and the colors created by the sun in 
the trees on the side of the hill. The large tower to the left is called the Peace Tower. It can be seen 
from many different places in the city and the tolling of the bell at the top of each hour can be heard 
for several miles. The camera was a Canon EOS 5D with a 17–40mm f/4 L lens, at ISO 400. I didn’t 
have my tripod with me so I used the top of a wrought iron fence for support.

Page 62 – chapter 4 opening image, Colour Waterfall: Waterfalls are much-photographed subjects. 
Given the ubiquity of the waterfall photo, I wanted to provide a different take on the theme. Watkins 
Glen State Park is a terrific spot for waterfall photography. On the main gorge trail through the park, 
which is two miles long, there are nearly 20 waterfalls. This particular waterfall is called Cavern 
Cascade. The trail actually takes you behind this fall. Many of the shots you’ll see of this fall are from 
head on, looking down the narrow cavern toward the fall, and that can definitely be a compelling 
shot. I, too, have a couple of those. We often see a subject quite differently when viewing it from 
the opposite direction. On my way back down the trail, I got a much better look at the bowl that 
had been carved out over millennia by the water. This is what I wanted to capture: the colors in the 
water at the bottom of the bowl and the stria of the rock, which looked interesting. I set the shot up 
so that the water ran through the side of the shot without showing the source, making it a bit more 
abstract, but so that the diverging rivulets at the bottom were included. The natural striated rock 
of the cavern wall and the pattern of the man-made trail wall contrasted nicely. It was shortly after 
noon in mid-September, but because of the high walls of the gorge, little light got into the valley. 
This was taken with a Canon 5D and a Canon 17–40mm f/4 L lens, on a tripod at 19mm, f/16 for 
30 seconds, and ISO 100. The DZS was used to process this image. 

Page 76 – chapter 5 opening image: This is an older image, shot on medium-format film with a 
Mamiya C220 Twin Lens Reflex camera. The Mamiya was my first foray into medium format. I liked 
it because these were the only TLRs that had interchangeable lenses. I also liked it because it was 
inexpensive and a good way to try out medium format on the cheap. Though heavy to carry around, 
I really enjoyed working with the TLR and medium format. Seeing a slide on medium format for the 
first time is quite an experience. I kept the camera until I decided to upgrade my medium-format kit 
and move to a Mamiya RZ. Now, having shot digital for several years, I’m considering picking up a 
medium-format rangefinder just for kicks. This image was shot in early spring before the leaves had 
started to pop open on the trees. On this fairly overcast day, I finished my roll of color film and de-
cided to load a roll of black-and-white. This was the only shot from the roll that I ended up scanning. 
The film was Fuji Acros 100, which is a fine-grained 100 ISO film. The bluish tint to the image is a 
result of the scanning and I left it in because I liked the quasi-cyanotype look it imparted.
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Page 94 – chapter 6 opening image: I made this image in 2000 or 2001, on the first trip I took for 
my lighthouse project. This waterfall, called Indian Falls, is in the town of Owen Sound, Ontario, Can-
ada. After about a mile hike from the nearest parking lot, I came to a small break in the trees where 
I could see the waterfall, but I couldn’t get a good shot of it. There is low fence there, meant to keep 
people safely away from the edge of the rocks, and on the other side of the fence I saw a ledge that 
I thought would provide a perfect vantage point. It was early morning and no one else was around, 
so I climbed over the fence, set up on the ledge, took a couple shots, and hopped back over the 
fence before anyone came along. This was also shot with the Mamiya C220 and on Fuji Acros film.

Page 106 – chapter 7 opening image: This was taken on the same evening as the opening shot 
for chapter 1. Royal Bank Plaza is comprised of two towers in downtown Toronto. The two buildings 
have 14,000 windows, and actual gold was used in making the windows. The cost of the gold in each 
pane was $70 in the mid- to late-70s when the towers were built. The design was quite revolutionary 
for its time. At the right time of day and the right time of year, the sun reflecting off the windows 
makes for some spectacular colors, giving a look of glowing from within, as I was lucky enough to 
capture here in a couple parts of the picture. As with the TD Centre shot, I wanted to concentrate 
on shape and form rather than the whole building, which led me to this composition and camera 
angle. As with the TD Centre, the brightness range was too much for a single shot, so this, too, is a 
three-shot HDR image with the bracketing at 1.5 stops. 

Page 120 – chapter 8 opening image, Locked?: From time to time, I set personal assignments for 
myself, which is something I recommend to others as well to help develop your eye. A personal as-
signment is simply an objective for a day’s worth of shooting. It can be anything. In this case, my ob-
jective was “texture.” That, of course, is a broad concept and can be interpreted in many ways. That’s 
okay, that’s the idea: to see how many ways you can interpret a certain concept. It really forces you 
to look for things you might otherwise not notice. Walking around in an older area of Toronto known 
as Kensington, there are numerous alleyways that are used by residents for parking. With the age of 
the buildings, there have been countless fixes and patches to most of the garages and fences, which 
provided a perfect spot for my mini-assignment. This door and lock intrigued me for a few reasons. 
First, the wood, hinge, nails, screws, and lock are loaded with texture. The blue color was also inter-
esting in contrast to the brownish red of the bare wood and the rust. But what really caught my eye 
was the lock. If you look closely, you’ll see that the door isn’t locked at all as there is no hasp part of 
the padlock set, thus the title of the image. This was shot handheld with a Nikon D700, a 28–70mm 
f/2.8 lens, at 65mm and 1/125s at f/8, at ISO 200. The DZS was used to process this image.

Page 132 – The Colour of Decay: This is the stump of an old, dead tree that sits near the trailhead of 
one of the hiking trails in a conservation area near my home. The colors of the moss growing on the 
tree and the contrast with the color and texture of the wood caught my interest. The angles of the 
parts of the stump and the space in the middle also looked interesting. Having seen the stump at the 
start of my hike, I didn’t like the light. I made a note and went back to the spot about 90 minutes 
later, knowing the light would be more favorable and would better show the texture and shape of 
the wood. Back in my office, when I opened the images, I was pleasantly surprised at the hints of 
purple the camera picked up that I hadn’t noticed at the time of capture. This led me to accentuate 
the colors a bit in the purple/magenta range to bring them out even more. Shot with a Nikon D700, 
Nikkor 28–70mm f/2.8 lens at f/11 and .8s, on a tripod. The shot was edited using the DZS.

Page 145: The Finger Lakes area of New York is a terrific place to shoot and hike. There are many 
state parks and nature preserves in the area, a bevy of waterfalls, and just overall wonderful scenery. 
There are a couple of interesting spots in Robert H. Treman State Park. Lucifer Falls is the main, most 
well known waterfall in the park. Upper Falls is the other. What started out as a one-day hike ended 
up as a bit of a two-day adventure due to a miscalculation on my part of the amount of daylight I 
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had left and not paying close enough attention to the time while I was shooting. You can hike the 
part from the top down or from the bottom up. I chose bottom up. Getting to Lucifer Falls took more 
time than planned, so I didn’t have time for Upper Falls, and definitely didn’t have time to shoot 
from the other direction on my way back down. Let me just say that navigating a less than well-kept 
and less than well-marked trail in darkness isn’t a lot of fun. But, you might be surprised at how 
much light a Timex Indiglo watch gives off! I headed back to the park early the next morning and 
this time parked at the top and walked down. Upper Falls is only a short distance from the top of 
the trail, and as I walked down into the gorge I was presented with a beautiful sight of the rising 
sun glowing through the trees further ahead. I hopped off the trail and down onto a ledge by the 
river to set up. Obviously, this image, with a dynamic range that is far too wide for a single shot, is 
a tonemapped HDR image. It was merged and tonemapped in Photomatix, and then further edited 
in Photoshop using the DZS. Shot with a Canon 5D, 17¬–40mm f/4 L lens at 40mm, f/22, and 9 
bracketed shots at 1-stop intervals.

Page 146: This shot was another one of those happy accidents. I was out shooting with a friend who 
specializes in street photography (Robert Sadoff, who took the portrait of me on the cover flap of this 
book). As we were walking to an outdoor market area in Toronto, I happened to look down at the 
wall of a building and noticed that the paint on the wall had chipped away in such a way as to cre-
ate a nearly perfect mouth shape. The wall behind being red and the crack making it appear as lips 
made this impossible to pass up. As I was kneeling down to shoot this, several passers by, including 
some with cameras, stopped and wondered what I was shooting. I said to a couple people, “Don’t 
you see it?” It took some of them a moment to catch on to it, and one never did. Several years ago, 
I probably wouldn’t have noticed this either, which it why I make myself go out and do these small, 
personal assignments. Pushing ourselves outside our comfort zone or shooting things we’re not used 
to shooting is a great way to develop our eye and helps make us better photographers. Shot with a 
Nikon D700, 28–70mm f/2.8 lens (my favorite “walking around” lens), ISO 200, f/11, 1/125. First, 
I cleaned up a smudge on the wall in ACR and then used the DZS in Photoshop. This is the simplest 
DZS image I’ve ever worked on because the stark contrast between the white of the wall and the red 
of the “lips” made choosing which zones to work on very simple. 

Appendix B – References

Adams, Ansel. The Negative. Little, Brown and Company, 2002

Fraser, Bruce, Murphy, Chris, and Bunting, Fred. Real World Color Managemet, 
Second Edition: Industrial-strength Production Techniques. Peachpit Press, 2005

Grey, Tim. Color Confidence: The Digital Photographer’s Guide to Color Management, 
Second Edition. Wiley Publishing, Inc., 2006

Howard, Jack. Practical HDRI: High Dynamic Range Imaging Using Photoshop CS5 
and Other Tools. Rocky Nook Inc., 2010

Livingstone, Margaret. Vision and Art: The Biology of Seeing. Abrams, 2002

References

Digital_Zone_EN_final_01.indd   151 24.09.12   19:46

http://lib.ommolketab.ir
http://lib.ommolketab.ir


|  152  |

A
Adams. See Ansel Adams 

adjustment layer  69–73, 83, 86–92

Adobe RGB  25–27

Advanced Black & White (ABW)  138 

Alpha Channel  72–74 

Ansel Adams  2, 5–8, 107, 130 

aperture  42, 46–48 

Aperture Priority  50–52 

average meter  35–36 

B
base ISO  56

Black Point Compensation (BPC)  28, 125, 129–139 

Black & White  99, 138

Blend Mode  81–82, 89, 92, 100

BPC. See Black Point Compensation 

brightness  5–6, 8–11, 35–36, 56–60, 77, 80–82 

brightness range  2

brightness value  8, 58, 80–82

Brush Tool  70, 72 

Bulb mode 42, 52 

burning  2 

C
center-weighted average meter  35 

Channel Mixer  99 

Channels palette  70–74, 78, 82–85 

Clone Stamp Tool  70 

cloning  70 

color cast  19, 22–25, 64, 110, 138 

color gamuts. See gamut 

colorimetric  129

color-managed workflow  15–16

color management  15–20 

color profiles  123, 128 

Curves  11

D
Density Mask  93 

Density Mask Sharpening  93 

depth of field  46–48

Desaturate  96 

device dependent  14, 128 

device independent  14, 128 

Digital Zone System (DZS)  3 

dodging  2 

dynamic range  2, 7, 107

E
Expose to the Right (ETTR)  25, 56–61

exposure compensation  50 

exposure triumvirate  42

G
gamut  16, 131–133 

grayscale  8, 58, 87, 99 

grayscale mode  95

H
HDR. See High Dynamic Range 

healing  70 

Healing Brush Tool  70 

high-contrast  9 

High Dynamic Range  107–112 

high-key  40 

highlight  2, 8–11, 52–56 

High Pass  69, 86, 92 

histogram  37, 40–41, 78–80, 90, 102 

Hue/Saturation  69 

I
ICC  128 

ICC profile  128 

Incident meter 38 

in-gamut  128–129 

ISO  38, 42–43, 48–49 

L
latitude 5, 9 

Layer Mask  72 

Layers  70, 83
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Levels adjustments  11 

low-key  40 

luminance 15, 77 

Luminance Layer  81–84, 89–95 

luminance mask 77 

luminance value  77 

Luminosity 81–82 

M
Manual mode  52 

medium format  2 

midtone  20 

Modified Zone System  2, 12 

multi-segment meter  35–36 

N
native ISO  48

natural ISO  43 

O
Opacity  90, 92 

out-of-gamut  27, 128–129 

output color space  128 

Overlay  92 

P
place and fall  8–9 

profiles. See color profiles 

ProPhoto RGB  25–28, 131 

R
RAW  25 

reflected-light meters  35 

Rendering Intent  27, 124–126, 128–129 

absolute colorimetric  129 

perceptual  128–129 

relative colorimetric  128–129 

saturation  128–129

RGB  25–28 

roll film  2, 11 

S
shadow  2, 6–12 

sharpening  28, 90–93 

sheet film  2 

Shutter Priority  36, 51 

shutter speed  42–46 

Smart Filter  69–70, 90, 92–93 

Smart Object  69–70 

Soft Light  92 

soft proofing  123, 140 

spot meter  8–9, 35–37 

sRGB  25–27 

step wedge  6–8, 58 

T
tonality 8 

tonemap 2 

tonemapping 107–109, 114, 117

U
Unsharp Mask  69–70, 90 

V
Vibrance  75 

Visualization  13 

W
white balance  25, 64 

working color space  128 

Z
zone mask 77, 83, 86–91 

Zone System 2 

Symbol
35 mm  2
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